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Úvod 2
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1.1 Popis prostřed́ı . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
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4.3 Základńı funkce lineárńı algebry . . . . . . . . . . . . . . . . . . . . . . 35
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9 Práce s grafikou 68
9.1 Funkce plot() a jej́ı použit́ı . . . . . . . . . . . . . . . . . . . . . . . . 69
9.2 Vzhled grafu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
9.3 3D grafika . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76
9.4 Vlastnosti grafických objekt̊u . . . . . . . . . . . . . . . . . . . . . . . 79
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5.2 Porovnávaćı a logické operátory . . . . . . . . . . . . . . . . . . . . . . 143
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5.4 Matematické funkce . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 145
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8.5 Skupiny funkćı apply() . . . . . . . . . . . . . . . . . . . . . . . . . . 202
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ÚVOD 2

Úvod

MATLAB (z anglického MATrix LABoratory) je interaktivńı programovaćı prostřed́ı a
skriptovaćı programovaćı jazyk pro operačńı systémy Windows, Linux i MacOS. Jedná
se o systém vhodný pro vědecké a inženýrské výpočty, modelováńı, simulace, analýzu
a vizualizaci dat, vývoj algoritmů a aplikaćı včetně tvorby grafického uživatelského
rozhrańı. Velké uplatněńı má zejména v technických oborech a ekonomii. Možnosti
MATLABu rozšǐruj́ı knihovny funkćı, tzv. toolboxy, soubory M-funkćı zaměřené na
specifické účely (statistika, optimalizace, symbolické výpočty, neuronové śıtě, zpra-
cováńı signál̊u a obrazu, apod.).
Autor MATLABu, firma The MathWorks, Inc. (http://www.mathworks.com/), stejně
jako jej́ı zástupce pro Českou republiku a Slovensko, firma HUMUSOFT (http://
www.humusoft.cz/), poskytuj́ı svému prostřed́ı značnou podporu. Uživatelé na výše
zmı́něných webových stránkách mohou źıskat informace o instalaci, nových produktech
a rozš́ı̌reńıch, nab́ıźı kurzy, školeńı apod. Licenčńı a instalačńı soubory jsou pro stu-
denty a zaměstnance Masarykovy univerzity k dispozici na Intranetovém serveru MU.
K systému MATLAB existuj́ı i volně šǐritelné alternativy jako Octave (www.octave.
org), Scilab (www.scilab.org) nebo FreeMat (http://freemat.sourceforge.net/),
ty ovšem nedosahuj́ı takové kvality jako MATLAB.

Tento studijńı text je určen předevš́ım pro studenty předmět̊u ”M4130 a M4130c
Výpočetńı matematické systémy”, předpokládá pouze základńı znalosti lineárńı al-
gebry, práce na poč́ıtači a základy programováńı. Ćılem textu je seznámit studenty se
syntax́ı MATLABu, matićı jako základńım stavebńım prvkem tohoto prostřed́ı a mati-
covým uvažováńım, závěr textu je věnován grafickému zobrazeńı dat a tvorbě vlastńıch
skript̊u a funkćı. Text je doplněn o množstv́ı jak demonstračńıch př́ıklad̊u usnadňuj́ıćı
pochopeńı př́ıkaz̊u, tak př́ıklad̊u určených pro samostatné řešeńı.
Návod je psán pro verzi MATLABu 8.3. Přestože MATLAB pracuje od verze 6 s okenńı
strukturou, př́ıkazová řádka i nadále z̊ustává základńım komunikačńım prostředkem a
většina př́ıkaz̊u by měla být funkčńı i ve verźıch nižš́ıch.

Jan Koláček, Kateřina Konečná

http://www.mathworks.com/
http://www.humusoft.cz/
http://www.humusoft.cz/
www.octave.org
www.octave.org
www.scilab.org
http://freemat.sourceforge.net/
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Kapitola 1

Zač́ınáme s MATLABem

Základńı informace

Nověǰśı verze MATLABu pracuj́ı s tzv. okenńı strukturou. Jedná se o interaktivńı
prostřed́ı, ve kterém má velká část př́ıkaz̊u pro manipulaci a základńı ovládáńı také
své ekvivalenty v podobě klikaćıch ikonek. V této kapitole se nejdř́ıve nauč́ıme v tomto
prostřed́ı orientovat – poṕı̌seme jednotlivá okna, ze kterých se prostřed́ı skládá, uve-
deme jejich funkce a možnosti. Dále se zaměř́ıme na základńı syntaxi jazyka, nakonec
se seznámı́me s nápovědńım systémem a všemi jeho možnostmi.

Výstupy z výuky

Studenti

• se seznámı́ s okenńı strukturou MATLABu a jej́ıch využit́ım

• umı́ využ́ıt př́ıkazové řádky

• ovládaj́ı základńı syntaxi jazyka

• umı́ využ́ıvat nápovědńıho systému

1.1 Popis prostřed́ı

Spouštěńı MATLABu je závislé na použitém operačńım systému. V Linuxu zpravi-
dla MATLAB spoušt́ıme zadáńım př́ıkazu matlab v př́ıkazové řádce, ve Windows
spoušt́ıme kliknut́ım na př́ıslušnou ikonu nebo program najdeme v menu. Dř́ıvěǰśı verze
MATLABu pracovaly výhradně s př́ıkazovou řádkou, od verze MATLAB 6 pracuj́ı
s okenńı strukturou, která je uživatelsky př́ıvětivěǰśı (Obr. 1.1).
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Základem grafického rozhrańı MATLABu je Command Window (př́ıkazové okno), dále
Current folder (okno pro správu aktuálńı složky), Workspace (pracovńı prostor) a Com-
mand history (okno historie př́ıkaz̊u). Jednotlivá okna lze uspořádat podle vlastńıho
uvážeńı.

• Command window je tvořen př́ıkazovým řádkem slouž́ıćım ke spouštěńı jednot-
livých př́ıkaz̊u, skript̊u či funkćı a zobrazováńı jejich výstup̊u

• Current folder obsahuje informace o souborech v aktuálńı složce, lze měnit obsah
adresáře, spouštět funkce

• Workspace obsahuje informace o všech definovaných proměnných (rozměr, typ,
velikost v paměti), poklikáńım na jejich název lze v editoru poĺı (Editor) zobrazit
jejich obsah

• Command history je tvořen seznamem dř́ıve použitých př́ıkaz̊u nejen od po-
sledńıho spuštěńı, př́ıkazy lze poklikáńım přenést do př́ıkazové řádky a znovu
spustit nebo kliknut́ım pravým tlač́ıtkem myši vybrat některou z položek kontex-
tového menu

Obr. 1.1. Okenńı struktura MATLABu.

V horńı části hlavńı pracovńı plochy v nástrojové lǐstě se nacháźı ikony pro nastaveńı
a manipulaci s proměnnými, kódy a okny (Obr. 1.2).
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Obr. 1.2. Nástrojová lǐsta s ikonami.

Záložka Home usnadňuje práci se soubory (skupina ikon File), obsahuje ikonky pro
pohodlné otv́ıráńı již existuj́ıćıch soubor̊u, vytvářeńı nových soubor̊u a jejich ukládáńı,
import dat (Import Data), správu proměnných (skupina ikon Variable), dále ikonky
vlastńıho uspořádáńı okenńı struktury (Layout), nastaveńı vlastnost́ı (Preferences) či
cesty k adresář̊um (Set Path).
Záložka Plots umožňuje grafické znázorněńı zvolených proměnných, záložka Apps ob-
sahuje klikaćı prostřed́ı pro prokládáńı křivek daty, optimalizaci, analýzu signálu apod.
V př́ıpadech, kdy je kód upravován (otevřen v okně Editor), se zobraźı daľśı tři nové
záložky: Editor, Publish a View. Tyto záložky obsahuj́ı funkce právě pro práci a úpravu
kódu. Záložka Editor usnadňuje práci s kódy. Skupina ikon File umožňuje otev́ıráńı a
ukládáńı existuj́ıćıch kód̊u, tvorbu nových kód̊u, prohledáváńı a porovnáváńı soubor̊u.
Skupina Edit obsahuje ikony pro vkládáńı předdefinovaných funkćı a komentář̊u, odsa-
zováńı textu, skupina Navigate obsahuje ikony pro pohyb v souboru, Breakpoints ikony
pro práci s ’breakpoints’ a Run ikony pro spouštěńı kódu.
Záložka Publish obsahuje ikony pro grafickou úpravu kódu a View ikony pro členěńı
okna editoru a vlastńıho kódu.

1.2 Základńı ovládáńı

Jak již bylo řečeno v odstavci výše, MATLAB spust́ıme př́ıkazem matlab v př́ıkazové
řádce nebo poklikáńım na odpov́ıdaj́ıćı ikonu. Program se ukončuje př́ıkazem exit

nebo zavřeńım okna, v němž program běž́ı.
Po spuštěńı programu prostřed́ı dominuje Command window s př́ıkazovou řádkou, do
které jsou zadávány veškeré př́ıkazy. Př́ıkazy je možné zadávat, pokud je aktivńı prompt
>> na začátku řádku, př́ıkazy spoušt́ıme klávesou ENTER. Po spuštěńı př́ıkazu se na
následuj́ıćıch řádćıch objevuj́ı výstupy.

>> 3 + 5 př́ıkaz s výpisem výstupńı hodnoty, výstup je dočasně uchován v proměnné
ans. Při spuštěńı daľśıho př́ıkazu, jehož výstup neńı přǐrazen do žádné proměnné, je
hodnota proměnné ans přepsána aktuálńı hodnotou
ans =

8

Přǐrazeńı př́ıkazu do proměnné se realizuje promoćı =, obsah této proměnné může být
kdykoliv zobrazen zadáńım názvu proměnné do př́ıkazové řádky. Při zadáváńı názv̊u
proměnným bychom měli dodržovat určitá pravidla:

5
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• názvy proměnných se mohou skládat z ṕısmen (a–z, A–Z), č́ıslic (0–9) a podtrž́ıtka,
žádné jiné symboly nejsou povoleny

• proměnné muśı zač́ınat ṕısmenem

• proměnné mohou mı́t až 31 znak̊u

• rozlǐsuj́ı se malá a velká ṕısmena (case sensitive)

• pro desetinnou čárku se použ́ıvá desetinná tečka

• měli bychom se vyvarovat použ́ıváńı názv̊u vestavěných funkćı a proměnných

>> a = -2.3 přǐrazeńı hodnoty do proměnné a

a =

-2.3

>> A MATLAB je case sensitive, proměnná A nebyla definována. Chybová hlášeńı
jsou zvýrazňována červenou barvou. Současně je na výstupu nab́ıdnuta možná alter-
nativa (a), a to pouze v př́ıpadě, kdy je definována proměnná podobného názvu
Undefined function or variable ’A’.

Did you mean:

>> a

Vlož́ıme-li za př́ıkaz středńık (;), zameźıme vypisováńı výstupu na obrazovku. Na je-
den řádek je možné zadávat i v́ıce př́ıkaz̊u, pak je oddělujeme čárkou nebo středńıkem.
Pokud chceme př́ıkaz rozdělit na v́ıce řádk̊u, můžeme použ́ıt tři tečky (...) jako po-
kračovaćı znaky.

>> a1 = 7; př́ıkaz s potlačeńım výpisu výstupu
>> a1 zobrazeńı proměnné a1

a1 =

7

>> a2 = ... př́ıkaz na v́ıce řádk̊u
0.025

a2 =

0.025

>> a3 = (2-4)*7, a4 = a2 v́ıce př́ıkaz̊u na řádku s výpisem výstup̊u
a3 =

-14

a4 =

0.025

Provedené př́ıkazy nelze upravit př́ımo, úprava je možná jen editaćı v daľśım př́ıkazu.

K listováńı v historii př́ıkaz̊u slouž́ı klávesy ↑ a ↓ . Klávesy → a ← slouž́ı k pohybu
kurzoru v aktuálńı př́ıkazové řádce. Při použit́ı části př́ıkazu následovaného klávesou

6
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↑ budou nab́ızeny předevš́ım př́ıkazy se shodným začátkem.
Pro přerušeńı výpočtu prováděného př́ıkazu lze použ́ıt klávesovou zkratku CTRL+C,
smazáńı př́ıkazového řádku se provád́ı klávesou ESC.
Symbol % se použ́ıvá jako komentář, veškerý text za t́ımto znakem neńı vyhodnocován.

>> % b = 15/4 komentář (zobrazuje se zeleně)

>> a ↑ doplńı př́ıkaz posledńım definovaným př́ıkazem zač́ınaj́ıćım výrazem a,
v našem př́ıpadě a3 = (2-4)*7, a4 = a2

1.3 Nápověda

Velmi d̊uležitou součást́ı softwaru MATLAB je nápovědńı systém, který obsahuje kom-
pletńı dokumentaci k celým knihovnám funkćı.
Jedńım ze základńıch př́ıkaz̊u pro vyvoláńı nápovědy je samostatný př́ıkaz help, který
v Command Window zobrazuje všechny základńı tématické oblasti spolu s cestou a
jednoduchým popisem.

>> help výpis části seznamu tématických oblast́ı
HELP topics:

Documents\MATLAB - (No table of contents file)

matlab\testframework - (No table of contents file)

matlab\demos - Examples.

matlab\graph2d - Two dimensional graphs.

matlab\graph3d - Three dimensional graphs.

matlab\graphics - Handle Graphics.

matlab\plottools - Graphical plot editing tools
...

Pro zobrazeńı seznamu funkćı s jednoduchým popisem pro konkrétńı tématickou oblast
slouž́ı př́ıkaz help nazev tematicke oblasti.

>> help graph2d výpis části seznamu funkćı tématické oblasti graph2d
Two dimensional graphs.

Elementary X-Y graphs.
plot - Linear plot.

loglog - Log-log scale plot.

semilogx - Semi-log scale plot.

semilogy - Semi-log scale plot.

7
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polar - Polar coordinate plot.

plotyy - Graphs with y tick labels on the left and right.
...

Pro zobrazeńı nápovědy konkrétńı funkce slouž́ı př́ıkaz help nazev funkce. Nápověda
obsahuje název funkce, jej́ı základńı popis, zp̊usob použit́ı, odkaz na hypertextovou va-
riantu nápovědy, funkce s touto funkćı souvisej́ıćı, popř. funkce stejného názvu obsažené
v jiných knihovnách.

>> help sin nápověda k funkci sin (sinus)
sin - Sine of argument in radians

This MATLAB function returns the sine of the elements of X.

Y = sin(X)

Reference page for sin

See also asin, asind, sind, sinh

Other functions named sin

fixedpoint/sin, symbolic/sin

Stejný zp̊usob použit́ı a výstupu jako funkce help má i funkce helpwin s jediným
rozd́ılem – zobrazeńı výstupu v samostatném okně. Práce s nápovědńım systémem se
tak může stát pro uživatele přehledněǰśı a pohodlněǰśı.

Hypertextová nápověda zobrazuje mnohem podrobněǰśı dokumentaci v samostatném
okně. Nápovědu můžeme vyvolat samostatným př́ıkazem doc, který zobrazuje se-
znam všech nainstalovaných toolbox̊u, postupným rozklikáváńım jednotlivých témat se
můžeme dostat k nápovědě konkrétńı funkce. K ńı se můžeme dostat rovněž zadáńım
př́ıkazu doc nazev funkce. Nápověda obsahuje kromě detailněǰśıho popisu samotné
funkce také popis vstupńıch a výstupńıch parametr̊u, mnohdy obsahuje rozbalovaćı
menu (obsahuj́ıćı např. grafické znázorněńı, př́ıklady použit́ı apod.).
Hypertextová nápověda umožňuje vyhledáváńı v knihovnách (Refine by Product),
podle kategorie (Refine by Category) nebo podle typu (Refine by Type).

>> doc sin

Alternativou k př́ıkazu doc je nápověda v menu Home → Resources → ikona otazńıku

nebo Home → Resources → Help → Documentation nebo klávesová zkratka F1.
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Př́ıkazem demo vyvoláme tematicky rozlǐsený seznam demonstračńıch programů ob-
sahuj́ıćı př́ıklady použit́ı či návodná videa. Alternativou je vyvoláńı z menu Home →
Resources → Help → Examples.

Informace o aktuálńı verzi MATLABu a nainstalovaných knihovnách źıskáme použit́ım
př́ıkazu ver.

Př́ıklady k procvičeńı

1. Definujte následuj́ıćı proměnné:

• proměnnou k s hodnotou 5

• proměnnou l s hodnotou -8.3645

2. Spoč́ıtejte obsah S trojúhelńıka, znáte-li délku strany a = 5 cm (proměnná a) a
výšku na stranu a va = 3 cm (proměnná va).

3. Zobrazte několika zp̊usoby nápovědu k funkci pow2() a stručně ji popǐste.

Řešeńı.

1. k = 5, l = -8.3645

2. a = 5, va = 3, S = (a * va)/2

3. help pow2 nebo doc pow2 nebo záložka Home → Resources → Help → Docu-

mentation/klávesová zkratka F1/ikona otazńıku + do Search Documentation
napsat pow2. Př́ıkaz pow2(n) spoč́ıtá 2n.

9
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Kapitola 2

Jednoduché výpočty, proměnné a
matice

Základńı informace

Systém MATLAB je využ́ıván jako nástroj pro jednoduché matematické výpočty stejně
jako složitěǰśı maticové počty a algoritmy z nich vycházej́ıćı. Za základńı stavebńı
kámen systému lze považovat matici, v této kapitole se proto zaměř́ıme předevš́ım na
to, jak matice vytvářet, jak generovat posloupnosti či náhodné hodnoty. Na samotném
závěru kapitoly se seznámı́me s některými speciálńımi výrazy a r̊uznými zp̊usoby výpisu
hodnot.

Výstupy z výuky

Studenti

• jsou schopni systém použ́ıvat jako inteligentńı kalkulačku

• umı́ určit funkčńı hodnoty elementárńıch matematických funkćı

• dokáž́ı definovat proměnné, vektory a matice

• umı́ vytvořit nulovou, jedničkovou a jednotkovou matici, umı́ generovat posloup-
nosti a náhodné prvky

• dokáž́ı vyjmenovat některé speciálńı výrazy, umı́ měnit zp̊usob výpisu hodnot

• znaj́ı obecná pravidla pro definováńı př́ıkaz̊u, rozlǐsuj́ı vstupńı a výstupńı para-
metry
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2.1 MATLAB jako kalkulátor

V MATLABu lze provádět libovolné výpočty, které lze běžně poč́ıtat na kalkulačce.
Jednotlivé výrazy můžeme seskupovat pomoćı běžných operátor̊u (+, –, *, /, ˆ), které
jsou podrobněji rozebrány v Kapitole Maticové operace. Priorita operátor̊u je ř́ızena
umı́stěńım kulatých závorek, ty zároveň slouž́ı i pro argumenty vestavěných či vlastńıch
funkćı.
Mezi nejpouž́ıvaněǰśı vestavěné funkce patř́ı:

• goniometrické funkce a funkce k nim inverzńı: sin(), cos(), tan(), cot(),
asin(), acos(), atan(), acot(),

• hyperbolické funkce a funkce k nim inverzńı: sinh(), cosh(), tanh(), coth(),
asinh(), acosh(), atanh(), acoth(),

• exp() (exponenciálńı funkce), log() (přirozený logaritmus), log10() (dekadický
logaritmus), log2() (logaritmus se základem 2), pow2(n) (n-tá mocnina 2),
pow2(n, m) (n ∗ 2m), sqrt() (2. odmocnina)

• abs() (absolutńı hodnota)

MATLAB má ve své paměti zabudovány i některé konstanty: pi (Ludolfovo č́ıslo), i,
j (imaginárńı jednotky), eps, realmin, realmax.

>> pi Ludolfovo č́ıslo
ans =

3.1416

>> 3*(15.8+3^8) - sin(pi/12) + sqrt(4.8)

ans =

1.9732e+04 výstup znač́ı hodnotu 1.9732 ∗ 104

>> abs(sin(3*pi/2))

ans =

1

Pro celoč́ıselné zaokrouhlováńı se použ́ıvaj́ı následuj́ıćı funkce:
round zaokrouhleńı k nejbližš́ımu celému č́ıslu
floor zaokrouhleńı směrem k minus nekonečnu
ceil zaokrouhleńı směrem k plus nekonečnu
fix zaokrouhleńı směrem k nule

>> r = round(-3.46)

r =

-3

11
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>> fl = floor(-3.46)

fl =

-4

>> c = ceil(-3.46)

c =

-3

>> f = fix(-3.46)

f =

-3

Poznámka. Zaokrouhlováńı č́ısla 5: Kladné prvky s hodnotou 5 za desetinnou čárkou
jsou zaokrouhlovány směrem nahoru (k nejbližš́ımu větš́ımu přirozenému č́ıslu), záporné
prvky s hodnotou 5 za desetinnou čárkou jsou zaokrouhlovány směrem dol̊u (k nej-
bližš́ımu menš́ımu celému č́ıslu).

>> round(11.5)

ans =

12

>> round(-5.5)

ans =

-6

2.2 Proměnné, matice a jejich definováńı

Výstup jakékoliv operace může být uložen (pomoćı znaku =) v proměnné, kterou lze
použ́ıt při daľśıch výpočtech. Pro připomenut́ı, název proměnné je libovolná posloup-
nost ṕısmen, č́ıslic a znaku zač́ınaj́ıćı ṕısmenem.

>> x = 12*sin(pi/2)

x =

12

>> x8 = 8*x definováńı nové proměnné x8 pomoćı proměnné x

x8 =

96

Proměnné mohou být č́ıselnými hodnotami, vektory či maticemi. Numerické hodnoty,
resp. vektory jsou považovány za matice typu 1 x 1, resp. 1 x n či n x 1 (pro řádkový
či sloupcový vektor), kde n je délka vektoru. Matice můžeme definovat výčtem jej́ıch
prvk̊u v hranatých závorkách, přičemž jednotlivé prvky na řádku oddělujeme mezerou
nebo čárkou, jednotlivé řádky matice oddělujeme středńıkem.
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>> u = [1 2 3 4] řádkový vektor
u =

1 2 3 4

>> v = [-1; -2; -3] sloupcový vektor
v =

-1

-2

-3

>> w = [1 3 -2]’ sloupcový vektor můžeme vytvořit i transpozićı (operátor ’)
řádkového vektoru
w =

1

3

-2

>> A = [1 -1 2 -3; 3 0 4 5; 3.2, 5, -6 12] matice, kv̊uli jednomu reálnému
prvku jsou i ostatńı celoč́ıselné prvky matice zobrazovány jako desetinná č́ısla
A =

1.0000 -1.0000 2.0000 -3.0000

3.0000 0 4.0000 5.0000

3.2000 5.0000 -6.0000 12.0000

Prázdnou matici lze vytvořit př́ıkazem [].

>> o = []

o =

[]

Matice lze vytvářet pomoćı už definovaných proměnných, je ovšem potřeba kontrolo-
vat, aby souhlasily typy jednotlivých proměnných.

>> y = [x, 2*x, 3*x]

y =

12 24 36

>> B = [A; u]

B =
1.0000 -1.0000 2.0000 -3.0000

3.0000 0 4.0000 5.0000

3.2000 5.0000 -6.0000 12.0000

1.0000 2.0000 3.0000 4.0000

13
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>> C = [A, v]

C =
1.0000 -1.0000 2.0000 -3.0000 -1.0000

3.0000 0 4.0000 5.0000 -2.0000

3.2000 5.0000 -6.0000 12.0000 -3.0000
>> D = [A; v] př́ıkaz nelze provést kv̊uli nevyhovuj́ıćım rozměr̊um
Error using vertcat

Dimensions of matrices being concatenated are not consistent.

Seznam definovaných proměnných lze źıskat př́ıkazem who. Př́ıkaz whos zobraźı seznam
proměnných i s jejich typy a daľśımi informacemi. Smazat definované proměnné je
možno př́ıkazem clear nazev promennych (názvy proměnných jsou odděleny čárkami),
př́ıkazem clear all smažeme všechny definované proměnné.

>> who

Your variables are:

A B C a a1 a2 a3 a4 ans c f fl o r u

v x x8 y

>> clear C a3 a4 c o r y smazáńı proměnných C, a3, a4, c, o, r, y
>> whos

Name Size Bytes Class Attributes

A 3x4 96 double

B 4x4 128 double

a 1x1 8 double

a1 1x1 8 double

a2 1x1 8 double

ans 1x1 8 double

f 1x1 8 double

fl 1x1 8 double

u 1x4 32 double

v 3x1 24 double

x 1x1 8 double

x8 1x1 8 double

2.3 Funkce pro tvorbu matic

Pro vytvořeńı matic větš́ıch rozměr̊u (obecně rozměr̊u m x n, m řádk̊u, n sloupc̊u) je
možné použ́ıt některých funkćı MATLABu:
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zeros(m, n) nulová matice (na všech pozićıch jsou nulové hodnoty)
ones(m, n) jedničková matice (na všech pozićıch jsou hodnoty rovny jedné)
eye(m, n) jednotková matice (na hlavńı diagonále jsou jedničky, jinde nuly)
rand(m, n) matice s náhodnými prvky mezi 0 a 1
randn(m, n) matice s prvky maj́ıćı standardizované normálńı rozděleńı

Všechny výše uvedené funkce je možné zadávat pouze s jedńım parametrem – v ta-
kovém př́ıpadě je vytvořena čtvercová matice př́ıslušného řádu.

>> Z = zeros(2,5) nulová matice o 2 řádćıch a 5 sloupćıch
Z =

0 0 0 0 0

0 0 0 0 0
>> O = ones(3,4) jedničková matice o 3 řádćıch a 4 sloupćıch
O =

1 1 1 1

1 1 1 1

1 1 1 1
>> I = eye(5,8) jednotková matice o 5 řádćıch a 8 sloupćıch
O =

1 0 0 0 0 0 0 0

0 1 0 0 0 0 0 0

0 0 1 0 0 0 0 0

0 0 0 1 0 0 0 0

0 0 0 0 1 0 0 0
>> o = ones(0,5) prázdná matice
o =

Empty matrix: 0-by-5

>> O1 = ones(3) čtvercová jedničková matice
O1 =

1 1 1

1 1 1

1 1 1
>> R1 = rand(3,5) náhodná matice o 3 řádćıch a 5 sloupćıch
R1 =

0.8147 0.9134 0.2785 0.9649 0.9572

0.9058 0.6324 0.5469 0.1576 0.4854

0.1270 0.0975 0.9575 0.9706 0.8003
>> R2 = randn(4) čtvercová náhodná matice s prvky z normálńıho rozložeńı
R2 =

-0.2050 1.4172 1.6302 -0.3034

-0.1241 0.6715 0.4889 0.2939

1.4897 -1.2075 1.0347 -0.7873

1.4090 0.7172 0.7269 0.8884
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Jelikož jsou vektory považovány za matice s jedńım řádkem nebo jedńım sloupcem, po-
moćı výše uvedených funkćı a nastaveńım jednoho z argument̊u na hodnotu 1 můžeme
vytvářet i vektory. Vektor, jehož prvky tvoř́ı aritmetickou posloupnost (tzv.

”
ekvi-

distantńı“ vektor), je možné vytvořit pomoćı operátoru : (dvojtečka). Př́ıkaz a : b

vygeneruje aritmetickou posloupnost prvk̊u od a do b s krokem 1. Pro jiný krok mezi
jednotlivými prvky lze použ́ıt př́ıkaz a : d : b, kde d je délka kroku, je možno použ́ıt
i záporný krok.

>> x = 1:10 vytvořeńı posloupnosti s krokem 1
x =

1 2 3 4 5 6 7 8 9 10

>> y = 0:2:12 vytvořeńı posloupnosti sudých č́ısel
y =

0 2 4 6 8 10 12

>> z = 0.5 : 0.1 : 1.1

z =

0.5 0.6 0.7 0.8 0.9 1 1.1

>> x1 = 15:-2:7 vytvořeńı posloupnosti se záporným krokem
x1 =

15 13 11 9 7

>> x2 = 2:3:15

x2 =

2 5 8 11 14

Př́ıkazy a : b, popř. a : d : b, lze nahradit př́ıkazy colon(a, b), popř. colon(a,
d, b).

>> x3 = colon(2,3,15) analogie k 2:3:15

x3 =

2 5 8 11 14

Daľśı alternativou pro generováńı ekvidistantńıch vektor̊u jsou př́ıkazy linspace() a
logspace():
x = linspace(a, b, n) generuje aritmetickou posloupnost prvk̊u x od a do b. Třet́ı
parametr n je volitelný, udává počet prvk̊u posloupnosti x, jeho implicitńı nastaveńı
na n=100 lze libovolně měnit.
x = logspace(a, b, n) generuje vektor x s deśıtkovou logaritmickou škálou prvk̊u
od 10^a do 10^b. Třet́ı parametr délky posloupnosti n je volitelný, jeho implicitńı na-
staveńı je n=50. Př́ıkaz je ekvivalentńı př́ıkazu 10.^linspace(a, b, n).

>> x = linspace(-1, 4, 8)

x =

-1.0000 -0.2857 0.4286 1.1429 1.8571 2.5714 3.2857

4.0000

16



KAPITOLA 2. JEDNODUCHÉ VÝPOČTY, PROMĚNNÉ A MATICE

>> x = logspace(0, 1, 5) ekvivalentńı př́ıkazu 10.^linspace(0, 1, 5)

x =

1.0000 1.7783 3.1623 5.6234 10.0000

>> x = 10.^linspace(0, 1, 5)

x =

1.0000 1.7783 3.1623 5.6234 10.0000

2.4 Některé speciálńı výrazy a funkce

Zvláštńı postaveńı mezi proměnnými má proměnná ans (z anglického answer), do které
se automaticky přǐrazuj́ı hodnoty, jež nebyly přǐrazeny explicitně do proměnné.

>> pi

ans =

3.1416

Dále i a j jsou imaginárńı jednotky pro práci s komplexńımi č́ısly. Daľśı speciálńı hod-
notou je eps – je to rozd́ıl mezi 1 a nejbližš́ım vyšš́ım zobrazitelným č́ıslem. Př́ıkazem
realmin a realmax zjist́ıme hodnotu nejmenš́ıho, resp. největš́ıho zobrazitelného č́ısla
podle normy IEEE. Hodnoty Inf a −Inf vznikaj́ı např. při děleńı nulou a symbolizuj́ı
nekonečné hodnoty (+∞ nebo −∞). Hodnotu NaN (Not a Number) dostaneme jako
výsledek neurčitého výrazu – např. 0/0.

Zp̊usob výpisu hodnot můžeme ovlivnit př́ıkazem format:

format long výpis na plný počet desetinných mı́st
format short výpis na omezený počet desetinných mı́st
format bank výpis na 2 desetinná mı́sta (implicitńı)
format hex hexadecimálńı výpis
format rat hodnoty jsou aproximovány zlomky
format compact potlač́ı se vynecháváńı řádku při výpisu
format loose zapne se vynecháváńı řádku při výpisu

>> pi

ans =

3.1416

>> format long

>> pi

ans =

3.141592653589793
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>> format rat

>> pi

ans =

355/113

>> abs(1+i) absolutńı hodnota komplexńıho č́ısla a+i·b je definována jako
√
a2 + b2

ans =

1.4142

2.5 Obecná pravidla pro př́ıkazy

Na jednu řádku můžeme zadat několik př́ıkaz̊u oddělených čárkou nebo středńıkem,
který potlačuje výstup na obrazovku:

přı́kaz1, přı́kaz2, přı́kaz3, atd.,

přičemž za posledńım př́ıkazem na řádce čárka být nemuśı. Pokud je př́ıkaz př́ılǐs
dlouhý, můžeme ukončit řádku třemi tečkami (...), př́ıkaz pak pokračuje na daľśı
řádce.

Jednotlivé př́ıkazy mohou být jednoduché př́ıkazy MATLABu (who, clear, dir),
př́ıkazy definuj́ıćı proměnné (A = [1 2; 3 4];), voláńı MATLABovských programů –
tzv. skript̊u, nebo voláńı MATLABovských funkćı. Toto voláńı má v obecném př́ıpadě
tvar:

[v1, v2, ..., vm] = nazev funkce(p1, p2, ..., pn)

v1, ..., vm jsou výstupńı parametry, p1,..., pn jsou parametry vstupńı. Pokud je
výstupńı parametr jen jeden, nemuśı být uzavřen v hranatých závorkách. Funkce také
nemuśı mı́t žádné vstupńı nebo výstupńı parametry, také je možné zadávat r̊uzný počet
vstupńıch nebo výstupńıch parametr̊u pro tutéž funkci.

>> A = rand(3);

>> s = size(A)

s =

3 3

>> [x, y] = size(A)

x =

3

y =

3

>> sl = size(A, 2)

sl =

3

Vykřičńık na začátku př́ıkazu provede př́ıkaz operačńıho systému, např. př́ıkazem !netscape

spust́ıme známý internetový prohĺıžeč.
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Př́ıklady k procvičeńı

1. Spoč́ıtejte velikost úhlu α při vrcholu A trojúhelńıku ABC, znáte-li délku proti-
lehlé strany a = 5 cm a přilehlé strany b = 3 cm.

2. Vypǐste hodnotu Ludolfova č́ısla, pak:
a) jej zaokrouhlete k nejbližš́ımu celému č́ıslu,
b) jej zaokrouhlete k plus nekonečnu,
c) jej zobrazte jako zlomek,
d) jej zobrazte na plný počet desetinných mı́st.

3. Třemi zp̊usoby vygenerujte vektor u1 délky 10 s počátečńı hodnotou 2 a krokem
0.2.

4. Vygenerujte náhodný vektor délky 5
a) s názvem u2 a prvky z intervalu [0, 1],
b) s názvem u3 a prvky z intervalu [−2, 4],
c) s názvem u4 a celoč́ıselnými prvky z intervalu [−8, 1].

5. Vygenerujte matici s rozměry 5x3
a) s názvem A1 a prvky z intervalu [−12, 5],
b) s názvem A2 a celoč́ıselnými prvky z intervalu [1, 7].

6. Vytvořte matici B rozměr̊u 4x5 sestavenou z vektoru u4 a matice A2.

7. Vytvořte matici rozměr̊u 4x9
a) s názvem C1, matićı B v levém bloku a jednotkovou matićı v pravém bloku,
b) s názvem C2, matićı B v levém bloku a matićı obsahuj́ıćı hodnoty 0.5 v pravém
bloku.

Řešeńı.

1. a = 5, b = 3

alpha = tan(a/b)

2. exp(1)

a) round(exp(1))
b) ceiling(exp(1))
c) format rat, exp(1)

d) format long, exp(1)
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3. 1. zp̊usob: u1 = 2:0.2:3.8,
2. zp̊usob: u1 = colon(2, 0.2, 3.8),
3. zp̊usob: u1 = linspace(2, 3.8, 10)

4. a) u2 = rand(1, 5)

b) u3 = 6*rand(1, 5) - 2

c) u4 = round(9*rand(1, 5) - 8)

5. a) A1 = rand(17*rand(5, 3) - 12)

b) A2 = round(6*rand(5, 3)+1)

6. B = [u4; A2’]

7. a) C1 = [B, eye(4)]

b) C2 = [B, 0.5 + zeros(4)] nebo
C2 = [B, 0.5 + zeros(4, 4)] nebo
C2 = [B, 0.5 + ones(4)] nebo
C2 = [B, 0.5 + ones(4, 4)]

20
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Kapitola 3

Maticové operace

Základńı informace

Již ze samotného názvu systému MATLAB, který pocháźı z anglického MATrix LABo-
ratory, je zřejmé, že zde hlavńı roli při práci bude hrát matice. Proto je velmi d̊uležité
se nejen naučit porozumět maticovým operaćım, ale také je umět výhodně využ́ıvat.
Ćılem následuj́ıćı kapitoly je rozš́ı̌rit již známé maticové operace o operace méně známé
a demonstrovat práci s nimi na jednoduchých př́ıkladech.

Výstupy z výuky

Studenti

• seznámı́ se s transpozićı reálných i komplexńıch matic

• ovládaj́ı sč́ıtáńı a odč́ıtáńı matic

• umı́ správně použ́ıt maticové násobeńı a umocňováńı matic

• umı́ vysvětlit rozd́ıl mezi pravostranným a levostranným násobeńım a děleńım
matic

• dokáž́ı definovat operace po složkách

3.1 Transpozice matic

Transpozici matic označuje jednoduchý apostrof (’), př́ıpadně jednoduchý apostrof
s tečkou (.’). V př́ıpadě reálných matic mezi těmito operátory neńı rozd́ıl, oba definuj́ı
transponovanou matici. Pokud ovšem má matice A komplexńı prvky, př́ıkazem X=A’
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źıskáme matici X, která vznikne transpozićı matice A, ale také jej́ı prvky budou kom-
plexně sdružené k prvk̊um matice A, tj. xij = aji.
Pokud bychom chtěli źıskat pouze transponovanou matici X bez komplexně sdružených
prvk̊u, tj. xij = aji, je třeba použ́ıt jednoduchý apostrof s tečkou (.’).

>> A = [1 1+i; 2-3*i i]

A =
1.0000 + 0.0000i 1.0000 + 1.0000i

2.0000 - 3.0000i 0.0000 + 1.0000i
>> X = A’ transpozice s komplexně sdruženými prvky
X =

1.0000 + 0.0000i 2.0000 + 3.0000i

1.0000 - 1.0000i 0.0000 + 1.0000i
>> X = A.’ transpozice bez komplexně sdružených prvk̊u
X =

1.0000 + 0.0000i 2.0000 - 3.0000i

1.0000 + 1.0000i 0.0000 + 1.0000i

3.2 Sč́ıtáńı a odč́ıtáńı matic

Symboly + a - označuj́ı sč́ıtáńı a odč́ıtáńı matic. Matice muśı mı́t shodné dimenze.
Operace jsou prováděny po složkách, tj. xij = aij ± bij. Přič́ıtáńı a odč́ıtáńı konstanty
k matici se realizuje po složkách, tj. konstanta je přičtena, popř. odečtena, ke každému
prvku matice.

>> A = [1 5; 2 3];

>> B = [0 1; -3 2];

>> X = A + B

X =
1 6

-1 5
>> c = 2;

>> X = A + c odpov́ıdá xij = aij + c
X =

3 7

4 5
>> X = c - B odpov́ıdá xij = c− bij
X =

2 1

5 0
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3.3 Maticové násobeńı

Symbol * označuje maticové násobeńı. Operace je definována, pokud jsou vnitřńı
rozměry dvou operand̊u stejné, tj. pokud je počet sloupc̊u prvńıho činitele shodný
s počtem řádk̊u druhého činitele. Necht’ A je typu n × k a B typu k × m, výsledná

matice X bude typu n×m a plat́ı xij =
k∑
r=1

airbrj.

Při násobeńı matice konstantou je operace provedena po složkách.

>> A = [1 5 0; -1 2 3]

A =
1 5 0

-1 2 3
>> B = [0 1 1; 1 -3 2; -1 4 2; 1 0 3]

B =
0 1 1

1 -3 2

-1 4 2

1 0 3
>> X = A * B součin se neprovede kv̊uli nesouhlasným rozměr̊um činitel̊u
Error using *

Inner matrix dimensions must agree.

>> X = A * B’

X =
5 -14 19 1

5 -1 15 8
>> c = 2;

>> X = A * c odpov́ıdá xij = aij ∗ c
X =

2 10 0

-2 4 6
>> X=c*B odpov́ıdá xij = c ∗ bij
X =

0 2 2

2 -6 4

-2 8 4

2 0 6

3.4 Maticové děleńı

V MATLABu existuj́ı dva zp̊usoby děleńı matic – levostranné \ a pravostranné / děleńı.
Obecně plat́ı
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X = A \ B je řešeńım A ∗X = B,

X = B / A je řešeńım X ∗ A = B.

Je-li A regulárńı čtvercová matice, potom X = A\B, resp. X = B/A, formálně odpov́ıdaj́ı
levostrannému, resp. pravostrannému, násobeńı matice B matićı inverzńı k matici A; tj.
inv(A)*B resp. B*inv(A). Funkce inv() slouž́ı pro výpočet inverzńı matice, výpočet
pomoćı levostranného, resp. pravostranného, děleńı je źıskán př́ımo, bez výpočtu in-
verze.
Je-li matice A obecně typu k × n, B muśı být typu k × m, výsledná matice X = A\B
bude typu n × m. Pravostranné děleńı X = B/A je definováno pomoćı levostranného
děleńı jako X = B/A, což je ekvivalentńı (A’\B’)’.
Při děleńı matice konstantou se děleńı provád́ı po složkách, výsledek pravostranného i
levostranného děleńı je stejný.

>> A = [1 5 0; -1 2 3; 1 2 1];

>> b = [1 3 2]’;

>> x = A \ b můžeme se přesvědčit, že tento př́ıkaz je ekvivalentńı př́ıkazu x =

inv(A) * b

x =
0.6875

0.0625

1.1875
>> x = inv(A) * b

x =
0.6875

0.0625

1.1875
>> c = 2;

>> x = c \ A

x =
0.5000 2.5000 0

-0.5000 1.0000 1.5000

0.5000 1.0000 0.5000
>> x = A / c

x =
0.5000 2.5000 0

-0.5000 1.0000 1.5000

0.5000 1.0000 0.5000
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3.5 Umocňováńı matic

Pro maticové umocňováńı se použ́ıvá symbol ^. Předpokládejme, že A je čtvercová
matice a p je skalár. Při umocňováńı mohou nastat tyto př́ıpady:

1. X = A^p

(a) p > 0 celé č́ıslo ⇒ X = A ∗ A ∗ · · · ∗ A︸ ︷︷ ︸
p

(b) p = 0⇒ X = I . . . jednotková matice (lze vytvořit př́ıkazem eye(size(A)))

(c) p < 0 celé č́ıslo ⇒ X = A−1 ∗ A−1 ∗ · · · ∗ A−1︸ ︷︷ ︸
p

(d) p neńı celé č́ıslo ⇒ uvažujme diagonálńı matici D =

λ1 0
. . .

0 λn

 , kde

λ1, . . . , λn jsou vlastńı č́ısla matice A, a matici V , jej́ıž sloupce jsou vlastńı
vektory př́ıslušné postupně těmto vlastńım č́ısl̊um ([V,D] = eig(A)). Plat́ı
tedy vztah A∗V = V ∗D, což je v tomto př́ıpadě jakási motivace pro výpočet

mocniny. Lze ukázat, že plat́ı Ap ∗ V = V ∗Dp, kde Dp =

λ
p
1 0

. . .

0 λpn

 .

Odtud dostáváme vztah pro výpočet X = V ∗Dp/V .

2. X = p^A

Při výpočtu opět vycháźıme ze vztahu A ∗ V = V ∗ D, kde V a D jsou výše

popsané matice. Odtud je pA ∗ V = V ∗ pD, kde pD =

p
λ1 0

. . .

0 pλn

 . Odtud

opět dostáváme vztah pro výpočet X = V ∗ pD/V .

Pokud matice A neńı čtvercová nebo pokud p neńı skalár, výpočet skonč́ı chybovým
hlášeńım.

>> A = [1 3; 3 2];

>> p = 0.5;
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>> [V, D] = eig(A) výpočet vlastńıch č́ısel (diagonálńı prvky matice D) a vlastńıch
vektor̊u (sloupce matice V)
V =

-0.7630 0.6464

0.6464 0.7630
D =

-1.5414 0

0 4.5414
>> X = A^p

X =
0.8904 + 0.7228i 1.0510 - 0.6123i

1.0510 - 0.6123i 1.2407 + 0.5187i
>> X = V*D^p/V

X =
0.8904 + 0.7228i 1.0510 - 0.6123i

1.0510 - 0.6123i 1.2407 + 0.5187i
>> Y = p^A

Y =
1.7126 -1.4144

-1.4144 1.2411
>> Y = V*p^D/V

Y =
1.7126 -1.4144

-1.4144 1.2411

3.6 Operace po složkách

V MATLABu lze též provádět tzv.
”
operace po složkách“. Tyto operace se definuj́ı

tak, že před operaci, kterou chceme provádět po složkách, zadáme tečku (.). U ope-
raćı, které se automaticky provád́ı po složkách (sč́ıtáńı a odč́ıtáńı), přidáńı tečky nemá
smysl a výpočet konč́ı chybovým hlášeńım. Uvažujme tedy libovolný maticový operátor
◦ ∈ {∗, /, \, ˆ}. Pro prováděńı operaćı po složkách muśı být obě matice shodné di-
menze, výstup bude mı́t tutéž dimenzi. Obecně tedy pro prvky matice X=A.◦B plat́ı
xij = aij ◦ bij.

Poznámka. Mezi operátory, u nichž má význam operace po složkách patř́ı také trans-
pozice, která je bĺıže popsána v odstavci Transpozice matic.

>> A = [1 2; 3 4]

A =
1 2

3 4

26



KAPITOLA 3. MATICOVÉ OPERACE

>> B = [2 4;6 8]

A =
2 4

6 8
>> X = A*B

X =
14 20

30 44
>> X = A.*B

X =
2 8

18 32
>> X = B/A

X =
2 0

0 2
>> X = B./A

X =
2 2

2 2
>> X = B^A neexistuje
Error using ^

Inputs must be a scalar and a square matrix.

To compute elementwise POWER, use POWER (.^) instead.

>> X = B.^A

X =
2 16

216 4096

Operace po složkách lze také provádět tehdy, pokud jedna z matic je skalár. V tomto
př́ıpadě má tečka smysl pouze u operace umocňováńı, nebot’ ostatńı operace se prove-
dou po složkách automaticky.

>> c = 2;

>> X = A/c děleńı konstantou s operátorem / vraćı stejný výsledek jako
s operátorem ./

X =
0.5000 1.0000

1.5000 2.0000
>> X = A./c

X =
0.5000 1.0000

1.5000 2.0000
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>> X = A^c při umocňováńı je tečka podstatná

X =
7 10

15 22
>> X = A.^c

X =
1 4

9 16
>> X = c^A

X =
10.4827 14.1519

21.2278 31.7106
>> X = c.^A

X =
2 4

8 16

3.7 Logické operace

Mezi tyto operace patř́ı relačńı operátory a logické funkce. Vı́ce se o nich dozv́ıme
v Kapitole 5.

3.8 Smı́̌sené operace

Jednotlivé operace (logické i aritmetické) je možné vzájemně efektivně kombinovat.
Priorita operaćı je následuj́ıćı (od nejvyšš́ı po nejnižš́ı):

1. umocňováńı: ^ .^

2. násobeńı, děleńı: * .* \ .\ / ./

3. sč́ıtáńı, odč́ıtáńı: + -

4. relačńı operátory: == ~= < <= > >=

5. negace: ~
6. logické spojky ’a’ a ’nebo’: & |

Prioritu výše uvedených operátor̊u můžeme ř́ıdit pomoćı kulatých závorek.
Všechny operátory pro práci s maticemi uvedené v této kapitole maj́ı své ekvivalenty:
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funkce význam operátor
plus plus +

uplus unárńı plus +

minus minus −
uminus unárńı minus −
mtimes maticové násobeńı *

times násobeńı po prvćıch .*

mpower maticová mocnina ^

power mocnina po prvćıch .^

mldivide levé maticové děleńı \
mrdivide pravé maticové děleńı /

ldivide levé děleńı po prvćıch .\
rdivide pravé děleńı po prvćıch ./

Př́ıklady k procvičeńı

1. Jsou dány matice A = [1 0 -1; 2 1 1], B = [2 -2 1; 0 1 2], C = [1 0 1;

0 1 1; 1 0 0] a D = [3 5 -6; 1 1 -2; 0 -2 0]. Vyřešte následuj́ıćı rovnice:
a) A + X1 = B,
b) (A - X2) * C = B,
c) A’*(X3 - B) = D.

2. Vytvořte komplexńı matici F, jej́ıž reálná část bude tvořena matićı X1 a ima-
ginárńı část matićı X2.
a) Vytvořte k ńı transponovanou matici F1.
b) Vytvořte k ńı transponovanou matici F2, která bude nav́ıc obsahovat kom-
plexně sdružené prvky.

3. Je dána matice E = [1 2; -1 1].
a) Vytvořte matici E1, která bude druhou mocninou matice E.
b) Vytvořte matici E2, která bude obsahovat druhé mocniny prvk̊u matice E.
c) Vytvořte matici E3 funkčńıch hodnot funkce kotangens v bodech E.

Řešeńı.

1. A = [1 0 -1; 2 1 1], B = [2 -2 1; 0 1 2], C = [1 0 1; 0 1 1; 1 0 0],

D = [3 5 -6; 1 1 -2; 0 -2 0]

a) X1 = B - A

b) X2 = A - B/C

c) X3 = A’\ D+B

2. F = X1 + i*X2

a) F1 = F.’

b) F2 = F’
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3. E = [1 2; -1 1]

a) E1 = E^2

b) E2 = E.^2

c) E3 = cot(E)
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Kapitola 4

Manipulace s maticemi

Základńı informace

Pro praktické řešeńı problémů je d̊uležitá dobrá orientace v možnostech, které systém
nab́ıźı. Následuj́ıćı kapitola nab́ıźı přehled a praktické ukázky použit́ı nejd̊uležitěǰśıch
a často použ́ıvaných funkćı a př́ıkaz̊u pro manipulaci s maticemi.

Výstupy z výuky

Studenti

• dokáž́ı vytvářet submatice a zjistit rozměry matice

• seznámı́ se s maticovými operacemi - sč́ıtáńı, odč́ıtáńı, násobeńı, děleńı

• umı́ použ́ıt funkci reshape() a znaj́ı funkce pro překlápěńı a otáčeńı matice

• ovládaj́ı základńı funkce lineárńı algebry

• demonstruj́ı práci s diagonálami matice

• aplikuj́ı funkce min(), max(), sum(), prod()

4.1 Základńı manipulace s maticemi

Pro zjǐstěńı rozměr̊u matice slouž́ı př́ıkaz size(). Tento př́ıkaz má i volitelný druhý
argument – v př́ıpadě hodnoty 1 vraćı počet řádk̊u matice, v př́ıpadě hodnoty 2 vraćı
počet sloupc̊u matice. Př́ıkaz size() lze použ́ıt i pro zjǐstěńı rozměr̊u vektoru, al-
ternativńım př́ıkazem pro počet prvk̊u (řádkového i sloupcového) vektoru je př́ıkaz
length(). Př́ıkaz length() lze použ́ıt i pro matici, v tomto př́ıpadě vraćı jej́ı největš́ı
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rozměr.

>> A = [1 -1 2 -3; 3 0 4 5; 3.2, 5, -6 12]

A =
1.0000 -1.0000 2.0000 -3.0000

3.0000 0 4.0000 5.0000

3.2000 5.0000 -6.0000 12.0000
>> [r, sl] = size(A) výstup funkce size() lze uložit do 2-prvkového vektoru,
prvńı prvek udává počet řádk̊u matice A, druhý počet sloupc̊u
r =

3

sl =

4

>> r1 = size(A, 1) počet řádk̊u matice A

r1 =

3

>> u = [3 -1 2]

u =

3 -1 2

>> size(u)

ans =

1 3

>> length(u) počet prvk̊u vektoru
ans =

3

>> length(A) největš́ı rozměr matice A

ans =

4

Na jednotlivé prvky matice je možné se odkazovat pomoćı kulatých závorek – tj.
A(r,sl) je prvek matice A na r-tém řádku a v s-tém sloupci. Toto vyjádřeńı lze použ́ıt
i obecněji, kdy prvńı parametr je vektor obsahuj́ıćı indexy vybraných řádk̊u a druhý
parametr je vektor sloupcových index̊u.

>> A(2,3) prvek na 2. řádku a ve 3. sloupci matice A

ans =

4

>> A([1 3],[4 2]) prvky na 1. a 3. řádku a 4. a 2. sloupci matice A

ans =
-3 -1

12 5
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>> A([1 3],[4 2]) = eye(2) do takto vybraných prvk̊u je možno také při za-
chováńı správných rozměr̊u provádět přǐrazeńı
A =

1.0000 0 2.0000 1.0000

3.0000 0 4.0000 5.0000

3.2000 1.0000 -6.0000 0.0000

Symbol : (dvojtečka) slouž́ı pro výběr celého řádku/sloupce matice.

>> u1 = A(:, 3) výběr 3. sloupce matice A

u1 =
2

4

-6
>> u2 = A(2,:) výběr 2. řádku matice A

u2 =

3 0 4 5

>> A(2,:) = [] smazáńı 2. řádku matice A

A =
1.0000 0 2.0000 1.0000

3.2000 1.0000 -6.0000 0.0000

Poznámka. Přǐrazeńı o = []; A(:,3) = o nefunguje, vraćı chybové hlášeńı.

Matice stejných rozměr̊u lze sč́ıtat a odč́ıtat (operátory +, -), při přičteńı konstanty
k matici je konstanta přičtena ke každému prvku matice.
Matice vhodných rozměr̊u lze násobit (operátor *), při násobeńı matice konstantou je
konstantou přenásoben každý prvek matice. Děleńı je v MATLABu dvoj́ıho druhu –
pravostranné a levostranné: \ a /.
Všechny operátory jsou podrobněji popsány v Kapitole 3.

Na matice lze rovněž aplikovat všechny běžné matematické funkce (sin(), sqrt(), . . . ),
které jsou popsány v Odstavci MATLAB jako kalkulátor. Tyto funkce jsou na matice
aplikovány po složkách (člen po členu).

4.2 Změna struktury matice

V MATLABu je možné měnit strukturu již existuj́ıćım objekt̊um, např. přeskládat
matici do matice jiných rozměr̊u. Př́ıkazem B = reshape(A, m, n) lze po sloupćıch
přeskládat matici A do matice B o m řádćıch a n sloupćıch. Obě matice A i B muśı mı́t
stejný počet prvk̊u, v opačném př́ıpadě př́ıkaz skonč́ı chybovým hlášeńım.
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>> A = [1:6; 7:12]

A =
1 2 3 4 5 6

7 8 9 10 11 12
>> B = reshape(A, 3, 4)

B =
1 8 4 11

7 3 10 6

2 9 5 12

Pokud bychom chtěli matici přeskládat po řádćıch, museli ji bychom nejdř́ıv transpo-
novat a nakonec opět transponovat celý př́ıkaz.

>> B = (reshape(A’, 4, 3))’

B =
1 2 3 4

5 6 7 8

9 10 11 12

Překlopit matici, tj. obrátit pořad́ı řádk̊u, resp. sloupc̊u, je možné provést př́ıkazem
flipud(), resp. fliplr(). Matici lze

”
otočit“ o 90 stupň̊u proti směru hodinových

ručiček př́ıkazem rot90(), přičemž daľśı nepovinný parametr udává, kolikrát má být
rotace provedena.

>> C1 = flipud(B) převrácené pořad́ı řádk̊u
C1 =

9 10 11 12

5 6 7 8

1 2 3 4
>> C2 = fliplr(B) převrácené pořad́ı sloupc̊u
C2 =

4 3 2 1

8 7 6 5

12 11 10 9
>> C3 = rot90(B, 3) třikrát otočená matice B o 90 ◦ proti směru hodinových
ručiček
C3 =

9 5 1

10 6 2

11 7 3

12 8 4

Jedńım z daľśıch př́ıkaz̊u, které využ́ıvaj́ı dvojtečku, je A(:). A(:) na pravé straně
přǐrazovaćıho př́ıkazu označuje všechny sloupce matice A seskládané do jednoho dlouhého
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sloupcového vektoru.

>> A = [1 2; 3 4; 5 6]

A =
1 2

3 4

5 6
>> b = A(:)

b =
1

2

3

4

5

6

Pokud již matice A existuje, lze A(:) použ́ıt i na levé straně přǐrazovaćıho př́ıkazu ke
změně tvaru nebo velikosti matice. Potom A(:) označuje matici svými rozměry stejnou
matici A, prvky za přǐrazovaćım př́ıkazem jsou do matice A umist’ovány po sloupćıch.
Tato operace je zahrnuta ve funkci reshape().

>> A(:) = 11:16 změńı šestiprvkový řádkový vektor 11:16 na matici stejných
rozměr̊u jako A, tj. 3× 2
A =

11 14

12 15

13 16

4.3 Základńı funkce lineárńı algebry

V MATLABu je implementováno velké množstv́ı funkćı a algoritmů lineárńı algebry.
Podrobný výpis lze źıskat pomoćı nápovědy help matfun.

Zde vyjmenujeme jen některé základńı:
det() determinant matice
rank() hodnost matice
norm() maticová nebo vektorová norma
trace() stopa matice (součet diagonálńıch prvk̊u)
inv() inverzńı matice
pinv() pseudoinverzńı matice
lu() LU rozklad
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qr() QR rozklad
svd() singulárńı rozklad
eig() vlastńı hodnoty a vektory matice
poly() charakteristický polynom matice

Syntaxi jednotlivých funkćı zjist́ıme nejlépe pomoćı nápovědy.

>> A = [3 -1; 2 0];

>> d = det(A) determinant
d =

2

>> h = rank(A) hodnost matice A

h =

2

>> tr = trace(A) stopa matice A, ekvivalentńı př́ıkaz: sum(diag(A))
tr =

3

>> [L, U] = lu(A) rozklad matice A na dolńı (L) a horńı (U) trojúhelńıkovou ma-
tici, jejich součinem dostáváme p̊uvodńı matici (A = L*U)
L =

1.0000 0

0.6667 1.0000
U =

3.0000 -1.0000

0 0.6667
>> p = poly(A) charakteristický polynom matice A, výstup odpov́ıdá polynomu
p(x) = x2 − 3x+ 2
p =

1 -3 2

4.4 Daľśı funkce pro manipulaci s maticemi

Dvoj́ı úlohu má funkce diag(). Jej́ı aplikaćı na vektor źıskáme diagonálńı matici s ar-
gumentem na hlavńı diagonále. Pokud funkci použijeme na matici, výstupem je vektor
jej́ıch diagonálńıch prvk̊u. Pokud chceme pracovat s jinou diagonálou než s hlavńı,
můžeme použ́ıt jako druhý parametr funkce diag() č́ıslo diagonály, přičemž kladná
č́ısla se použij́ı pro diagonály nad hlavńı diagonálou a záporná pod ńı.
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>> A = round(10*rand(5)) celoč́ıselná matice s prvky od 0 do 10
A =

8 7 8 4 5

7 0 7 4 4

4 3 3 8 6

7 0 10 8 7

2 1 0 2 8
>> x = diag(A) vektor diagonálńıch prvk̊u
x =

8

0

3

8

8
>> B = diag(x,2) nulová matice s prvky x na 2. diagonále nad hlavńı diagonálou
B =

0 0 8 0 0 0 0

0 0 0 0 0 0 0

0 0 0 0 3 0 0

0 0 0 0 0 8 0

0 0 0 0 0 0 8

0 0 0 0 0 0 0

0 0 0 0 0 0 0
>> C = diag(pi, -2)

C =
0 0 0

0 0 0

3.1416 0 0
>> D = diag(diag(A)) diagonálńı matice
D =

8 0 0 0 0

0 0 0 0 0

0 0 3 0 0

0 0 0 8 0

0 0 0 0 8

Pomoćı funkćı tril() a triu() vyrob́ıme z dané matice dolńı nebo horńı trojúhelńıkovou
matici, přičemž je možné podobně jako u funkce diag() použ́ıt daľśı nepovinný para-
metr pro posunut́ı diagonály.
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>> L1 = tril(A) dolńı trojúhelńıková matice
L1 =

8 0 0 0 0

7 0 0 0 0

4 3 3 0 0

7 0 10 8 0

2 1 0 2 8
>> L2 = tril(A,2)

L2 =
8 7 8 0 0

7 0 7 4 0

4 3 3 8 6

7 0 10 8 7

2 1 0 2 8

Funkce max() hledá maximálńı prvek vektoru, pokud na výstupu uvedeme i druhý
výstupńı parametr, ulož́ı se do něj index maximálńıho prvku. Při použit́ı funkce max()

na matici se hledaj́ı maximálńı prvky v jednotlivých sloupćıch, do volitelného druhého
výstupńıho parametru jsou ukládány řádkové indexy maximálńıho prvku v daném
sloupci. Podobně funguje funkce min().

>> x = rand(1,6)

x =

0.2760 0.6797 0.6551 0.1626 0.1190 0.4984

>> M = max(x)

M =

0.6797

>> [m, ind] = min(x) minimálńı prvek vektoru x i se svou pozićı
m =

0.1190

ind =

5

>> A = rand(4) náhodná matice
A =

0.9597 0.7513 0.8909 0.1493

0.3404 0.2551 0.9593 0.2575

0.5853 0.5060 0.5472 0.8407

0.2238 0.6991 0.1386 0.2543
>> [M, r ind] = max(A)

M =

0.9597 0.7513 0.9593 0.8407

r ind =

1 1 2 3
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U komplexńıch matic se maximum či minimum hledá mezi absolutńımi hodnotami
prvk̊u.

>> K = round(2*rand(3)) + i*round(2*rand(3)) náhodná komplexńı matice
s celoč́ıselnými hodnotami reálné a imaginárńı části
K =

1.0000 + 2.0000i 0.0000 + 0.0000i 0.0000 + 2.0000i

1.0000 + 0.0000i 0.0000 + 2.0000i 2.0000 + 2.0000i

1.0000 + 1.0000i 2.0000 + 0.0000i 1.0000 + 2.0000i
>> absK = abs(K) absolutńı hodnoty prvk̊u komplexńı matice K

absK =
2.2361 0 2.0000

1.0000 2.0000 2.8284

1.4142 2.0000 2.2361
>> [m, r] = min(K) minima komplexńı matice K a jejich řádkové indexy
m =

1.0000 + 0.0000i 0.0000 + 0.0000i 0.0000 + 2.0000i

r =

2 1 1

>> u = [1 3 0 3];

>> [m, ind] = max(u) v př́ıpadě v́ıce shodných maximálńıch prvk̊u je vybrán pr-
vek s nižš́ım indexem
m =

3

ind =

2

Ku vzestupnému seřazeńı vektoru se použ́ıvá funkce sort(), u komplexńıch hodnot se
řazeńı provád́ı podle absolutńıch hodnot. Do druhého nepovinného výstupńıho parame-
tru je umı́stěna tř́ıdićı permutace index̊u. Při použit́ı funkce sort() na matice docháźı
k řazeńı v rámci jednotlivých sloupc̊u.

>> u = [1 3 0 3];

>> [y, ind] = sort(u)

y =

0 1 3 3

ind =

3 1 2 4

>> u(ind) odpov́ıdá seřazenému vektoru
ans =

0 1 3 3
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>> A = [1 0 1; 2 1 3; -1 2 1]

A =
1 0 1

2 1 3

-1 2 1
>> [y, ind] = sort(A)

y =
-1 0 1

1 1 1

2 2 3
ind =

3 1 1

1 2 3

2 3 2

Pro sč́ıtáńı a násobeńı prvk̊u vektoru slouž́ı funkce sum() a prod(). Aplikujeme-li tyto
funkce na matici, př́ıslušná operace je provedena po sloupćıch.

>> f = prod(1:5) faktoriál č́ısla 5
f =

120

Poznámka. Obecně lze n!, n ∈ N0 spoč́ıtat př́ıkazem prod(1:n) i pro n=0, protože
součin přes prázdnou matici je roven 1.

>> f = prod(1:0)

f =

1

Pro zjǐstěńı součtu, popř. součinu, všech prvk̊u matice je třeba funkci sum(), popř.
prod(), použ́ıt dvakrát.

>> soucet = sum(sum(A)) součet všech prvk̊u matice A

soucet =

10

Poznámka. Pro připomenut́ı, pro zjǐstěńı rozměr̊u matice lze použ́ıt funkci size() de
dvoj́ı formě – s = size(A) nebo [r, sl] = size(A). Funkce length() vraćı délku
řádkového či sloupcového vektoru. Pokud ji aplikujeme na matici, dostáváme ma-
ximálńı z rozměr̊u; je ekvivalentńı př́ıkazu max(size(A)).
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Př́ıklady k procvičeńı

1. Vygenerujte celoč́ıselnou náhodnou matici A rozměr̊u 5x6 s prvky z intervalu
[−7, 7].
a) Vytvořte matici A1, která bude obsahovat sudé sloupce matice A.
b) Zjistěte rozměry matice A1.
c) Z matice A1 vytvořte matici A2, která bude obsahovat mı́t vyměněný druhý a
třet́ı sloupec.
d) Dvěma zp̊usoby vytvořte z matice A matici A3, která bude mı́t opačné pořad́ı
řádk̊u.
e) Spoč́ıtejte součet řádkových maxim matice A.
f) Vytvořte matici A4, která bude obsahovat pouze diagonálńı prvky matice A.
g) Vytvořte matici A5, která bude obsahovat stejné prvky jako matice A a pod
diagonálou hodnoty 3.
h) Vytvořte čtvercovou matici A6, která bude obsahovat matici A a na posledńım
řádku jej́ı sloupcové součiny.

2. Vytvořte matici B rozměr̊u 10x10, která bude po řádćıch obsahovat posloupnost
č́ısel 0, 1, 2, atd.

3. Vygenerujte náhodné celé č́ıslo a z intervalu [−3, 3] a náhodné přirozené č́ıslo n

z intervalu [1, 10]. Pak spoč́ıtejte
∑n

i=0 a
n.

Řešeńı.

1. A = round(14 * rand(5, 6) - 7)

a) A1 = A(:, 2:2:6) nebo A1 = A(:, 2:2:size(A,2))

b) [r, sl] = size(A1)

c) A2 = A1(:, [1 3 2])

nebo pomoćı permutačńı matice A2 = A1 * [1 0 0; 0 0 1; 0 1 0]

d) 1. zp̊usob: A3 = A(size(A,1):-1:1, :),
2. zp̊usob: A3 = flipud(A)

e) sum(max(A’))
f) A4 = diag(diag(A))

g) A5 = A - tril(A, -1) + 3*ones(size(A)) - triu(3*ones(size(A)))

h) A6 = [A; prod(A)]

2. B = (reshape(0:99, 10, 10))’

3. a = round(6 * rand(1)-3), n = round(9 * rand(1)+1)

sum(a.^(0:n))
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Kapitola 5

Logické operace

Základńı informace

Kapitola je zaměřena na relačńı a logické operátory a funkce, jejichž správné po-
chopeńı je d̊uležité nejen pro samotnou práci v MATLABu, ale je rovněž d̊uležitým
předpokladem při programováńı.

Výstupy z výuky

Studenti

• dokáž́ı vyjmenovat a použ́ıt relačńı operátory

• dokáž́ı uvést př́ıklady logických operátor̊u a použ́ıt je na př́ıkladech

• znaj́ı logické funkce pro testováńı nulových a nenulových, prázdných a reálných
matic

• umı́ použ́ıt funkci find()

5.1 Relačńı operátory

Relačńı operátory slouž́ı k porovnáváńı proměnných. Jedná se o následuj́ıćı operátory:

== test rovnosti
~= test nerovnosti
< menš́ı
<= menš́ı nebo rovno
>= větš́ı nebo rovno
> větš́ı
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Porovnávat je možné jen matice stejných rozměr̊u nebo matici se skalárem. Při po-
rovnáváńı se vytvoř́ı matice př́ıslušných rozměr̊u obsahuj́ıćı jedničky a nuly podle toho,
zda je př́ıslušná relace splněna nebo neńı.

>> A = [1 2 3; 4 5 6];

>> B = [1 1 1; 8 7 6];

>> c = 5;

>> X = (A == B)

X =
1 0 0

0 0 1
>> Y = (A >= B)

Y =
1 1 1

0 0 1
>> Z = (A < c)

Z =
1 1 1

1 0 0

Při porovnáváńı komplexńıch proměnných se kromě testu na rovnost nebo nerovnost
porovnává pouze reálná část.

>> u = [1+1i, -3i, 5];

>> d = 1+1i;

>> x = (u == d)

x =

1 0 0

>> y = (u >= d)

y =

1 0 1

5.2 Logické operátory

Mezi logické operátory patř́ı:

& logické ’a současně’
| logické ’nebo’
~ logicky zápor
xor vylučovaćı ’nebo’ (bud’ a nebo)

Jednotlivé operátory se aplikuj́ı na matice, př́ıpadně na matici a skalár, podobně jako
relačńı operátory. Výstupem logických operátor̊u je, stejně jako u relačńıch operátor̊u,
matice obsahuj́ıćı nuly a jedničky podle toho, zda bylo porovnáńı nepravdivé či prav-
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divé. Jednotlivé operace jsou prováděny po složkách. Nula je brána jako nepravdivá
hodnota a nenulové hodnoty (včetně Inf a NaN) jsou brány jako pravdivé hodnoty.

>> A = -2:2;

>> B = zeros(1,5);

>> C = ones(1,5);

>> X1 = A|B

X1 =

1 1 0 1 1

>> X2 = A|C

X2 =

1 1 1 1 1

>> X3 = ~A

X3 =

0 0 1 0 0

>> X4 = xor(A,pi)

X4 =

0 0 1 0 0

Pro logické operátory rovněž existuj́ı ekvivalentńı funkce:

logický operátor ekvivalentńı funkce
A & B and(A,B)

A|B or(A,B)

~A not(A)

5.3 Logické funkce

Logické funkce jsou takové funkce, které na svém výstupu vraćı matice či skaláry
obsahuj́ıćı nuly a jedničky podle typu dané funkce:

isinf(A)

vraćı matici stejného typu jako A s jedničkami na mı́stech, kde je hodnota Inf

nebo -Inf, na zbylých mı́stech jsou nuly

isnan(A)

vraćı matici stejného typu jako A s jedničkami na mı́stech, kde je hodnota NaN,
na zbylých mı́stech jsou nuly

isfinite(A)

vraćı matici stejného typu jako A s jedničkami na mı́stech, kde nejsou hodnoty
Inf, -Inf nebo NaN, na zbylých mı́stech jsou nuly
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all(A)

je-li A vektor, funkce vraćı jedničku, pokud jsou všechny hodnoty nenulové, jinak
vraćı nulu. Je-li A matice, funkce all() je aplikována na jednotlivé sloupce matice
A a výstupem je řádkový vektor obsahuj́ıćı nuly nebo jedničky pro jednotlivé
sloupce.

any(A)

funguje podobně jako all(), vraćı jedničku pokud je alespoň jeden prvek nenu-
lový.

isempty(A)

vraćı 1, pokud A je prázdná matice

isreal(A)

vraćı 1, pokud A je reálná matice (ne komplexńı)

islogical(A)

vraćı 1, pokud A je logická matice. Charakter logické matice maj́ı všechny výsledky
relačńıch a logických operátor̊u a logických funkćı.

isstr(A)

vraćı 1, pokud je A textová matice

isnumeric(A)

vraćı 1, pokud je A č́ıselná matice (ne textová)

>> A = [1, 0, Inf; NaN, -3, 2.5];

>> isfinite(A)

ans =
1 1 0

0 1 1
>> isempty(A)

ans =

0

>> isstr(A)

ans =

0

>> all(A)

ans =

1 0 1

>> any(A)

ans =

1 1 1
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5.4 Funkce find() a exist()

Daľśı užitečnou funkćı je funkce find(), která vraćı indexy nenulových prvk̊u vstupńıho
vektoru nebo matice.
Možnosti použit́ı funkce find():
I = find(x) do proměnné I umı́st́ı indexy nenulových prvk̊u vektoru x

I = find(A) do proměnné I umı́st́ı indexy nenulových prvk̊u matice A, ty
jsou brány po sloupćıch

[I,J] = find(A) umı́st́ı do I řádkové indexy a do ”J"sloupcové indexy

nenulových prvků matice "A"

[I,J,K] = find(A) do proměnné K nav́ıc umı́st́ı př́ıslušné nenulové prvky
[I,J,K] = find(x) do proměnné I umı́st́ı řádkové indexy, do proměnné J sloup-

cové indexy nenulových prvk̊u vektoru x a do proměnné K

jeho nenulové hodnoty

Častým použit́ım funkce find() jsou př́ıpady, kdy vektor x nebo matice A jsou logické
vektory/matice, tzn. jsou výstupem porovnávaćıch operaćı.

>> x = -2:2;

>> [I,J,K] = find(x)

I =

1 1 1 1

J =

1 2 4 5

K =

-2 -1 1 2

>> A = [-2 0; 1 -1];

>> [I,J] = find(A >= 0) hledá nezáporné prvky matice A a jejich indexy
I =

2

1
J =

1

2

Existenci a typy objekt̊u MATLABu lze testovat pomoćı funkce exist(). Výstupem
př́ıkazu ex = exist(’A’) jsou následuj́ıćı možnosti proměnné ex:

0 objekt s názvem A neexistuje
1 A je proměnná
2 A je m-soubor v běžném adresáři nebo v MATLABPATH
3 A je MEX-soubor v běžném adresáři nebo v MATLABPATH
4 A je kompilovaná funkce v systému SIMULINK1

1SIMULINK je nadstavba MATLABu pro simulaci a modelováńı dynamických systémů.
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5 A je interńı (předkompilovaná) funkce MATLABu
6 A je předkompilovaná m-funkce s názvem A.p. Soubor A.p lze vytvořit pomoćı

př́ıkazu pcode (v́ıce viz help pcode)
7 A je adresář

Při kolizi názv̊u (existuj́ı-li r̊uzné objekty se stejným názvem) plat́ı následuj́ıćı priorita:

1. proměnná
2. interńı funkce
3. funkce MEX (napřed pracovńı adresář, pak MATLABPATH od začátku)
4. př́ıkaz jako p-soubor (napřed pracovńı adresář, pak MATLABPATH od začátku)
5. př́ıkaz jako m-soubor (napřed pracovńı adresář, pak MATLABPATH od začátku)

Funkci exist() je možné také použ́ıt se dvěma parametry:

exist(’A’, ’var’) testuje, zda je A proměnná
exist(’A’, ’builtin’) testuje, zda je A interńı funkce
exist(’A’, ’file’) testuje, zda je A soubor
exist(’A’, ’dir’) testuje, zda je A adresář

Výstupńı hodnota je tak 1, pokud A jako daný typ existuje, v opačném př́ıpadě je
výstupńı hodnotou 0.

Př́ıklady k procvičeńı

1. Vygeneruje náhodné celoč́ıselné matice A a B s rozměry 5x5 a prvky v intervalu
[−1, 2].
a) Zjistěte počet nulových prvk̊u matice A.
b) Zjistěte počet nenulových prvk̊u matice A.
c) Zjistěte, na kolika pozićıch se shoduj́ı prvky matice A a B.
d) Zjistěte, na kolika pozićıch jsou prvky matice A větš́ı než prvky matice B.
e) Zjistěte řádkové součty záporných prvk̊u matice B.
f) Vytvořte matici C maj́ıćı hodnotu -5 na pozićıch, kde má B kladné prvky, na
ostatńıch pozićıch má matice C stejné prvky jako B.
g) Zjistěte řádkové počty kladných prvk̊u matice A.
h) Zjistěte, kolik obsahuje matice A hodnot plus/minus nekonečno.
i) Zjistěte, zda se v řádćıch matice A vyskytuj́ı nuly.
j) Vypǐste řádkové i sloupcové indexy nulových prvk̊u matice B.

Řešeńı.

1. A = round(3 * rand(5) - 1), B = round(3 * rand(5) - 1)

a) sum(sum(A == 0)) nebo
sum(sum(~A)) nebo
length(find(A == 0)) nebo
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length(find(~A))

b) sum(sum(A ~= 0)) nebo
sum(sum(~~A)) nebo
length(find(A ~= 0)) nebo
length(find(A)) nebo (méně efektivńı)
prod(size(A)) - sum(sum(~A)), apod.
c) sum(sum(A == B)) nebo
length(find(A == B))

d) sum(sum(A > B)) nebo
length(find(A > B))

e) sum((B .* (B < 0))’)

f) C = B; C(B > 0) = -5 nebo
C = -5 * (B > 0) + B .* (B <= 0)

g) sum((A > 0)’)

h) sum(sum(isinf(A)))
i) any(A’)
j) [r, sl] = find(B == 0) nebo
[r, sl] = find(~~B)
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Kapitola 6

Textové řetězce

Základńı informace

Textový řetězec je posloupnost jednotlivých znak̊u uzavřených mezi jednoduchými apo-
strofy. V této kapitole se zaměř́ıme na práci s textovými řetězci, na jejich vytvářeńı,
spojováńı, vyhledáváńı a nahrazováńı. Dále se zaměř́ıme na převod numerických hod-
not na textový řetězec a naopak a v samotném závěru kapitoly ukážeme využit́ı tex-
tových řetězc̊u při vyhodnocováńı matematických výraz̊u.

Výstupy z výuky

Studenti

• umı́ vytvářet textové řetězce a skládat je do vektor̊u i matic

• dokáž́ı převádět textový řetězec na č́ıselný vektor, i naopak

• umı́ použ́ıt funkce pro převod č́ısla na řetězec, umı́ vytvářet a odstraňovat mezery
z textových řetězc̊u

6.1 Vytvářeńı řetězc̊u

Textový řetězec je posloupnost znak̊u ohraničená apostrofy (’). Pokud má řetězec ob-
sahovat jako jeden ze znak̊u i apostrof, muśıme jej zdvojit.
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>> s1 = ’abcdef’

s1 =

abcdef

>> s2 = ’123’’45’

s2 =

123’45

Řetězce je možno skládat do matice, ovšem pouze za předpokladu, kdy jsou všechny
řádky stejné délky. V opačném př́ıpadě je nutné použ́ıt funkci char() nebo str2mat(),
které řádky kratš́ı délky doplńı mezerami. Takto vytvořené matice maj́ı př́ıznak tex-
tových poĺı, to zjist́ıme pomoćı př́ıkazu whos nebo funkce isstr().

>> S1 = [’1.radek’; ’2.radek’; ’3.radek’; ’4.radek’]

S1 =
1.radek

2.radek

3.radek

4.radek
>> S2 = char(’1.radek’, ’2.radek’, ’3.radek’, ’posledni radek’)

S2 =
1.radek

2.radek

3.radek

posledni radek
>> S3 = str2mat(’1.radek’, ’2.radek’, ’3.radek’, ’posledni radek’)

S3 =
1.radek

2.radek

3.radek

posledni radek

Pokud chceme složit v́ıce řetězc̊u do jednoho řádku, použijeme k tomu stejný zp̊usob,
jakým definujeme č́ıselné matice, tj. všechny prvky uzavřeme do hranatých závorek.
Tento zp̊usob má uplatněńı zejména v př́ıpadech, kdy některý z řetězc̊u źıskáme jako
výstup funkce.

>> s3 = [’abcdef’, ’123’, ’45’]

s3 =

abcdef12345

>> s4 = [’Čı́slo pı́ je rovno přibližně ’, num2str(pi), ’.’] funkce
num2str() slouž́ı k převodu č́ısla na textový řetězec
s4 =

Čı́slo pı́ je rovno přibližně 3.1416.

50



KAPITOLA 6. TEXTOVÉ ŘETĚZCE

6.2 Základńı manipulace s řetězci

Převod textového řetězce na č́ıselný vektor můžeme provést pomoćı funkce double(),
přičemž jednotlivým znak̊um se přǐrad́ı jejich kód (0 - 255) podle ASCII tabulky. Zpětný
převod č́ıselného vektoru na znakový řetězec lze provést použit́ım funkce char().

>> x = double(’ABCDabcd’)

x =

65 66 67 68 97 98 99 100

>> s = char(32:64)

s =

!"#$%&’()*+,-./0123456789:;<=>?@

Znaky se děĺı do několika skupin. Znaky s kódem menš́ım než 32 maj́ı speciálńı význam:
konec řádku (kódy 10 a 13), konec stránky (kód 12), tabulátor (kód 8) apod. Znaky
s kódy vyšš́ımi se běžně zobrazuj́ı na obrazovce, přičemž znaky s kódy větš́ımi než 127
se mohou lǐsit podle operačńıho systému nebo nastaveného jazyka.
V MATLABu existuje několik funkćı k testováńı typ̊u objekt̊u, jejich název zpravi-
dla zač́ıná slabikou is* a výstupem je hodnota 1, pokud objekt daného typu nabývá,
v opačném př́ıpadě je výstupem 0. Celý seznam těchto funkćı lze zobrazit př́ıkazem
doc is*, ńıže je uveden seznam nejpouž́ıvaněǰśıch z nich.

isletter(a) testuje, zda jsou jednotlivé složky proměnné a ṕısmena
(’A’ - ’Z’, ’a’ - ’z’)

isspace(a) testuje, zda je proměnná a mezerového typu (mezera - kód
32, tabulátor apod.)

isnumeric(a) testuje, zda je a č́ıselná proměnná
isstrprop(a, ’type’) testuje, zda je proměnná a daného typu, argument

’type’ je textový řetězec specifikuj́ıćı daný typ: ’alpha’
(ṕısmena), ’alphanum’ (č́ıslice a ṕısmena), ’digit’

(č́ıslice), ’wspace’ (mezera), ’lower’ (malá ṕısmena),
’upper’ (velká ṕısmena), daľśı viz doc isstrprop

Převod č́ısla na řetězec je možné pomoćı funkce num2str() nebo int2str(), která
č́ıslo zaokrouhĺı. Opačný převod provád́ı funkce str2num(), je možno použ́ıt i funkci
eval().

Řetězec dané délky obsahuj́ıćı pouze mezery lze vytvořit pomoćı funkce blanks(n),
kde argument n označuje počet mezer. Funkce deblank(a) naopak odstrańı mezery
z konce textového řetězce a.

51



KAPITOLA 6. TEXTOVÉ ŘETĚZCE

>> s1 = [’123’, blanks(3), ’abc’, blanks(2)]

s1 =

123 abc

>> d1 = double(s1) převod na č́ıselný vektor odpov́ıdaj́ıćı kód̊um ASCII tabulky
d1 =

49 50 51 32 32 32 97 98 99 32 32

>> s2 = deblank(s1) odstraněńı mezer
s2 =

123 abc

>> d2 = double(s2)

d1 =

49 50 51 32 32 32 97 98 99

6.3 Funkce pro manipulaci s řetězci

S řetězci je možné provádět řadu operaćı pomoćı funkćı k tomu určených. Nejd̊uležitěǰśı
z nich jsou:

strcat(s1, s2, ..., sN) – spojuje řetězce, které jsou na vstupu, do jednoho.

strvcat(s1, s2, ..., sN) – umı́st’uje řetězce do matice jako řádky, přitom je do-
plňuje mezerami na stejnou délku.

strcmp(s1, s2) – porovnává vstupńı řetězce s1 a s2. Vraćı hodnotu 1, pokud jsou
řetězce stejné, v opačném př́ıpadě vraćı 0.

strncmp(s1, s2, n) – funguje podobně jako funkce strcmp() s t́ım rozd́ılem, že
porovnává pouze prvńıch n prvk̊u vstupńıch řetězc̊u.

strcmpi(s1, s2) – funguje podobně jako funkce strcmp(), ale nerozlǐsuje malá a
velká ṕısmena.

strncmpi(s1, s2, n) – funguje podobně jako funkce strcmpi(), porovnává pouze
prvńıch n prvk̊u vstupńıch řetězc̊u.

findstr(s1, s2) – vyhledává v deľśım řetězci kratš́ı z nich. Jako výstup vraćı inde-
xové pozice, na kterých zač́ıná kratš́ı řetězec v deľśım. Pokud se v něm nevysky-
tuje, výstupem je prázdná matice.

strfind(s1, s2) – funguje podobně jako funkce findstr(), vyhledává řetězec s2

v řetězci s1.
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strrep(s1, s2, s3) – funkce prohledává řetězec s1, pokud v něm najde řetězec s2,
nahrad́ı jej řetězcem s3.

[s1, s2] = strtok(s) – najde úvodńı část vstupńıho řetězce ukončenou mezerou a
vrát́ı ji na výstup do proměnné s1. Př́ıpadné počátečńı mezery jsou vypuštěny.
Ve druhé výstupńı proměnné s2 je obsažen zbytek vstupńıho řetězce.

upper(s) – převede malá ṕısmena ve vstupńım řetězci s na velká.

lower(s) – převede velká ṕısmena ve vstupńım řetězci s na malá.

6.4 Funkce eval a feval

Funkce eval() slouž́ı k vyhodnoceńı vstupńıho řetězce. Funkce je užitečná zejména
v př́ıpadě, kdy potřebujeme spoč́ıtat hodnotu nějakého výrazu pro r̊uzné hodnoty pa-
rametr̊u v něm obsažené.

>> s = ’sin(2*pi*a*x)’;

>> x = 0:0.1:1;

>> a = 1;

>> y = eval(s);

y =

0 0.5878 0.9511 0.9511 0.5878 0.0000 -0.5878 -0.9511

-0.9511 -0.5878 -0.0000

Funkce feval(funkce, hodnota) slouž́ı k vyhodnoceńı funkce. Jej́ım prvńım vstupńım
argumentem je textový řetězec obsahuj́ıćı název funkce, která má být vyhodnocena
(funkce), druhý parametr obsahuje hodnotu (hodnota), která se předá volané funkci
jako vstupńı parametr.
Následuj́ıćı tři př́ıkazy dávaj́ı stejný výstup:

>> x = 0:0.01:1;

>> y = sin(x);

>> y = feval(’sin’, x);

>> y = eval(’sin(x)’);

Pokud má volaná funkce v́ıce parametr̊u, jsou uvedeny jako daľśı parametry funkce
feval().
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>> x = -1:2;

>> y = feval(’diag’, x, 1);

y =
0 -1 0 0 0

0 0 0 0 0

0 0 0 1 0

0 0 0 0 2

0 0 0 0 0

Funkce feval() se využ́ıvá zejména v př́ıpadě, kdy voláme r̊uzné funkce, jejichž názvy
jsou obsaženy v textovém řetězci.

Př́ıklady k procvičeńı

1. Definujte následuj́ıćı tři textové řetězce: t1 = ’Textovy retezec’, t2 = ’je

posloupnost znaku’ a t3 = ’uzavrena v apostrofech.’.
a) Vytvořte řádkový vektor t poskládaný z řetězc̊u t1, t2 a t3.
b) Vytvořte matici T obsahuj́ıćı řetězce t1, t2 a t3 v řádćıch.
c) Zjistěte rozměry matice T.
d) Zjistěte počet mezer ve druhém řádku matice T s koncovými mezerami i bez
nich a porovnejte s počtem mezer v řetězci t2.
e) Vypǐste pozice, na kterých se v textovém řetězci t1 nacháźı řetězec ’e’.
f) Zjistěte, na kolika pozićıch vektoru t se nacháźı řetězec ’o’.
g) Zjistěte, v kolika sloupćıch matice T se nacháźı mezera.
h) Každý výskyt řetězce ’z’ ve vektoru t nahrad’te otazńıkem.

2. Definujte funkci ea·x a pro a=0.5 a ekvidistantńı vektor x délky 5 s počátečńım
bodem 0 a koncovým bodem 3 vyč́ıslete.

Řešeńı.

1. t1 = ’Textovy retezec’, t2 = ’je posloupnost znaku’, t3 = ’uzavrena v

apostrofech.’

a) t = [t1, ’ ’, t2, ’ ’, t3] nebo
t = [t1, blanks(1), t2, blanks(1), t3] nebo

b) T = char(t1, t2, t3) nebo
T = strvcat(t1, t2, t3)

c) size(T)

54



KAPITOLA 6. TEXTOVÉ ŘETĚZCE

d) s koncovými mezerami: sum(isspace(T(2,:))) nebo
sum(isstrprop(T(2,:), ’wspace’))

bez koncových mezer: sum(isspace(deblank(T(2,:)))) nebo
sum(isstrprop(deblank(T(2,:)), ’wspace’))

v řetězci t2: sum(isspace(t2)) nebo
sum(isstrprop(t2, ’wspace’))

e) findstr(’e’, t1) nebo
findstr(t1, ’e’) nebo
strfind(t1, ’e’)

f) length(findstr(’o’, t)) nebo
length(findstr(t, ’o’)) nebo
length(strfind(t, ’o’))

g) sum(sum(isspace(T)) >= 1) nebo
sum(any(isspace(T))) nebo
sum(sum(isstrprop(T, ’wspace’)) >= 1) nebo
sum(sum(double(T) == 32) >= 1)

h) strrep(t, ’z’, ’?’)

2. f = ’exp(a*x)’

a = 0.5, x = linspace(0, 3, 5)

y = eval(f)
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Kapitola 7

Vyhodnocováńı výraz̊u

Základńı informace

Matematické výrazy a funkce mohou být v MATLABu zadány několika zp̊usoby. V této
kapitole si ukážeme možnosti zadáńı těchto funkćı, zp̊usoby výpočtu funkčńıch hodnot
či hledáńı jejich kořen̊u. Posledńı část kapitoly je věnována polynomům, pro jejichž
manipulaci byly v MATLABu vyvinuty speciálńı funkce.

Výstupy z výuky

Studenti

• umı́ vyhodnotit výraz jako textový řetězec, znaj́ı rozd́ıl mezi vyhodnocováńım
proměnných jako skalár̊u, vektor̊u a matic

• umı́ pracovat se symbolickými výrazy, umı́ převádět textový řetězec na symbo-
lický výraz a vyhodnocovat jej

• znaj́ı funkce pro derivováńı, integrováńı a zjednodušeńı symbolického výrazu

• definuj́ı výraz jako INLINE funkci, dokáž́ı takto definované výrazy vyhodnocovat

• umı́ konstruovat polynomy, dokáž́ı použ́ıt funkce pro určeńı kořen̊u a vyhodnoceńı
polynomu v bodě i matici bod̊u

7.1 Výraz jako textový řetězec

Chceme-li vyhodnotit výraz zadaný jako textový řetězec, použijeme funkci eval() bĺıže
popsanou v minulé kapitole.
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Vyhodnoceńı výrazu x2 + xy + 1 v bodech x = 2, y = 3 pomoćı textového řetězce:

>> f = ’x^2+x*y+1’;

>> x = 2;

>> y = 3;

>> z = eval(f)

z =

11

Trochu jiná situace však nastane, pokud proměnné x a y budou vektory, např. x =
[0, 1], y = [1, 2], a tedy z = [1, 4]. Je třeba si totiž uvědomit, že MATLAB bude
výše definovaný výraz f vyhodnocovat maticově, tj. operace umocňováńı a násobeńı
bude provádět maticově. Vyhodnoceńı v tomto př́ıpadě selže, protože vektory x a y
nemaj́ı př́ıslušné rozměry pro tyto operace. Nav́ıc nás ani maticové vyhodnoceńı ne-
zaj́ımá, nebot’ chceme, aby se jednotlivé operace provedly po složkách. Muśıme tedy
”dodat”tečky před operace násobeńı a umocňováńı (př́ıpadně ještě děleńı). To se dá
provést bud’ ručně nebo pomoćı funkce vectorize().

>> f = vectorize(’x^2+x*y+1’)

f =

x.^2+x.*y+1

>> x = [0 1];

>> y = [1 2];

>> z = eval(f)

z =

1 4

Takový postup plat́ı samozřejmě i v př́ıpadě, že by x a y nebyly vektory, ale matice
(samozřejmě stejných rozměr̊u).

>> x = [0 1 2; -1 2 3];

>> y = [1 2 -1; 0 3 1];

>> z = eval(f)

z =
1 4 3

2 11 13

Pro řešeńı rovnic slouž́ı funkce solve().

>> g = ’x^2 - 2*x - 3’;

>> solve(g)

ans =
3

-1
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7.2 Symbolický výraz

MATLAB umı́ pracovat i se symbolickými výrazy (podobně jako např. MAPLE). Je
však nutné, aby př́ıslušná verze MATLABu obsahovala knihovnu pro práci se symbo-
lickými výrazy (Symbolic Toolbox). To lze zjistit např. př́ıkazem ver, který vyṕı̌se
verzi MATLABu a všechny nainstalované knihovny. Pomoćı funkce sym() můžeme li-
bovolný textový řetězec převést na symbolický výraz. Vyhodnoceńı takto definovaného
výrazu se provede pomoćı funkce subs(f, old, new), kde f je symbolický výraz nebo
textový řetězec, old udává proměnné jako textové řetězce. Pokud je proměnných v́ıce,
muśı být odděleny čárkou, uzavřeny ve složených závorkách a zálež́ı na jejich pořad́ı.
Argument new udává hodnoty proměnných, ve kterých má být funkce vyč́ıslena. Jejich
pořad́ı se ř́ıd́ı pořad́ım proměnných uvedeným v argumentu old.

Vyhodnoceńı výrazu x2 + xy + 1 v bodech x = 2, y = 3 pomoćı symbolického výrazu:

>> f = sym(’x^2+x*y+1’);

>> z = subs(f, {’x’, ’y’}, {2, 3})
z =

11

>> z1 = subs(’sin(x)’, ’x’, pi/2) vyhodnoceńı funkce sin(x) v bodě x = π
2

z1 =

1

V př́ıpadě, že proměnné x a y jsou vektory, resp. matice, syntaxe je podobná. POZOR!
Symbolické výrazy nevektorizujeme!
>> f = sym(’x^2 + x*y + 1’);

>> z = subs(f, {’x’, ’y’}, {[0 1], [1 2]})
z =

[1, 4]

Pro řešeńı rovnic slouž́ı funkce solve().

>> g = sym(’x^2 - 2*x - 3’);

>> solve(g)

ans =
3

-1

Práce se symbolickými výrazy má mnoho výhod. K dispozici jsou funkce pro derivováńı
(diff()), integrováńı (int()), zjednodušeńı výraz̊u (simplify()), převod výrazu do
do jeho LATEXovské reprezentace (latex()) a mnoho daľśıch.
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7.3 Výraz jako INLINE funkce

Posledńı možnost́ı, jak vyhodnotit daný výraz, je definovat ho jako tzv. INLINE funkci
př́ıkazem inline(). Samotné vyhodnoceńı je prováděno pouhým zapsáńım dané hod-
noty do kulatých závorek za funkci.

>> f = inline(’x^2 + 1’)

>> z = f(2)

z =

5

V př́ıpadě, že funkce obsahuje v́ıce proměnných, je jejich pořad́ı dáno abecedně. Vlastńı
pořad́ı proměnných lze definovat pomoćı daľśıch argument̊u – čárkami oddělené tex-
tový řetězce názv̊u proměnných v požadovaném pořad́ı.

>> f1 = inline(’x^2 + x*y + 1’, ’x’, ’y’); př́ıkaz ekvivalentńı př́ıkazu s im-
plicitńım nastaveńı pořad́ı proměnných f = inline(’x^2 + x*y + 1’);

>> z1 = f1(2, 3)

z1 =

11

>> f2 = inline(’x^2 + x*y + 1’, ’y’, ’x’); výměna pořad́ı proměnných pro
vyhodnocováńı funkce
>> z2 = f2(2, 3)

z2 =

16

V př́ıpadě, že proměnné x a y jsou vektory, resp. matice, syntaxe je podobná – aby
byly operace prováděny po složkách, je potřeba dodat tečky před př́ıslušné operace
nebo funkci vektorizovat pomoćı funkce vectorize().

>> f = inline(’x^2 + x*y + 1’, ’x’, ’y’);

>> f = vectorize(f);

>> z = f([0 1], [1 2])

z =

1 4

7.4 Polynomy

V MATLABu existuje několik funkćı usnadňuj́ıćıch práci s polynomy. Jsou to předevš́ım
funkce pro tvorbu polynomů, jejich vyhodnocováńı, výpočet kořen̊u, apod. S polynomy
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lze samozřejmě zacházet stejně jako s výrazy popsanými výše, tento př́ıstup ovšem neńı
tak efektivńı.
Polynom je v MATLABu definován jako posloupnost koeficient̊u seřazených od členu
s nejvyšš́ı mocninou po absolutńı člen. Nulové hodnoty v této posloupnosti odpov́ıdaj́ı
chyběj́ıćım člen̊um polynomu.

>> p = [2 -3 0 5 -4]; zápis polynomu p(x) = 2x4 − 3x3 + 5x− 4

Základńı funkce pro práci s polynomy:
y = polyval(p, x) vyhodnoceńı polynomu p v daném

bodě/vektoru x

y = polyvalm(p, A) vyhodnoceńı polynomu p v matici bod̊u A

k = roots(p) kořeny k polynomu p

p = poly(k) sestrojeńı polynomu p, jehož kořeny jsou k

pd = polyder(p) derivace pd polynomu p

pint = polyint(p, k) integrál pint polynomu p. k označuje inte-
gračńı konstantu, neńı-li uvedena, je volena
nulová integračńı konstanta

p = conv(p1, p2) součin p polynomů p1 a p2

[podil, zbytek] = deconv(p1, p2) děleńı polynomů p1 a p2 se zbytkem, podil
obsahuje pod́ıl polynomů, zbytek obsahuje
jejich zbytek

>> y1 = polyval(p, 1) vyhodnoceńı polynomu p v bodě 1
y1 =

0

>> y2 = polyval(p, -1:1) vyhodnoceńı polynomu p v bodech -1, 0, 1
y2 =

-4 -4 0

>> A = [-1 0; 1 2];

>> Y1 = polyval(p, A) vyhodnoceńı polynomu p po složkách v matici A
Y1 =

-4 -4

0 14

>> Y1 = polyvalm(p, A) vyhodnoceńı polynomu p (maticově) v matici A, ekviva-
lentńı př́ıkaz: 2*A^4 - 3*A^3 + 5*A - 4*eye(2)

Y1 =
-4 0

6 14

>> k = roots([1 0 -1]) kořeny polynomu x2 − 1
k =

-1

1
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>> p1 = poly([-1 1]) polynom p s kořeny -1, 1
p1 =

1 0 -1

>> pd = polyder(p) derivace polynomu p

pd =

8 -9 0 5

>> p = conv([1 -1], [2 0]) součin p(x) = 2x2 − 2x polynomů p1(x) = x − 1 a
p2(x) = 2x
p =

2 -2 0

>> [podil, zbytek] = deconv(p, p1) pod́ıl a zbytek při děleńı polynomu p po-
lynomem p1

podil =

2

zbytek =

0 0 0 2 -2

Př́ıklady k procvičeńı

1. Definujte funkci f(x) = x4 + 4x3 + 3x2 − 4x− 4 jako:
a) textový řetězec f1,
b) symbolický výraz f2,
c) inline funkci f3,
d) polynom f4.

2. Spoč́ıtejte funkčńı hodnoty funkćı f1, f2, f3 a f4 v bodech x = [0 1 2 3].

3. Pro f1, f2 a f4 řešte rovnici f(x) = 0.

4. Vyč́ıslete prvńı derivaci funkce f(x) v bodech x pomoćı symbolického výrazu a
polynomu.

5. Vyč́ıslete integrál z funkce f(x) v bodech x pomoćı symbolického výrazu a poly-
nomu.

Řešeńı.

1. a) f1 = ’x^4 + 4*x^3 + 3*x^2 - 4*x - 4’

b) f2 = sym(’x^4 + 4*x^3 + 3*x^2 - 4*x - 4’)

c) f3 = inline(’x^4 + 4*x^3 + 3*x^2 - 4*x - 4’)

d) f4 = [1 4 3 -4 -4]
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2. x = 0:3

a) y1 = eval(vectorize(f1))

b) y2 = subs(f2, ’x’, x)

c) f3 = vectorize(f3), y3 = f3(x)

d) y4 = polyval(f4, x)

3. a) res1 = solve(f1)

b) res2 = solve(f2)

c) res4 = roots(f4)

4. a) yd2 = eval(vectorize(diff(f2)))

b) yd4 = polyval(polyder(f4), x)

5. a) yint2 = eval(vectorize(int(f2)))

b) yint4 = polyval(polyint(f4), x)
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Kapitola 8

Práce se soubory

V praktických situaćıch často pracujeme s daty, která jsou uložena v exterńıch soubo-
rech, v pr̊uběhu práce potřebujeme ukládat záznam práce, některé proměnné obsahuj́ıćı
d̊uležité výstupy či celý workspace. V této kapitole se seznámı́me s př́ıkazy pro mani-
pulaci se soubory a adresáři a nastaveńı cesty k nim.

Základńı informace

Výstupy z výuky

Studenti

• umı́ prováděné př́ıkazy i s výsledky ukládat do souboru

• znaj́ı funkce pro ukládáńı a nač́ıtáńı proměnných

• dokáž́ı zjistit název pracovńıho adresáře a vypsat jeho obsah, dokáž́ı se pohybovat
mezi adresáři

8.1 Záznam práce

Prováděné př́ıkazy i s výstupy je možné zaznamenávat do tzv. žurnálu, ukládat lze
pomoćı př́ıkazu diary. Př́ıkaz diary on zapne ukládáńı a všechny daľśı př́ıkazy i s je-
jich výstupy budou ukládány v pracovńım adresáři do souboru s názvem diary. Př́ıkaz
diary off toto ukládáńı přeruš́ı a uzavře soubor, přičemž nové použit́ı př́ıkazu ne-
smaže p̊uvodńı obsah souboru a nově provedené př́ıkazy i s výstupy do souboru přidá.
Použit́ı samotného př́ıkazu diary bez parametr̊u přepne režim ukládáńı, tj. pokud bylo
ukládáńı zapnuto, pak ho vypne a naopak.
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Ukládáńı do souboru s jiným názvem dosáhneme pomoćı př́ıkazu diary jmeno souboru

nebo ekvivalentńım př́ıkazem diary(’nazev souboru’), kde nazev souboru je libo-
volný název souboru. Daľśı použit́ı př́ıkazu diary bez parametr̊u se pak bude vztahovat
ke zvolenému souboru.

8.2 Ukládáńı a nač́ıtáńı proměnných

Pro uložeńı proměnných do souboru slouž́ı př́ıkaz save. Jeho použit́ı bez parametr̊u
ulož́ı všechny definované proměnné do souboru s názvem matlab.mat.
Pro uložeńı pouze vybraných proměnných do námi zvoleného souboru zadáme jako
prvńı parametr název souboru a jako daľśı parametry (odděleny čárkami nebo me-
zerami) názvy proměnných, které chceme uložit. Uložené soubory maj́ı automaticky
př́ıponu .mat. Je možné zadat i př́ıponu jinou.

>> who seznam definovaných proměnných
Your variables are:

a A b c u v x

>> save data ulož́ı všechny definované proměnné do souboru data.dat

>> save data1 a b c proměnné a, b a c ulož́ı do souboru data1.mat

>> save(’data1’, ’a’, ’b’, ’c’) ekvivalentńı př́ıkaz k př́ıkazu save data1 a b

c

Nač́ıst data z uloženého souboru můžeme př́ıkazem load. Použijeme-li ho bez para-
metr̊u, načtou se všechny uložené proměnné ze souboru matlab.mat. Př́ıkaz load je
možné použ́ıt podobně jako př́ıkaz save.
Pokud má soubor s uloženými daty jinou př́ıponu než .mat, muśı se při nač́ıtáńı jeho
obsahu použ́ıt parametr -MAT (lze použ́ıt i malá ṕısmena: -mat).

>> load data1 načte všechny proměnné uložené v souboru data1.mat, ekvivalentńı
př́ıkaz: load(’data1’)
>> load data1.dat -MAT načte všechny proměnné uložené v souboru data1.dat

Data lze uložit do souboru i v tzv. ASCII tvaru, který je běžně čitelný v textovém edi-
toru. Dosáhneme toho užit́ım volby -ASCII:

save data2.dat X -ASCII

V tomto souboru ovšem neńı uložen název proměnné X, pouze jej́ı obsah. Při nač́ıtáńı
souboru, který má jinou koncovku než .mat, se automaticky předpokládá, že jsou v AS-
CII tvaru. Z takového souboru je možné ovšem nač́ıst pouze jednu proměnnou, která
má nav́ıc stejný název jako je název p̊uvodńıho souboru (bez př́ıpony). Takové sou-
bory je možné vytvářet i ručně, př́ıpadně jako výstup práce jiných programů. Je ovšem
nutno mı́t na paměti, že data v nich obsažená muśı mı́t tvar matice, tj. každý řádek
muśı mı́t stejný počet sloupc̊u.
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8.3 Soubory v systému MATLAB

MATLAB většinu př́ıkaz̊u, které provád́ı, hledá v souborech, které tyto př́ıkazy obsahuj́ı
jako funkce. Př́ıpona těchto soubor̊u je .m, proto se taky nazývaj́ı m-soubory (m-file).
Tyto soubory obsahuj́ı jednak zápis algoritmu, pomoćı něhož se provád́ı daný výpočet
či dané operace, a nápovědu, která se vypisuje př́ıkazem help.

Některé funkce jsou tzv. vnitřńı, ty jsou uloženy v předkompilované podobě v kni-
hovně funkćı a př́ıslušný m-soubor obsahuje jen nápovědu. Pomoćı př́ıkazu which

zjist́ıme, kde se soubor s daným programem či funkćı nacháźı, nebo zda se jedná
o vnitřńı funkci MATLABu.

>> which poly

C:\Program Files\MATLAB\R2014a\toolbox\matlab\polyfun \poly.m
>> which eig

built-in (C:\Program Files\MATLAB\R2014a\toolbox\matlab\matfun\@single\
\eig) % single method

Daľśı funkce mohou být uloženy v tzv. mex-souborech (s př́ıponou .mex). Ty jsou vy-
tvořeny v některém jiném programovaćım jazyce (C, FORTRAN) a jsou speciálně
zpracovány tak, aby je bylo možné použ́ıvat v MATLABu.
Datové soubory, jak už bylo řečeno, maj́ı standardně př́ıponu .mat.

8.4 Cesta k soubor̊um

Programy a funkce spouštěné při práci v MATLABu jsou vyhledávány v adresář́ıch,
k nimž je nastavená cesta – tzv. matlabpath. Jej́ı obsah zjist́ıme př́ıkazem path nebo
matlabpath. Pokud chceme do této cesty přidat nějaký daľśı adresář, jednoduše to
můžeme provést pomoćı funkce path(path,’dalsi adresar’) nebo př́ıkazem addpath

dalsi adresar. Proměnná dalsi adresar muśı obsahovat textový řetězec s cestou
k danému adresáři. Konkrétńı tvar cesty záviśı na použitém operačńım systému.

>> path(path, ’d:\user\matlab’) přidáńı nové cesty v MS Windows
>> addpath d:\user\matlab ekvivalentńı zp̊usob pro přidáńı nové cesty v MS Win-
dows
>> addpath /home/user/matlab přidáńı nové cesty v UNIXu

Pokud na konci př́ıkazu addpath přidáme přeṕınač -BEGIN, nový adresář se ulož́ı na
začátek seznamu a bude pak prohledáván jako prvńı. Uložeńı na konec seznamu je
možné zadat přeṕınačem -END. Ke smazáńı adresáře ze seznamu slouž́ı př́ıkaz rmpath.
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8.5 Daľśı př́ıkazy pro práci se soubory

Výpis obsahu pracovńıho adresáře zjist́ıme př́ıkazem dir nebo ls. Můžeme také použ́ıt
hvězdičkovou konvenci – př́ıkazem dir *.mat vyṕı̌seme všechny datové soubory s př́ı-
ponou .mat v daném adresáři.

Chceme-li zjistit, ve kterém adresáři se právě nacháźıme, použijeme př́ıkaz pwd, který
zobraźı textový řetězec kompletńı cesty do aktuálńı složky. Pro změnu pracovńıho ad-
resáře slouž́ı př́ıkaz cd jiny adresar, kde jiny adresar je cesta k novému adresáři.

>> addpath(pwd) aktuálńı adresář je možné přidat do cesty pro prohledáváńı
>> cd matlab/data změna pracovńıho adresáře

Pro výpis obsahu zvoleného souboru můžeme použ́ıt funkci type(filename), kde
filename je název zvoleného souboru. Pokud předem zadáme př́ıkaz more on, výpis
dlouhého souboru bude zobrazován po stránkách. Vypnut́ı stránkováńı provedeme
př́ıkazem more off (implicitńı nastaveńı).

Daľśı užitečné funkce:
copyfile(’source’, ’destination’) funkce pro koṕırováńı soubor̊u z p̊uvodńıho

umı́stěńı ’source’ na nové mı́sto ’destination’

delete(’fileName’) funkce pro mazáńı soubor̊u
rmdir(’folderName’) funkce pro mazáńı adresář̊u
lookfor topic pro zadaný výraz topic prohledává nápovědu
edit př́ıkaz pro vyvoláńı editoru pro psańı kódu, jeho nastaveńı záviśı na operačńım

systému. Editor lze rovněž vyvolat z menu Editor → New.

Př́ıklady k procvičeńı

1. Veškerý záznam práce uložte do souboru ZaznamPrace.

2. Načtěte soubor v.mat, ve kterém je uložen vektor v. Zjistěte jeho délku a počet
záporných prvk̊u.

3. Vektor v seskládejte po sloupćıch do čtvercové matice A a tu uložte do souboru
A.mat.

4. Ukončete ukládáńı záznamu práce do souboru.

Řešeńı.

1. diary ZaznamPrace nebo
diary(’ZaznamPrace’)
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2. load v, delka = length(v), zap = sum(v < 0)

3. A = reshape(v, sqrt(delka), sqrt(delka)), save A.mat A

4. diary off
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Kapitola 9

Práce s grafikou

Základńı informace

Ned́ılnou součást́ı vědeckotechnických výpočt̊u, analýz, model̊u či simulaćı je prezentace
dat či grafické výstupy. Následuj́ıćı kapitola obsahuje základńı typy graf̊u, seznamuje
s potřebnými funkcemi pro potřebnou úpravu graf̊u a dává návod, jak lze požadovaného
vzhledu grafu dosáhnout interaktivně.

Výstupy z výuky

Studenti

• ovládaj́ı základńı př́ıkazy pro vykresleńı grafu, dokáž́ı určit definičńı obor a
spoč́ıtat funkčńı hodnoty

• dokáž́ı použ́ıt parametry ovlivňuj́ıćı barvu, styl čáry a znak pro vykresleńı jed-
notlivých bod̊u

• umı́ konstruovat v́ıce graf̊u do jednoho grafického okna, znaj́ı funkce pro zaṕınáńı
a vyṕınáńı přepisováńı v grafu

• dokáž́ı zobrazit mř́ıžku v grafu, znaj́ı př́ıkazy pro popisky os i název grafu

• umı́ vykreslit v́ıce graf̊u do jednoho grafického okna

• zobraźı funkce dvou proměnných, umı́ zvolit barevné škálováńı a měnit úhel po-
hledu na trojrozměrný obrázek

• umı́ měnit vlastnosti grafických objekt̊u
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9.1 Funkce plot() a jej́ı použit́ı

Základńım př́ıkazem pro kresleńı graf̊u funkćı jedné proměnné je funkce plot(), která
při implicitńım nastaveńı spojuje zadané body úsečkami.
plot(x) pro vstupńı vektor x vykresĺı spojnicový graf s indexy 1:length(x)

na ose x a hodnotami vektoru x na ose y. Pro vstupńı matici x vykresĺı
v jednom okně spojnicový graf pro každý sloupec matice.

plot(x, y) vykresĺı spojnicový graf hodnot y na pozićıch x.

Graf funkce sin(2x) + cos(x) na intervalu [0, π]:

>> x = linspace(0, pi); vygenerováńı (implicitně 100) hodnot na ose x, pro které
má být funkce zobrazena
>> y = sin(2*x) + cos(x); výpočet funkčńıch hodnot
>> plot(x, y) vykresleńı grafu (Obr. 9.1)

Obr. 9.1. Výstup funkce plot(x, y).

Poznámka. Vykreslená funkce vypadá hladce, ve skutečnosti se ovšem jedná o lome-
nou čáru, jednotlivé body jsou spojovány úsečkami. Vzhled grafu tak velmi ovlivňuje
hustota bod̊u na ose x (Obr. 9.2).
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>> x = linspace(0, pi, 7); vygenerováńı menš́ıho počtu hodnot na ose x
>> y = sin(2*x) + cos(x);

>> plot(x, y) vykresleńı grafu (Obr. 9.2)

Obr. 9.2. Výstup funkce plot(x, y) pro menš́ı počet vygenerovaných bod̊u.

Funkce plot(), může obsahovat ještě daľśı volitelný parametr. Jedná se o textový
řetězec, pomoćı něhož můžeme ovlivňovat barvu a styl vykreslené čáry a symbol pro
zobrazeńı jednotlivých bod̊u, které jsou spojovány úsečkami. Každá barva, styl čáry a
symbol maj́ı sv̊uj znak, jejich kombinaćı do textového řetězce zvoĺıme vzhled grafu.
Znaky pro barvu:

y žlutá (yellow)
m fialová (magenta)
c modrozelená (cyan)
r červená red
g zelená (green)
b modrá (blue)
w b́ılá (white)
k černá (black)

Znaky pro styl čáry:

- plnou čarou
-- čárkovaně
: tečkovaně
-. čerchovaně
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Znaky pro symboly zobrazených bod̊u:

. tečka
o kroužek
+ kř́ıžek
* hvězdička
s čtvereček (square)
d kosočtverec (diamond)
v trojúhelńık (otočený dol̊u)
^ trojúhelńık (otočený nahoru)
< trojúhelńık (otočený doleva)
> trojúhelńık (otočený doprava)
p pentagram
h hexagram

>> x = [1, 2, 3];

>> y = [1, 3, 2];

>> plot(x, y, ’r--*’) vykresleńı daných bod̊u červenou čárkovanou čarou s body
vyznačenými hvězdičkami (Obr. 9.3)

Obr. 9.3. Výstup funkce plot(x, y, ’r--*’).
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>> plot(x, y, ’+r’) vykresĺı pouze zadané body bez spojováńı úsečkou. V
př́ıpadě, že explicitně nezadáme barvu, je volena automaticky.

Funkce plot() umožňuje kreslit v́ıce graf̊u najednou, stač́ı je zadat jako daľśı jej́ı pa-
rametry. Pro každý graf můžeme uvést parametry pro styl vykresleńı.

>> x = linspace(0, 2*pi);

>> y1 = sin(x);

>> y2 = cos(x);

>> y3 = sin(2*x);

>> plot(x, y1, x, y2, x, y3) vykresĺı tři grafy uložené v proměnných y1, y2 a
y3, všechny pro stejný definičńı obor daný proměnnou x (Obr. 9.4)

Obr. 9.4. Výstup funkce plot(x, y1, x, y2, x, y3).

>> x = linspace(-2, 10, 20);

>> y = exp(x);

>> plot(x, y, ’b--’, x, y, ’r*’) vykresleńı bod̊u jinou barvou než je barva
spojovaćıch čar (Obr. 9.5)
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Obr. 9.5. Výstup funkce plot(x, y, ’b--’, x, y, ’r*’).

9.2 Vzhled grafu

MATLAB obsahuje několik funkćı, d́ıky nimž si uživatel může přizp̊usobit vzhled grafu
podle vlastńıch představ, obsahuje funkce pro popisky os, název grafu, vkládáńı textu
do grafu, apod.
Nı́že jsou uvedeny nejpouž́ıvaněǰśı funkce a př́ıkazy:
• hold on přeṕınač pro zapnut́ı přikreslováńı daľśıch graf̊u do již existuj́ıćıho grafu.
Pro vypnut́ı této vlastnosti slouž́ı př́ıkaz hold off

• grid on zapne zobrazeńı mř́ıžky pro lepš́ı orientaci v grafu, vypnout lze př́ıkazem
grid off

• text(x, y, ’text’) do obrázku na mı́sto o souřadnićıch [x, y] umı́st́ı popisek
text

• gtext(’text’) do obrázku na mı́sto interaktivně zvolené myš́ı umı́st́ı popisek text

• xlabel(’popisx’) vytvoř́ı popis osy x
• ylabel(’popisy’) vytvoř́ı popis osy y
• title(’nazev’) vytvoř́ı název obrázku
• legend(pozice, ’popis’) vytvoř́ı legendu grafu tvořenou čárkami oddělenými
textovými řetězci s popisem, je zobrazena na mı́stě daném umerickou hodnotou para-
metru pozice (pozice může být dána i textovým řetězcem – v́ıce viz doc legend):
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-1 vpravo mimo osy
0 uvnitř os
1 pravý horńı roh
2 pravý levý roh
3 dolńı levý roh
4 dolńı pravý roh
• axis([xmin xmax ymin ymax]) numerické hodnoty xmin, xmax, ymin, ymax pro
úpravu rozsah̊u os
• figure() otevře nové prázdné okno

>> plot(x, y, ’b--’) výstup je zobrazen na Obr. 9.6
>> grid on zapnut́ı mř́ıžky
>> xlabel(’x’) popis osy x
>> ylabel(’y’) popis osy y
>> title(’Graf funkce y=e^x’) název grafu
>> hold on zapne funkci přikreslováńı daľśıch objekt̊u do vytvořeného grafu
>> plot(x, y, ’r*’) přidáńı bod̊u do grafu

Obr. 9.6. Demonstrace funkćı title(), xlabel(), ylabel() a př́ıkaz̊u grid on a hold

on.

Vzhled grafu lze měnit také př́ımo z menu grafu Edit → Figure properties ..., kde lze
měnit barva pozad́ı či název grafu (Obr. 9.7). Poklikáńım na vykreslenou křivku lze
zobrazit daľśı menu (Obr. 9.8), kde lze měnit typ grafu, barvu, styl a tloušt’ku čáry a
symbol̊u.
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Obr. 9.7. Menu Figure Properties .... Obr. 9.8. Menu Figure Properties ....

Poklikáńım na osy grafu nebo v menu Edit→ Axes properties ... lze v daľśım otevřeném
menu (Obr. 9.9)měnit popisky, rozsahy a barvy os, lze zapnout mř́ıžka, ohraničeńı grafu,
apod.

Obr. 9.9. Menu Axes Properties ....

Složený obrázek obsahuj́ıćı v́ıce graf̊u v jednom okně lze vytvořit funkćı subplot(m,
n, p). Parametr m udává počet obrázk̊u svisle, n počet obrázk̊u vodorovně, parametr
p pozici pro umı́stěńı grafu při aktuálńım voláńı funkce plot(). Pozice jsou č́ıslovány
po řádćıch.
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>> x = 0:0.01:1;

>> y1 = sin(pi*x); y2 = sin(2*pi*x); y3 = sin(3*pi*x); y4 =

sin(4*pi*x);

>> subplot(2, 2, 1)

>> plot(x, y1, ’r’)

>> subplot(2, 2, 2)

>> plot(x, y2, ’b’)

>> subplot(2, 2, 3)

>> plot(x, y3, ’g’)

>> subplot(2, 2, 4)

>> plot(x, y4, ’k’)

Obr. 9.10. Funkce subplot().

Vytvořený graf lze uložit v menu grafického okna File → Save as....

9.3 3D grafika

Pro kresleńı graf̊u funkćı dvou proměnných můžeme použ́ıt základńı funkce:
mesh(X, Y, Z) vytvoř́ı 3D śıt’ovaný graf
surf(X, Y, Z) vytvoř́ı 3D śıt’ovaný graf s barevně vyplněnými ploškami

Parametry X a Y jsou jsou matice nezávislých proměnných, třet́ı parametr Z obsahuje
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matici funkčńıch hodnot. V př́ıpadě vynecháńı nezávislých proměnných je graf inde-
xován rozměry matice Z.
Pro snadněǰśı vytvářeńı dvojrozměrných graf̊u slouž́ı funkce meshgrid(), která vytvoř́ı
z jednorozměrných vektor̊u nezávislých proměnných dvourozměrné śıtě vhodné pro de-
finováńı grafu dané funkce. Použit́ım [X, Y] = meshgrid(x, y) vytvoř́ıme z vektor̊u
x a y śıt’ bod̊u, jej́ıž souřadnice jsou uloženy v matićıch X a Y.

>> x = 0:0.05:1;

>> y = 0:0.05:1;

>> [X, Y] = meshgrid(x, y);

>> Z = sin(pi*(X+Y)); výpočet funkčńıch hodnot. POZOR! Je nutno poč́ıtat s ma-
ticemi X a Y, ne s vektory x a y!
>> mesh(X, Y, Z) vykresleńı śıt’ovaný graf funkce sin(π(x + y)) pro x, y ∈ [0, 1]
(Obr. 9.11)
>> surf(X, Y, Z) vykresleńı śıt’ovaný graf s vyplněnými ploškami pro funkci
sin(π(x+ y)), x, y ∈ [0, 1] (Obr. 9.12)

Obr. 9.11. Výstup funkce mesh(X, Y, Z) Obr. 9.12. Výstup funkce surf(X, Y, Z)

Vykreslené graf obsahuj́ı celou škálu barev podle funkčńıch hodnot v jednotlivých
bodech. Barevnou stupnici tohoto škálováńı lze při okraji grafu zobrazit př́ıkazem
colorbar.
Úhel pohledu na trojrozměrný obrázek lze nastavit funkćı view(az, el). Parametr az
udává azimut v rovině nezávislých proměnných, tj. otočeńı ve stupńıch kolem osy z;
kladné hodnoty udávaj́ı otočeńı proti směru hodinových ručiček. Parametr el udává
tzv. elevaci, což je úhel směru pohledu s rovinou nezávislých proměnných. Implicitně
je nastaven azimut -37.5◦ a elevace 30◦.
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V MATLABu je od verze 5.3 možné nastavovat úhel pohledu pomoćı myši př́ımo
v obrázku volbou v panelu nástroj̊u (na Obr. 9.13 vyznačeno červeně). Podobně lze
výběrem položky v menu obrázku nastavovat i vlastnosti dvojrozměrných graf̊u.

>> surf(X, Y, Z)

>> colorbar

>> view(16, 12)

Obr. 9.13. Zobrazeńı stupnice škálováńı barev a natočeńı grafu.

Pro vykreslováńı křivek v 3D prostoru se použ́ıvá funkce plot3(x, y, z), jej́ıž vstupńımi
argumenty jsou vektory x, y a z stejných rozměr̊u. Pokud by vstupńımi argumenty byly
matice, funkce by vykreslila křivky postupně pro sloupce těchto matic.

>> t = 0:pi/50:10*pi;

>> plot3(sin(t), cos(t), t) vykresĺı křivku v prostoru (Obr. 9.14)

Daľśımi užitečnými funkcemi pro tvorbu 3D grafiky mohou být např. funkce contour()
(vrstevnicový graf), meshc() (śıt’ovaný graf doplněný vrstevnicemi), waterfall() (po-
dobný śıt’ovanému grafu, dělaj́ıćı iluzi vodopádu), quiver() (vektorové pole), apod.
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Obr. 9.14. Výstup funkce plot3(sin(t), cos(t), t).

9.4 Vlastnosti grafických objekt̊u

Každý grafický objekt, jako je např́ıklad graf funkce, popis os, titulek obrázku, ale i
obrázek jako celek, má spoustu grafických vlastnost́ı. Mezi tyto vlastnosti patř́ı třeba
barva grafu, tloušt’ka čáry grafu, velikost ṕısma a použitý druh ṕısma (font) apod.
Výpis všech vlastnost́ı lze źıskat pomoćı funkce get(), nastavit vlastnosti lze pomoćı
funkce set(). Předt́ım je ale potřeba, aby byl definován ukazatel na daný grafický
objekt, tzv. handle. Ten vytvoř́ıme přǐrazeńım grafického př́ıkazu do proměnné.

>> x = linspace(0, pi);

>> y = sin(x);

>> p = plot(x, y) vykresleńı funkce sinus spolu s přǐrazeńım do proměnné p.
Protože př́ıkaz neńı ukončen středńıkem, vyṕı̌se se hodnota definované proměnné p,
ovšem vlastńı hodnota neńı d̊uležitá. Zadáńım př́ıkazu get(p) źıskáme výpis všech
vlastnost́ı vykresleného grafu.
p =

176.0278
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>> get(p) výpis vlastnost́ı grafu
DisplayName: ’’

Annotation: [1x1 hg.Annotation]

Color: [0 0 1]

LineStyle: ’-’

LineWidth: 0.5000

Marker: ’none’

MarkerSize: 6

MarkerEdgeColor: ’auto’

MarkerFaceColor: ’none’

XData: [1x100 double]

YData: [1x100 double]

ZData: [1x0 double]

BeingDeleted: ’off’

ButtonDownFcn: []

Children: [0x1 double]

Clipping: ’on’

CreateFcn: []

DeleteFcn: []

BusyAction: ’queue’

HandleVisibility: ’on’

HitTest: ’on’

Interruptible: ’on’

Selected: ’off’

SelectionHighlight: ’on’

Tag: ’’

Type: ’line’

UIContextMenu: []

UserData: []

Visible: ’on’

Parent: 175.0216

XDataMode: ’manual’

XDataSource: ’’

YDataSource: ’’

ZDataSource: ’’

Vlastnosti grafu lze měnit pomoćı funkce set(p, ’PropertyName’, PropertyValue),
kde ’PropertyName’ označuje název vlastnosti (ve výpisu text před dvojtečkou) a
PropertyValue jej́ı novou hodnotu.
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Př́ıklady k procvičeńı

1. Nakreslete graf funkce f1(x) = x2 pro x ∈ [−2, 2]. Graf řádně otitulkujte.

2. Červeně přikreslete graf funkce f2(x) = x4.

3. Do nového grafického okna nakreslete tyto grafy vedle sebe.

4. Jedńım př́ıkazem vykreslete pro x ∈ [−6, 6] graf funkce

f3(x) =

{
(x+ 3)3 + x x <= 0

(x− 2)4 + (x− 5)2 + 1 x > 0

.

5. Pro x, y ∈ [−2, 2] vykreslete graf funkce g(x) = x2 + y2.

Řešeńı.

1. x = linspace(-2, 2);

plot(x, x.^2)

title(’Graf 2. mocniny’), xlabel(’osa x’), ylabel(’osa y’)

2. hold on

plot(x, x.^4, ’r’)

3. figure

subplot(1, 2, 1)

plot(x, x.^2), title(’2. mocnina’), xlabel(’x’), ylabel(’y’)

subplot(1, 2, 2)

plot(x, x.^4), title(’4. mocnina’), xlabel(’x’), ylabel(’y’)

4. x = linspace(-6, 6); figure

y = ((x+3).^3 + x).*(x <= 0) + ((x-2).^4 + (x-5).^2 + 1).*(x > 0);

plot(x, y)

5. x = linspace(-2, 2); y = x; figure

[X, Y] = meshgrid(x, y);

surf(X, Y, X.^2 + Y.^2)
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Kapitola 10

Programováńı v MATLABu

Základńı informace

MATLAB je prostřed́ı nejen pro výpočty, modelováńı, simulace a grafické zobrazeńı
dat, ale také programovaćı prostřed́ı, které svým uživatel̊um umožňuje vytvářeńı svých
vlastńıch programů či přizp̊usobeńı již existuj́ıćıch funkćı podle vlastńıch potřeb. Pro
tvorbu těchto funkćı je nezbytně nutné, aby uživatel dobře porozuměl rozd́ılu mezi
dávkovým souborem a funkćı a daľśım základńım věcem jako lokálńı a globálńı proměnné
a základńı programové struktury.

Výstupy z výuky

Studenti

• umı́ vytvářet jednoduché vlastńı skripty a funkce, znaj́ı rozd́ıl mezi nimi

• rozlǐsuj́ı lokálńı a globálńı proměnné

• ovládaj́ı schémata větveńı programu pomoćı př́ıkaz̊u ”if”a ”switch”, umı́ tyto
př́ıkazy demonstrovat na jednoduchých př́ıkladech

• orientuj́ı se v př́ıkazech cykl̊u ”while”a ”for”, znaj́ı rozd́ıly v jejich použit́ı

• seznámı́ se s některými alternativami pro větveńı programů a cykl̊u

• dokáž́ı použ́ıt př́ıkazy pro laděńı programu

10.1 Dávkové soubory (skripty) a funkce

Programy v MATLABu, které si může uživatel běžně vytvořit, lze rozdělit do dvou
skupin: dávkové soubory neboli skripty a funkce. Hlavńı rozd́ıl mezi nimi je v tom, že
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funkce může pracovat se vstupńımi a výstupńımi proměnnými, dávkový soubor nikoliv.
Daľśı rozd́ıl je v lokálńıch a globálńıch proměnných, ten bude popsán dále. Obě skupiny
programů řad́ıme mezi tzv. M-fajly, nebot’ jsou uloženy v souborech s př́ıponou .m –
např. dávka1.m, funkce2.m apod.
Dávkový soubor obsahuje př́ıkazy MATLABu, které bychom mohli zadávat př́ımo
z klávesnice. Důvodem jejich uložeńı do souboru může být třeba to, že stejnou sek-
venci př́ıkaz̊u budeme potřebovat v́ıcekrát. Důležitou roli zde má soubor s názvem
startup.m, který se vykoná při každém spuštěńı programu MATLAB, pokud existuje
v adresáři, v němž MATLAB poušt́ıme. V souboru startup.m může být např. úvodńı
nastaveńı formátu, otevřeńı záznamu práce př́ıkazem diary, atd.
Př́ıklad obsahu souboru startup.m:

format compact

diary on

disp(’Program MATLAB Vás vı́tá!’)

disp(’ ’)

disp(’Vás pracovnı́ adresář je:’)

disp(pwd)

Funkce muśı zač́ınat hlavičkou, která má tvar:

function [vystupni parametry] = nazev funkce(vstupni parametry)

a měla by končit př́ıkazem end.
Vytvořená funkce muśı být uložena v souboru s př́ıponou .m. Je doporučováno volit
shodný název pro funkci i soubor, v opačném př́ıpadě je při voláńı funkce rozhoduj́ıćı
název souboru.
Seznamy vstupńıch a výstupńıch parametr̊u jsou seznamy proměnných oddělených
čárkami. Tyto proměnné je možné libovolně použ́ıvat v př́ıkazech uvnitř funkce, přičemž
všechny výstupńı proměnné by měly mı́t přǐrazenou hodnotu před ukončeńım běhu
funkce. Pokud je výstupńı proměnná jen jedna, nemuśı být uzavřena v hranatých
závorkách. Vstupńı ani výstupńı proměnné nejsou povinné, hlavička funkce může v tomto
př́ıpadě vypadat následovně:

function funkce1

Na řádćıch pod hlavičkou může být umı́stěna nápověda k funkci. Jedná se o řádky
zač́ınaj́ıćı znakem % (komentáře) obsahuj́ıćı popis chováńı funkce. Nápověda se zobraźı
pomoćı funkce help nazev funkce nebo doc nazev funkce.

Př́ıklad jednoduché funkce:
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function [P,o] = trojuh(a, b, c)

% [P,o] = trojuh(a, b, c)

% Funkce pro výpočet obvodu a obsahu trojúhelnı́ka

% a, b, c - délky stran

% P - obsah, o - obvod

o = a+b+c;

s = o/2;

P = sqrt(s*(s-a)*(s-b)*(s-c));

end

Uvedené př́ıkazy ulož́ıme do souboru s názvem trojuh.m v pracovńım adresáři nebo
v adresáři, do kterého je nastavena cesta.

Názvy skutečných proměnných, které předáváme funkci jako parametry, se samozřejmě
nemuśı shodovat se jmény proměnných ve funkci samotné, vstupńı parametry je možné
zadávat i př́ımo pouze hodnotami.

>> [x,y] = trojuh(3, 4, 5)

x =

6

y =

12

V př́ıpadě, že při voláńı použijeme méně výstupńıch parametr̊u, než je v definici funkce,
jsou funkćı přǐrazeny př́ıslušné hodnoty zleva, pokud tuto situaci neřeš́ı funkce samotná.

>> trojuh(3, 4, 5) źıskáme pouze obsah trojúhelńıka, jehož hodnota bude je
přǐrazena v proměnné ans

Funkce je ukončena po vykonáńı všech př́ıkaz̊u, které obsahuje. Je také možné funkci
ukončit dř́ıve pomoćı př́ıkazu return. Předčasné ukončeńı činnosti funkce dosáhneme
též funkćı error(’chyba’), která nav́ıc vyvolá zvukový signál a vyṕı̌se textový řetězec
chyba.

>> A = [];

>> [m, n] = size(A);

>> if m*n == 0 % matice a je prazdna

error(’Prazdna matice!’); % vypis chyboveho hlaseni (cervene) v

pripade, ze je podminka splnena

end

Prazdna matice!
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10.2 Lokálńı a globálńı proměnné

Všechny proměnné definované v MATLABu jsou implicitně považovány za lokálńı,
tj. nejsou známy mimo aktivńı prostřed́ı, kterým může být volaná funkce nebo pra-
covńı okno s př́ıkazovým řádkem. Tedy pokud jsme v pracovńım okně definovali na
př́ıkazovém řádku proměnnou x, pak ve volané funkci bude tato proměnná neznámá.
Pokud si uvnitř funkce definujeme také proměnnou x nebo tak bude označen vstupńı,
př́ıpadně výstupńı parametr, nebude to mı́t žádný vliv na proměnnou x definovanou
v př́ıkazovém řádku. Naopak jakékoliv proměnné definované během práce nějaké funkce
nejsou známy mimo tuto funkci.

Výjimku tvoř́ı dávkové soubory, ve kterých jsou známé proměnné definované v prostřed́ı,
odkud byly zavolány. Naopak pokud v dávce nějaké proměnné definujeme, jsou pak
známé i po jej́ım ukončeńı.
Mějme soubor davka1.m obsahuj́ıćı př́ıkazy
[P1, o1] = trojuh(3, 4, 5);

[P2, o2] = trojuh(7, 8, 9);

Po zadáńı př́ıkazu davka1 z př́ıkazové řádky jsou definovány proměnné P1, o1, P2,

o2 obsahuj́ıćı spočtené hodnoty. Podobně bychom mohli tyto hodnoty použ́ıt v nějaké
funkci, která by obsahovala př́ıkaz davka1.

V př́ıpadě, že potřebujeme použ́ıt nějakou proměnnou definovanou v př́ıkazové řádce
i v nějaké funkci, muśıme ji deklarovat jako globálńı pomoćı př́ıkazu global, a to jak
v př́ıkazové řádce tak v těle funkce. Tato deklarace by se měla použ́ıt před přǐrazeńım
hodnoty této proměnné.

10.3 Základńı programové struktury

Mezi základńı programové struktury patř́ı př́ıkaz větveńı a př́ıkaz cyklu. Tyto struktury
je samozřejmě možné použ́ıt i v př́ıkazové řádce MATLABu. Nejprve se tedy zmı́ńıme
o větveńı programu.

10.3.1 Větveńı programu

Větveńı se provád́ı př́ıkazem if. Syntaxe jeho použit́ı se ř́ıd́ı následuj́ıćım schématem:

if podmı́nka1

přı́kazy1

elseif podmı́nka2

přı́kazy2

else

přı́kazy3

end
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Větve else a elseif jsou samozřejmě nepovinné, přičemž elseif je možné použ́ıt
v́ıcekrát. Př́ıkaz̊u v každé větvi může být v́ıc. Znázorněné odsazeńı je nepovinné a je
použito kv̊uli větš́ı přehlednosti. Všechny podmı́nky, př́ıkazy i kĺıčová slova je možné
uvést v jediném řádku, v tomto př́ıpadě je nutno použ́ıt oddělovač př́ıkaz̊u, tedy čárku
nebo středńık.

Podmı́nky po kĺıčových slovech if a elseif jsou obecně matice. Plat́ı, že podmı́nka
je splněna, jestliže všechny jej́ı prvky jsou nenulové. Např́ıklad pokud má podmı́nka1
tvar A==B, kde A, B jsou matice, pak tento výraz vrát́ı matici s jedničkami nebo nulami,
podle toho, zda se jednotlivé odpov́ıdaj́ıćı prvky shoduj́ı nebo ne. Větev př́ıkazy1 by
se provedla jen v tom př́ıpadě, že výsledná matice obsahuje jenom jedničky.

Kĺıčové slovo elseif je možné nahradit dvojićı else a if, ovšem potom je potřeba
o jeden end v́ıce. Schéma by pak vypadalo následovně:

if podmı́nka1

přı́kazy1

else

if podmı́nka2

přı́kazy2

else

přı́kazy3

end

end

Jako př́ıklad vytvoř́ıme soubor davka1.m. Po zadáńı př́ıkazu davka1 z př́ıkazové
řádky je uživatel vyzván, aby zadal libovolné č́ıslo. Po zadáńı hodnoty a stisknut́ı
klávesy ENTER se vyṕı̌se na obrazovku, jestli uživatel zadal kladné nebo záporné č́ıslo.

s = input(’Zadejte libovolne cislo: ’)

if s < 0

disp(’Zadali jste zaporne cislo.’);
elseif s > 0

disp(’Zadali jste kladne cislo.’);
else

disp(’Vami zadana hodnota je bud 0 nebo to neni cislo!’);
end

Daľśım typem větveńı je switch. Syntaxe jeho použit́ı se ř́ıd́ı následuj́ıćım schématem:

switch výraz

case přı́pad1

přı́kazy1

case přı́pad2

přı́kazy2
...
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otherwise

přı́kazy jiné

end

Tento typ větveńı se použ́ıvá předevš́ım v situaćıch, kdy proměnná výraz nabývá
v́ıce hodnot. Přeṕınač switch sleduje hodnotu proměnné výraz a pro jednotlivé př́ıpady
(case) provede př́ıslušné přı́kazy. Pokud nenastane žádný z popsaných př́ıpad̊u, vy-
konaj́ı se přı́kazy jiné. Znázorněné odsazeńı je nepovinné a je použito kv̊uli větš́ı
přehlednosti.

Jako př́ıklad vytvoř́ıme soubor davka2.m, ve kterém je uživatel vyzván, aby zadal
č́ıslo, které odpov́ıdá pořad́ı dne v týdnu. Po zadáńı hodnoty a stisknut́ı klávesy EN-
TER se vyṕı̌se na obrazovku den, který odpov́ıdá zadanému č́ıslu.

s = input(’Zadejte poradi dne v tydnu: ’) switch s

case 1

disp(’Zadali jste cislo pro pondeli.’);

case 2

disp(’Zadali jste cislo pro utery.’);

case 3

disp(’Zadali jste cislo pro stredu.’);

case 4

disp(’Zadali jste cislo pro ctvrtek.’);

case 5

disp(’Zadali jste cislo pro patek.’);

case 6

disp(’Zadali jste cislo pro sobotu.’);

case 7

disp(’Zadali jste cislo pro nedeli.’);

otherwise

disp([’Zadane cislo ’,num2str(s),’ neodpovida zadnemu dni!’]);

end

10.3.2 Cykly

Pro cyklus jsou v MATLABu dva př́ıkazy. Je to př́ıkaz while a př́ıkaz for.
Cyklus while se použ́ıvá v př́ıpadech, kdy předem neznáme počet pr̊uběh̊u cyklem,
který je závislý na předem splněńı dané podmı́nky. Použit́ı př́ıkazu while vypadá
následovně:

while podmı́nka

přı́kazy

end
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Pro vyhodnoceńı podmı́nky podmı́nka plat́ı v podstatě tatáž pravidla jako pro
př́ıkaz if. Př́ıkazy mezi while a end se vykonávaj́ı, pokud je podmı́nka pravdivá.

Jako př́ıklad vytvoř́ıme soubor davka3.m, po jehož spuštěńı z př́ıkazové řádky je
uživatel vyzván, aby zadal nějaký text. Po zadáńı textu a stisknut́ı klávesy ENTER
se vyṕı̌se na obrazovku libovolná permutace textu. Zadá-li uživatel pouze klávesu EN-
TER, dávka se ukonč́ı.

s = input(’Zadejte libovolny text (konec = ’’ENTER’’): ’,’s’);

n = length(s);

while n ~= 0

disp(’Libovolna permutace zadaneho textu je:’);

disp(s(randperm(n)));

s = input(’Zadejte libovolny text (konec = ’’ENTER’’): ’,’s’);

n = length(s);

end;

Př́ıkaz for se použ́ıvá předevš́ım v př́ıpadech, kdy předem známe počet pr̊uchod̊u
cyklem. Jeho syntaxe je následuj́ıćı:

for prom=výraz

přı́kazy

end

Výraz v uvedeném přǐrazeńı dá obecně matici. Proměnná prom je pak sloupcový vek-
tor, který v pr̊uběhu cyklu postupně nabývá hodnot jednotlivých sloupc̊u této matice.
Velmi typické je následuj́ıćı použit́ı:

for k=1:n

přı́kaz

end

Je třeba si uvědomit, že výraz 1:n vytvoř́ı matici o jednom řádku a n sloupćıch, hod-
noty v tomto řádku budou č́ısla od 1 do n, takže proměnná k bude postupně nabývat
těchto hodnot. V tomto př́ıpadě se tedy chová př́ıkaz for podobně, jak to známe
z jiných programovaćıch jazyk̊u. Pokud je jako výraz použita nějaká konstantńı ma-
tice a v pr̊uběhu cyklu ji změńıme, proměnná prom bude nabývat p̊uvodńıch hodnot
sloupc̊u matice. Běh obou cykl̊u je možné předčasně přerušit, slouž́ı k tomu př́ıkaz
return. Tato situace může nastat třeba při řešeńı soustavy lineárńıch rovnic, kdy
během výpočtu zjist́ıme, že matice soustavy je singulárńı.

V MATLABu je často možné nahradit použit́ı cyklu jedńım nebo několika př́ıkazy,
pokud využijeme některé již definované funkce. Jako př́ıklad nám může sloužit výpočet
faktoriálu. Pokud chceme vypoč́ıtat faktoriál z č́ısla n v běžném programovaćım jazyce,
postupujeme obvykle následovně:

88



KAPITOLA 10. PROGRAMOVÁNÍ V MATLABU

faktor = 1;

for k = 1:n

faktor = faktor * k;

end

Pro tento účel stač́ı v MATLABu napsat př́ıkaz

faktor = 1;

for k = 1:n

faktor = faktor * k;

faktor = prod(1:n);

end

Tento př́ıkaz dá správný výsledek i pro n=0, nebot’ součin přes prázdnou matici dává
jako výsledek jedničku.

10.4 Nástrahy při programováńı v MATLABu

Výše naznačený postup – totiž práce s vektory a s maticemi nikoliv v cyklech, ale se
všemi prvky v jediném př́ıkazu najednou – je pro MATLAB typický. V tom také spoč́ıvá
jedna z velkých přednost́ı tohoto systému – možnost psát programy velmi efektivně.
Skrývá se zde ale také kámen úrazu, dokonce i pro zkušené programátory, kteř́ı mohou
být navykĺı na jiný zp̊usob práce.

Uved’me jednoduchý př́ıklad. Potřebujeme definovat nějakou funkci po částech,
dejme tomu f(x) bude mı́t hodnotu x^2 pro x < 0 a hodnotu x^3 pro x >= 0. Prvńı
věc, která by mnohé napadla, je udělat to následovně:

function y = f(x)

if x < 0

y = x^2;

else

y = x^3;

end

Tento postup je zajisté správný, pokud by se jednalo o program řekněme v ja-
zyce C nebo Pascal, kde při poč́ıtáńı funkčńıch hodnot pro nějakou množinu bod̊u
postupujeme v cyklu. Ale v MATLABu je zvykem, že jako argument funkce může být
použit vektor nebo matice, funkce pak vrát́ı vektor či matici stejného řádu, kde na od-
pov́ıdaj́ıćıch mı́stech budou funkčńı hodnoty v p̊uvodńıch bodech. Tohle výše uvedená
funkce evidentně nedělá.

Vypadá to, že stač́ı, když oprav́ıme operátor ^ na operátor .^, který pracuje po
složkách. Tato úprava ale nestač́ı. Jak bylo vysvětleno výše, výraz za kĺıčovým slovem
if je matice nul a jedniček stejného řádu jako proměnná x. Stač́ı, aby nula byla je-
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diná, a provede se druhá větev programu. Tedy jestliže jediná složka matice x bude
nezáporná, pak výsledkem budou na všech mı́stech výstupu třet́ı mocniny. Pokud ale
budou všechny složky záporné, výsledek bude kupodivu správný.

Pokusme se funkci opravit. Jeden ze zp̊usob̊u, jak to udělat, je provést přǐrazováńı
v cyklech. Výsledek pak vypadá takto:

function y = f1(x)

[m,n] = size(x); % zjištěnı́ rozměrů matice

y = zeros(size(x)); % definice výstupnı́ matice stejných rozměrů

for k = 1:m

for l = 1:n

if x(k,l) < 0

y(k,l) = x(k,l)^2;

else

y(k,l) = x(k,l)^3;

end

end

end

end

Tento postup je po stránce výsledk̊u správný, ztráćı se j́ım ale veškeré výhody
MATLABu. Problém lze vyřešit mnohem efektivněji. Jednak by bylo možné použ́ıt
pouze jeden cyklus ve tvaru for k = 1:m*n a při indexováńı pak zadávat pouze jeden
index, např. y(k) = x(k)^2;

Lze se ale obej́ıt bez cykl̊u úplně. Stač́ı, jestliže vytvoř́ıme dvě matice stejného řádu
jako x, prvńı bude mı́t jedničky na mı́stech záporných složek x a nuly jinde, u druhé
tomu bude naopak. Tyto matice vynásob́ıme druhými resp. třet́ımi mocninami složek x

a po sečteńı vyjde správný výsledek. Pro lepš́ı pochopeńı uvedeného postupu uvedeme
následuj́ıćı program:

function y = f2(x)

p1 = x < 0;

p2 = x >= 0;

y = p1.*x.^2 + p2.*x.^3;

end

Je dokonce možné provést zkráceńı na jediný řádek, pokud nepoč́ıtáme hlavičku
funkce:

function y = f3(x)

y = (x<0).*x.^2 + (x>=0).*x.^3;

end
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Tato verze je nejen daleko kratš́ı, ale rovněž funguje rychleji, protože prováděńı cykl̊u je
v MATLABu poměrně pomalé, kdežto pro manipulaci s maticemi se použ́ıvaj́ı interńı
MATLABovské funkce, které pracuj́ı daleko efektivněji.

10.5 Laděńı programu

Běžně se stává, že hotový program sice pracuje, ale chová se podivně nebo jeho výsledky
nejsou ve shodě s očekáváńım. V tomto př́ıpadě je potřeba naj́ıt chybu, v čemž mo-
hou pomoci lad́ıćı prostředky MATLABu. V nověǰśıch verźıch je laděńı umožněno
v rámci editoru programů, který je součást́ı MATLABu. Poṕı̌seme ale i prostředky,
které umožňuj́ı laděńı z př́ıkazové řádky.

K laděńı slouž́ı následuj́ıćı př́ıkazy:

dbstop, dbstep, dbclear, dbcont, dbstack, dbtype, dbquit, dbup, dbdown, dbstatus

Př́ıkazem dbstop je možné nastavit zastaveńı programu v daném mı́stě. Syntaxe
př́ıkazu je

dbstop in m-file zastav́ı v daném souboru obsa-
huj́ıćım funkci na prvńım př́ıkazu

dbstop in m-file at line zastav́ı v daném souboru na dané
řádce

dbstop in m-file at subfun zastav́ı v daném souboru na
začátku dané podfunkce

dbstop if error zastav́ı v př́ıpadě chyby
dbstop if warning zastav́ı v př́ıpadě varováńı
dbstop if naninf zastav́ı v př́ıpadě výskytu hod-

noty Inf nebo NaN

dbstop if infnan zastav́ı v př́ıpadě výskytu hod-
noty Inf nebo NaN

Po zastaveńı běhu programu je možné kontrolovat hodnoty proměnných jejich výpisem,
př́ıpadně je opravovat. Př́ıkazem dbstack můžeme zobrazit posloupnost voláńı jednot-
livých funkćı v mı́stě zastaveńı. Př́ıkazem dbtype můžeme zobrazit daný soubor včetně
č́ısel řádk̊u. Pokud chceme zobrazit řádky v daném rozmeźı, použijeme dbtype mfile

n1:n2.
Př́ıkaz dbstep provede př́ıkaz na řádce, kde se běh programu zastavil. Př́ıkazem

dbstep n se provede n řádk̊u od mı́sta zastaveńı. Pokud je na mı́stě zastaveńı voláńı
funkce a chceme pokračovat s laděńım uvnitř této funkce, použijeme př́ıkaz dbstep in.

Pomoćı př́ıkazu dbcont se spust́ı daľśı běh programu. Př́ıkazem dbquit se předčasně
ukonč́ı činnost laděného programu. Pokud chceme zjistit, jaké byly hodnoty proměnných
v nadřazené funkci nebo v základńım prostřed́ı, lze použ́ıt př́ıkaz dbup, který zajist́ı

91



KAPITOLA 10. PROGRAMOVÁNÍ V MATLABU

zavedeńı proměnných z prostřed́ı nadř́ızeného funkci, v ńıž se právě nacháźıme. Opačně
funguje funkce dbdown.

Seznam všech mı́st zastaveńı źıskáme př́ıkazem dbstatus. Odstranit bod zastaveńı
lze pomoćı dbclear.

Př́ıklady k procvičeńı

1. Vytvořte funkci nasobky(), která pro vstupńı parametry k a n vyṕı̌se prvńıch k

násobk̊u č́ısla n.

2. Vytvořte funkci test(), která pro vstupńı vektor známek (1 – 5) testu z mate-
matiky urč́ı četnosti jednotlivých hodnoceńı. Výstup uložte do matice – v prvńım
sloupci hodnoceńı, ve druhém sloupci počet hodnoceńı.
Funkce by také měla zkontrolovat, zda se opravdu jedná o celoč́ıselný vstupńı
vektor s hodnotami 1, 2, . . . , 5, v opačném př́ıpadě by měla skončit chybovým
hlášeńım.

3. Vytvořte funkci soucet(), která bude náhodně generovat hodnoty z intervalu
[0, 1], dokud jejich součet nepřevýš́ı hodnotu vstupńıho parametru s (s > 1).
Funkce na svém výstupu vyṕı̌se vektor vygenerovaných hodnot vektor a jejich
součet suma.
Funkce by měla ověřit, zda je s numerická hodnota větš́ı než 1, v opačném př́ıpadě
by měla skončit chybovým hlášeńım.

Řešeńı.

1. function[vystup] = nasobky(k, n)

% pro zadana "k"a "n"vypise prvnich "k"nasobku cisla "n"

vystup = (1:k) .* n;

end

2. function[vystup] = test(v)

% pro zadany vektor hodnoceni testu vypocita jejich cetnosti

if (isnumeric(v) == 0) | any(v - round(v) ~= 0) | any(v < 1) ...

| any(v > 5)

error(’Spatne zadana hodnoceni!’)

end

for i = 1:5
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cetnost(i) = sum(v == i);

vystup = [1:5; cetnost]’;

end

3. function[vektor, suma] = soucet(s)

if isnumeric(s) == 0 | s <= 1

error(’Spatne zadana hodnota s!’)

end

suma = 0;

vektor = [];

while suma <= s

prvek = rand(1);

suma = suma + prvek;

vektor = [vektor, prvek];

end

end
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Úvod

R je volně dostupný jazyk použ́ıvaný zejména v akademické a vědecké sféře. Jedná se
o prostřed́ı pro statistickou analýzu dat a jejich grafické zobrazeńı. Standardńı distri-
buce R obsahuje množstv́ı funkćı pro manipulaci s daty, výpočty a grafické výstupy,
široká škála daľśıch funkćı je součást́ı mnoha podp̊urných baĺıčk̊u. Jedná se o progra-
movaćı prostřed́ı umožňuj́ıćı definovat rovněž své vlastńı funkce a skripty.
Bezesporným kladem jazyka R je jeho grafika. Ta je založena na systému high-level
a low-level funkćı, jejichž vhodnou kombinaćı může uživatel dosáhnout grafického
výstupu přesně dle své představy.

Následuj́ıćı studijńı text seznamuje studenty se syntax́ı jazyka R, jeho datovými struk-
turami, funkcemi pro tvorbu grafiky stejně jako se základy programováńı. Text je do-
plněn o množstv́ı jak ukázkových př́ıklad̊u, tak př́ıklad̊u určených pro samostatné řešeńı
a je vytvořen pro práci v prostřed́ı klasické př́ıkazové řádky jazyka R. V současné době
je ovšem možnost využ́ıt r̊uzných nadstaveb a uživatelsky př́ıvětivěǰśıho prostřed́ı, např.
RStudio, RKWard apod.
Program je volně dostupný na webových stránkách projektu (http://www.r-project.
org, [19]), kde jsou k dispozici i podrobné manuály ([17], [10]) a online nápověda.
Srozumitelným a velmi přehledně zpracovaným materiálem s množstv́ım názorných
př́ıklad̊u a doplňkových otázek je skriptum P. Drozd: Cvičeńı z biostatistiky [3], z an-
glické literatury stoj́ı za zmı́nku studijńı materiály Theresy A. Scott [11], [12], [13],
[14]. Velmi př́ınosné jsou dokumenty srovnávaj́ıćı př́ıkazy v R s ekvivalentńımi př́ıkazy
v MATLABu [5], [4].

Někdy se syntaxe či chováńı R a MATLABu výrazně lǐśı. V těchto př́ıpadech
je v textu na tyto odlǐsnosti upozorněno a pro zvýrazněńı a snadněǰśı orientaci
je na okraj́ıch stránek použita ikonka MATLABu [20].

Kateřina Konečná, Jan Koláček

http://www.r-project.org
http://www.r-project.org
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Kapitola 1

Prvńı setkáńı s jazykem R

Základńı informace

R je volně šǐritelný programovaćı jazyk, který umožňuje špičkové zpracováńı dat včetně
grafických výstup̊u. Jeho široké spektrum využit́ı zahrnuje možnost doplněńı základńıch
funkćı ohromným množstv́ım baĺıčk̊u s funkcemi pro r̊uzné typy analýz.
V této kapitole poṕı̌seme, jak prostřed́ı R vypadá, nauč́ıme se zde orientovat, zaměř́ıme
se na základńı syntaxi a pravidla pro práci s proměnnými a funkcemi. Ćılem neńı znát
všechny argumenty funkćı zpaměti, ale dobře jim porozumět a vědět, kde tyto informace
naj́ıt. Důležitou součást́ı kapitoly je proto naučit se pracovat s nápovědńım systémem
jazyka, popř. vědět, kde naj́ıt podrobněǰśı manuály vhodné zejména pro začátečńıky.
Jazyk R pracuje nad datovými strukturami - těm nejčastěji použ́ıvaným je stručně
věnována posledńı část kapitoly.

Výstupy z výuky

Studenti

• se seznámı́ s prostřed́ım jazyka R a jeho základńımi př́ıkazy,

• umı́ využ́ıvat nápovědńıho systému,

• se orientuj́ı v pracovńım prostoru a př́ıkazech s ńım spjatých,

• rozlǐsuj́ı datové typy objekt̊u, dokáž́ı popsat jednotlivé datové struktury.
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1.1 Základńı ovládáńı

R je volně dostupný programovaćı jazyk a softwarové prostřed́ı pro statistické výpočty
a grafiku, který je možný provozovat na operačńıch systémech UNIX, Windows i Ma-
cOS. R je skutečně

”
jen“ programovaćı jazyk - žádné grafické rozhrańı, které by se

dalo ovládat myš́ı, zde neńı. Pro grafické rozhrańı (GUI) je potřeba vyzkoušet některé
grafické nástavby (Poor Man’s GUI, Rcommander, . . . ). Program lze źıskat z webových
stránek projektu (http://www.r-project.org, [19]).

Po spuštěńı programu se objev́ı okno s konzolou (R console), ve kterém se daj́ı
spouštět funkce, vkládaj́ı se objekty, provád́ı se výpočty a zobrazuj́ı se i základńı
výstupy. Dále se můžeme setkat i s daľśımi typy oken:

• okno nápovědy - volá se po zadáńı př́ıkazu help()

• grafické okno - při spuštěńı grafické prezentace

• editor programu - zobraźıme ho v menu File → New Script. Toto okno je
určeno k tvorbě programů. (U deľśıch zdrojových kód̊u je výhodné mı́t k dispozici
editor s č́ıslovanými řádky, kontrolu syntaxe R a závorek - jako freeware PSPad,
http://www.pspad.com , nebo shareware WinEdt, http://www.winedt.cz )

To, že je konzole připravena k použ́ıváńı, symbolizuje prompt >, za ńımž následuj́ı
jednotlivé př́ıkazy. Pokud nezměńıme základńı nastaveńı, řádky, do nichž vepisujeme
př́ıkazy, jsou odlǐseny červenou barvou. Výstupńı řádek je psán modrým ṕısmem,
v př́ıpadě hodnot zač́ıná pořadovým č́ıslem dané hodnoty. Př́ıkaz v konzole spust́ıme
klávesou ENTER. Takto provedený př́ıkaz nelze opravit př́ımo, ale v již napsaných
př́ıkazech můžeme listovat pomoćı kláves ↑ ↓ , jež umožňuj́ı pohyb v historii př́ıkaz̊u.
Historii př́ıkaz̊u můžeme uložit v menu File → Save History. Konzole se všemi př́ıkazy
může být uložena v menu File → Save to File . . . .

Jednotlivé př́ıkazy jsou vkládány na nový řádek, v př́ıpadě v́ıce př́ıkaz̊u za se-
bou jsou navzájem oddělovány středńıkem. Složitěǰśı př́ıkazy, které maj́ı být spuštěny
bezprostředně po sobě, jsou seskupovány pomoćı složených závorek. Každý př́ıkaz je
následován kulatými závorkami s argumenty v př́ıpadě, že jsou požadovány. Argumenty
lze uvádět ve stejném pořad́ı, v jakém byly definovány, nebo je možno je uvádět v libo-
volném pořad́ı ve tvaru nazev.argumentu=hodnota. Argumenty je často možné zkra-
covat (jestliže zkratka nemůže znamenat jiný argument), např. round(x, digits=2)

má naprosto stejný význam jako round(x, d=2) (jedná se o funkci zaokrouhleńı na 2
desetinná mı́sta).

Př́ıkazem <- (popř. =, ten se ovšem nedoporučuje) vlož́ıme daný výraz do proměnné.
K jej́ımu zobrazeńı muśı být v konzole z př́ıkazové řádky zavolán jeho název. Daľśı
možnost́ı je zadáńı celého př́ıkazu do kulatých závorek.

98

http://www.r-project.org
http://www.pspad.com
http://www.winedt.cz
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> a <- 2

> a

[1] 2

> (a <- 2)

[1] 2

Pro neúplné př́ıkazy se na následuj́ıćım řádku objev́ı prompt + , který dává možnost
dodat chyběj́ıćı část př́ıkazu, a pokračuje dál ve čteńı.

> a <- (2+3

> + ) * 5

[1] 25

Symbol # na př́ıkazové řádce zp̊usob́ı ignoraci zbytku řádky (komentář).

> a <- 2 # komentar

> a

[1] 2

Při zadáváńı názvu jednotlivých proměnných či objekt̊u bychom měli dodržovat
určitá pravidla. Názvy se mohou skládat z ṕısmen (a–z, A–Z), č́ıslic (0–9), tečky a
podtrž́ıtka. Název muśı zač́ınat ṕısmenem, nesmı́ zač́ınat č́ıslićı, tečka rovněž neńı do-
poručována. Matematické operátory (+, -, *, /), mezera a jiné daľśı speciálńı znaky
také nejsou povoleny. Chceme-li použ́ıt v́ıceslovný název, rozděleńı názvu na dvě části se
provád́ı pomoćı tečky (např. pr̊uměrnou výšku chlapc̊u můžeme nazvat chlapci.prumer),
popř. pomoćı podtrž́ıtka (chlapci prumer). Rovněž bychom se měli vyvarovat použ́ıváńı
názv̊u vestavěných proměnných. R je case sensitive, tzn. rozlǐsuje malá a velká ṕısmena.

> a <- 2

> a

[1] 2

> A

Error: object ’A’ not found

Běž́ıćı program může být zastaven klávesou ESC ve Windows, CTRL + C v Linuxu.
Konzoli můžeme vymazat klávesovou zkratkou CTRL + L nebo v menu Edit → Clear
Console.

Pro ukončeńı programu se použ́ıvá př́ıkaz q().

1.2 Nápověda

Př́ıkazem help() je vyvoláno daľśı okno – okno nápovědy. V levé části můžeme naj́ıt
abecedně seřazený seznam objekt̊u, poklikáńım na některý z nich se v hlavńım okně
zobraźı popis objektu. Pro zobrazeńı nápovědy ke konkrétńım objekt̊um či funkćım
slouž́ı př́ıkaz help(tema), alternativou může být rovněž ?tema nebo v menu Help→ R-
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functions (text) . . . . Chceme-li znát argumenty př́ıkazu, můžeme použ́ıt funkci
args(nazev funkce).

Pro vyhledáváńı témat v kontextu (tzn. ne pouze v názvech a zkrácených popi-
sech funkćı a objekt̊u, ale i v kĺıčových slovech) slouž́ı př́ıkaz help.search("tema"),
v menu Help → Search Help nebo v okně nápovědy pod záložkou Vyhledávat.
Př́ıkazem apropos("nazev") zobraźıme př́ıbuzné př́ıkazy k př́ıkazu nazev, pro př́ıklady
k nějakému tématu použijeme př́ıkaz example(tema).

K dispozici jsou rovněž PDF manuály, které obsahuj́ı základńı manuály a refe-
rence o funkćıch. Spoušt́ı se přes menu Help → Manuals (in PDF). HTML nápovědu,
obsahuj́ıćı manuály, seznamy funkćı, apod. zobraźıme př́ıkazem help.start() nebo
přes menu Help → Html help.

Jazyk R nab́ıźı i několik funkćı, které uživatel̊um usnadňuj́ı pochopeńı některých
př́ıkaz̊u. Funkce demo je uživatelsky př́ıznivé prostřed́ı, ve kterém běž́ı demonstrace
(ukázkové programy) R skript̊u. Př́ıkaz demo() vyṕı̌se seznam všech dostupných de-
monstraćı. Argumenty funkce demo:
topic téma, které má být demonstrováno
package název baĺıčku, ze kterého má být spuštěno topic

> demo(persp) v novém okně spust́ı ukázky použit́ı funkce persp

V MATLABu je analogickým př́ıkazem funkćı help(funkce) a ?funkce př́ıkaz
help funkce.

1.3 Workspace (pracovńı prostor)

Program R nač́ıtá data z jakéhokoliv adresáře. Nejjednodušš́ı pro manipulaci s nimi je
ukládat si data do tzv. pracovńıho adresáře (workspace). Chceme-li zjistit, ve kterém
adresáři se právě nacháźıme, použijeme př́ıkaz getwd(). Ten zobraźı kompletńı cestu
do aktuálńı složky. Pro změnu pracovńıho adresáře použijeme př́ıkaz setwd(), jehož
argumentem je cesta k adresáři v jednoduchých apostofech (’) nebo uvozovkách (”).
Změna adresáře je rovněž možná přes menu File → Change dir . . . .

> (setwd("C:/Documents and Settings/PC/Plocha/R")) nastav́ı za pracovńı ad-
resář složku R umı́stěnou na ploše a vyṕı̌se cestu složky, ze které jsme vycházeli.
[1] "C:/Documents and Settings/PC/Dokumenty"

O tom, že se opravdu nacháźıme v adresáři R, se můžeme přesvědčit př́ıkazem
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> getwd()

[1] "C:/Documents and Settings/PC/Plocha/R"

Př́ıkazy dir() nebo list.files() zobraźıme názvy soubor̊u v aktuálńım nebo za-
daném adresáři.

> dir() výpis soubor̊u v aktuálńım adresáři
[1] "cviceni" "prednasky" "data"

> dir("C:/Documents and Settings/PC/Plocha/R/cviceni")

[1] "cviceni 1" "cviceni 2" "cviceni 3" "cviceni 4"

[5] "cviceni 5" "cviceni 6"

> list.files("C:/Documents and Settings/PC/Plocha/R/cviceni")

[1] "cviceni 1" "cviceni 2" "cviceni 3" "cviceni 4"

[5] "cviceni 5" "cviceni 6"

Všechny objekty, které v pr̊uběhu práce vytvoř́ıme, se ukládaj́ı do paměti a můžeme
s nimi kdykoliv manipulovat. Vytvořené objekty tvoř́ı tzv. workspace (pracovńı pro-
stor), chceme-li je uchovat pro pozděǰśı práci, celý workspace ulož́ıme pomoćı File →
→ Save Workspace . . . . T́ımto zp̊usobem vytvoř́ıme soubor s koncovkou .R, který se
při daľśım spuštěńı ze stejného adresáře automaticky nahraje spolu s historíı př́ıkaz̊u.
V př́ıpadě, že zavřeme program R bez uložeńı, při daľśım spuštěńı už dř́ıve definované
objekty nejsou k dispozici. Vı́ce o ukládáńı jednotlivých objekt̊u viz odstavec 6.2.

Daľśı užitečné př́ıkazy:
objects(), ls() vyṕı̌se všechny názvy objekt̊u, které jsou momentálně definovány
v aktuálńım adresáři
ls(name, pattern, all.names=T) vyṕı̌se ty objekty, které jsou omezeny volitelnými
parametry:

name výpis konkrétńıho objektu podle č́ısla nebo názvu prostřed́ı
pattern vyhledávaćı výraz (např. objekty zač́ınaj́ıćı na ”a”)
all.names nastavený na hodnotu TRUE vyhledává také objekty zač́ınaj́ıćı tečkou

rm() maže vybrané objekty
rm(list=ls()) maže všechny objekty

> ls(pattern="v")

[1] "v" "vec" "vector"

> ls(pattern="v", all.names=T)

[1] ".vec" "v" "vec" "vector"

> rm(v,vec) př́ıkaz analogický př́ıkazu rm(list=c("v","vec"))

> ls()

[1] ".vec" "vector"
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1.4 Datové typy objekt̊u

Jazyk R použ́ıvá následuj́ıćı datové typy:

• numerické hodnoty vypisujeme klasickým zp̊usobem, k odděleńı desetinných mı́st
použ́ıváme desetinnou tečku, tzn.

> 1.234

• komplexńı - numerická hodnota je doplněna o komplexńı jednotku i, např.

> 1 + 2i

[1] 1 + 2i

> 3 + 1i Pozor! Komplexńı jednotka muśı být vždy doplněna o numerickou
hodnotu
[1] 3 + 1i

> 3 + i

Error: object ’i’ not found

• logické hodnoty - hodnoty TRUE, T a FALSE, F (Pozor! Jazyk R je citlivý na velká a
malá ṕısmena, proto logické hodnoty nelze psát jinak než uvedeným zp̊usobem.)
Logické hodnoty se použ́ıvaj́ı pro některé argumenty funkćı, jsou výsledkem tes-
továńı výraz̊u, např.

> 2.3 > 3

[1] FALSE

• řetězec - použ́ıvá se pro textové hodnoty, pro popisky os, název grafu, . . . . Řetězec
muśı být zadán do jednoduchých apostrof̊u (’) nebo dvojitých uvozovek (”):

> r <- "retezec"

[1] "retezec"

> r <- ’retezec’

[1] "retezec"

K dispozici jsou rovněž speciálńı hodnota NA (”Not Available”), která reprezentuje
chyběj́ıćı nebo neznámou hodnotu, a daľśı speciálńı konstanty: NULL, odpov́ıdaj́ıćı
prázdnému objektu, Inf, odpov́ıdaj́ıćı nekonečnu (např. 1/0) a NaN (”Not-a-Number”),
která je výsledkem numerických výpočt̊u, jež nejsou definovány (např. 0/0 nebo Inf -
Inf).

1.5 Datové struktury

Vedle datových typ̊u objekt̊u, jazyk R poskytuje i množstv́ı datových struktur, které
umožňuj́ı v́ıcero hodnot specifikovat jako samostatný objekt. Mezi základńı datové
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struktury patř́ı vektor, faktor, matice, pole, tabulka dat a seznam. V následuj́ıćıch
kapitolách se dozv́ıme, jak jednotlivé datové objekty definujeme, jak s nimi pracujeme.
Protože každý objekt má svá specifika, následuj́ıćı tabulka souhrnně uvád́ı základńı
datové struktury a odpov́ıdaj́ıćı datové typy, kterými mohou být tvořeny.

datová struktura datový typ možnost v́ıce
typ̊u dat
současně

vektor numerický, komplexńı, logický, řetězec ne
faktor numerický, řetězec ne
matice numerický, komplexńı, logický, řetězec ne
pole numerický, komplexńı, logický, řetězec ne
tabulka dat numerický, komplexńı, logický, řetězec ano
seznam numerický, komplexńı, logický, řetězec,

funkce, výraz, . . .
ano

Tab. 1.1. Přehled datových typ̊u objekt̊u

Př́ıklady k procvičeńı

1. Několika zp̊usoby zobrazte nápovědu funkce mean a stručně ji popǐste.

2. Vyhledejte př́ıklad použit́ı funkce dim.

3. Spust’te ukázku použit́ı funkce image.

4. Vypǐste cestu k adresáři, ve kterém se nacháźıte.

5. Definujte následuj́ıćı proměnné:

• proměnnou a s textovou hodnotou "pokus"

• proměnnou a1 s hodnotou 1-i

• proměnnou b s hodnotou TRUE

• proměnnou c s hodnotou -1.333

• proměnnou d s hodnotou ∞

a) Vypǐste seznam všech definovaných proměnných.
b) Vypǐste seznam všech proměnných zač́ınaj́ıćıch na ”a”.
c) Smažte proměnnou c a vypǐste nový seznam definovaných proměnných.
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6. Jakou datovou strukturu byste volili pro zobrazeńı:
a) údaj̊u o nadmořské výšce dané obdélńıkové oblasti,
b) informace o provedeném experimentu obsahuj́ıćı jeho stručný popis v textové
podobě, vstupńı data a porovnáńı výsledk̊u pro r̊uzné metody,
c) pohlav́ı respondent̊u,
d) údaj̊u pro 100 respondent̊u, u nichž známe jméno, př́ıjmeńı, věk, výšku a váhu.

Řešeńı.

1. help(mean), ?mean nebo v menu Help → Search help . . . , mean - funkce pro
výpočet aritmetického pr̊uměru

2. example(dim)

3. demo(image)

4. getwd()

5. a <- "pokus" nebo a <- ’pokus’,
a1 <- 1-1i,
b <- TRUE nebo b <- T,
c <- -1.333,
d <- Inf

a) ls() nebo objects()

b) ls(pattern="a")
c) rm(c), ls()

6. a) matice,
b) seznam,
c) vektor, faktor,
d) datová tabulka.
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Kapitola 2

Vektory

Základńı informace

V této kapitole uvedeme nejjednodušš́ı datovou strukturu – vektor. Vektory jsou po-
sloupnosti hodnot s jistou informačńı hodnotou – mohou udávat hmotnosti kapr̊u
v kádi, koncentrace mikroorganismů v ovzduš́ı během určitého časového obdob́ı či počty
krtinc̊u na několika sousedńıch zahradách. Seznámı́me se s několika možnostmi, jak de-
finovat vektory r̊uzných datových typ̊u a pracovat s nimi, a s některými speciálńımi
př́ıklady vektor̊u poměrně často využ́ıvanými v praxi – s posloupnostmi a vektory
náhodných č́ısel.
Závěr kapitoly je věnován daľśımu speciálńımu př́ıkladu vektor̊u – faktoru. Tyto struk-
tury umožňuj́ı jednoduše a přehledně definovat a efektivně pracovat s vektory no-
minálńıch nebo ordinálńıch znak̊u.

Předpokládá se znalost práce s poč́ıtačem a základy lineárńı algebry.

Výstupy z výuky

Studenti

• ovládaj́ı základńı př́ıkazy pro tvorbu vektor̊u,

• umı́ vytvářet posloupnosti a generovat vektory náhodných č́ısel,

• dokáž́ı pracovat se subvektory,

• umı́ definovat, vytvářet a použ́ıvat faktory.
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2.1 Základńı př́ıkazy, tvorba vektor̊u

Jazyk R pracuje nad datovými strukturami. Nejjednodušš́ı takovou strukturou je vek-
tor. Např. jednoduchá hodnota (logická hodnota TRUE, numerická hodnota 2, . . . ) je
vektor délky 1. Vektory jsou 1-dimenzionálńı struktury, skládaj́ıćı se z posloupnosti
prvk̊u. Všechny prvky vektoru muśı být stejného datového typu (modu) – numerický,
komplexńı, logický nebo typu řetězec.

Některé prvky vektoru ovšem nemuśı být známy – v těchto př́ıpadech je na mı́sto
př́ıslušného prvku vektoru umı́stěna speciálńı hodnota NA (

”
Not Available“). Všechny

operace nad NA vraćı hodnotu NA. Funkce is.na(x) vraćı hodnoty TRUE na těch po-
zićıch vektoru x, na kterých maj́ı prvky hodnotu NA, na ostatńıch pozićıch vraćı hodnotu
FALSE. Rovněž některé prováděné operace nemuśı dávat smysl (např. 0/0, Inf - Inf),
v těchto př́ıpadech vraćı př́ıkaz hodnotu NaN (

”
Not a Number“).

Pro vytvořeńı numerického vektoru x o hodnotách -1.2, 31.8., 10.7, 5.6, 9.22 použijeme
př́ıkaz x <- c(-1.2, 31.8, 10.7, 5.6, 9.22). Analogicky můžeme použ́ıt př́ıkazu
assign("nazev", c()), v našem př́ıpadě tedy assign("x", c(-1.2, 31.8, 10.7,

5.6, 9.22)). Přǐrazeńı může být rovněž provedeno v opačném směru: c(-1.2, 31.8,

10.7, 5.6, 9.22) -> x.
Naprosto analogickým zp̊usobem můžeme zadávat komplexńı vektory, např. y <-

c(1+2i, 3, 5i), vektory logických hodnot, např. z <- (x<12 & x>-1), nebo vektory
textových hodnot, např. ovoce <- c("banan", "broskev", "jablko", "pomeranc").

Funkce c() sv̊uj výstup zobrazuje jako řádkový vektor, ovšem je s ńım nakládáno
jako s vektorem sloupcovým.

> c(2, 4, "v", F) jedna z hodnot je znak, vektor tedy bude textový
[1] "2" "4" "v" "FALSE"

Př́ıkaz vector(mode, length) vytvoř́ı vektor daného typu mode a dané délky
length s nulovými hodnotami.

> vector(mode="logical", length=3)

[1] FALSE FALSE FALSE

> vector(m="character", length=5)

[1] "" "" "" "" ""

Nejjednodušš́ım zp̊usobem ke generováńı posloupnost́ı č́ısel je použ́ıt operátoru :.
Př́ıkaz a:b vygeneruje aritmetickou posloupnost prvk̊u od a do b s krokem 1, resp.
−1. Funkce sequence(n) slouž́ı ke generováńı posloupnosti hodnot od č́ısla 1 do č́ısla
(vektoru hodnot) uvedeného v argumentu funkce.

> 4:10

[1] 4 5 6 7 8 9 10
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> 2.4:7

[1] 2.4 3.4 4.4 5.4 6.4

> sequence(6)

[1] 1 2 3 4 5 6

> sequence(c(3,5))

[1] 1 2 3 1 2 3 4 5

Ke generováńı posloupnost́ı s daným krokem MATLAB použ́ıvá funkci
a:krok:b. R tuto syntaxi nezná, je proto třeba použ́ıt jiných funkćı.

Pro generováńı složitěǰśıch posloupnost́ı se použ́ıvá funkce seq(), která má 5 argu-
ment̊u, ale pouze některé z nich mohou být specifikovány současně při jednom voláńı.

• Prvńı 2 argumenty specifikuj́ı počátečńı a koncový bod posloupnosti, př́ıkaz
seq(2,10) je ekvivalentńı př́ıkazu 2:10. Argumenty mohou být rovněž volány
pomoćı from=a, to=b.
Př́ıkazy seq(1,30), seq(from=1, to=30) a seq(to=30, from=1) vraćı stejný
výsledek.

• Argument velikosti kroku: by=krok.

• Argument délky posloupnosti: length=delka.

• V př́ıpadě, že je použit argument along.with, muśı být jediným argumentem
funkce. Argument along.with=v generuje posloupnost poč́ınaj́ıćı hodnotou 1
a délkou shodnou s délkou vektoru v.

> seq() vytvořeńı prázdné posloupnosti
[1] 1

> seq(from=2, to=10)

[1] 2 3 4 5 6 7 8 9 10

> seq(from=2, to=15, by=3)

[1] 2 5 8 11 14

> seq(length=6)

[1] 1 2 3 4 5 6

> seq(from=3, length=6)

[1] 3 4 5 6 7 8

> (k <- seq(to=13, length=6))

[1] 8 9 10 11 12 13

> seq(along.with=k)

[1] 1 2 3 4 5 6

> 7 + seq(along.with=k)

[1] 8 9 10 11 12 13
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Pro vytvořeńı vektoru, v němž se opakuje určitý objekt (hodnota nebo vektor), se
použ́ıvá funkce rep(x). Jej́ımi argumenty jsou:

times=pocet udává počet, kolikrát má být objekt za sebe poskládán
each=pocet udává počet opakováńı každé složky objektu
length.out udává délku výsledného vektoru

> x <- 2:5

> rep(x, times=3) stejný výsledek dává i rep(x, 3)

[1] 2 3 4 5 2 3 4 5 2 3 4 5

> rep(x, each=3)

[1] 2 2 2 3 3 3 4 4 4 5 5 5

> rep(x, length.out=10)

[1] 2 3 4 5 2 3 4 5 2 3

> rep(rep(x, each=2), times=2)

[1] 2 2 3 3 4 4 5 5 2 2 3 3 4 4 5 5

Náhodná č́ısla generovaná v R (a obecně ve všech softwarech) nejsou ve skutečnosti
zcela náhodná, ale jsou generována na základě specifických algoritmů tak, aby se
náhodným č́ısl̊um podobala (tzv. pseudonáhodná č́ısla). Podle pravděpodobnosti výskytu
jednotlivých hodnot můžeme generovat č́ısla z r̊uzných typ̊u rozděleńı:
runif(n, min=a, max=b) Náhodně vygeneruje n náhodných č́ısel z intervalu (a, b),
každé č́ıslo má stejnou pravděpodobnost výskytu.
rpois(n, lambda) Náhodně vygeneruje n celých č́ısel z Poissonova rozděleńı s pa-
rametrem lambda.
rnorm(n, mean=mi, sd=sigma) Náhodně vygeneruje n reálných č́ısel z normálńıho
rozděleńı se středńı hodnotou mi a směrodatnou odchylkou sigma.

> runif(10, min=2, max=8)

[1] 3.468575 2.006183 5.151939 4.864977 5.117221 5.981666

[7] 6.186421 6.470627 7.230629 7.726394

> rpois(10, 5)

[1] 7 11 1 4 3 5 6 3 1 5

> rnorm(10, mean=5, sd=2)

[1] 3.880884 5.902384 9.645860 3.955287 3.923085 3.763641

[7] 1.782563 6.003977 7.512364 4.685642

Daľśım užitečným př́ıkazem ke generováńı vektor̊u je funkce sample(). Funkce
sample(x, size, replace=FALSE, prob=NULL) vytvoř́ı náhodnou permutaci prvk̊u
objektu x. Objekt x může být vektor (č́ıselný, komplexńı, logický nebo vektor znak̊u)
nebo přirozené č́ıslo. Argument size je přirozené č́ıslo udávaj́ıćı délku výsledného vek-
toru. Argument replace=TRUE umožňuje opakováńı vybraných prvk̊u, zat́ımco impli-
citńı nastaveńı replace=FALSE opakováńı nepovoluje. Argument prob umožňuje na-
staveńı pravděpodobnostńıch vah výběru jednotlivých prvk̊u.
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> x <- c(1, 3, 5, 7, 2, 6)

> sample(x, 3)

[1] 6 7 2

> sample(x, 3, replace=TRUE)

[1] 3 3 2

> x <- letters[1:15] vektor prvńıch 15 ṕısmen abecedy (a–o)
> sample(x, 4, prob=c(1, rep(0.1, 13), 1))

[1] "a" "o" "d" "l"

> sample(x, 8, prob=c(1, rep(0.1, 13), 1), replace=TRUE)

[1] "e" "b" "o" "o" "n" "a" "a" "c"

2.2 Subvektory

K výpisu určité podmnožiny prvk̊u vektoru můžeme použ́ıt hranatých závorek, [ ].
Obecně má pro vektor x tento př́ıkaz tvar x[index], kde index je vektor jednoho
z následuj́ıćıch tvar̊u:

1. Vektor přirozených č́ısel. Jedná se o vektor index̊u, který nabývá hodnot
z množiny {1, 2, . . . , length(x)}.
> x <- 2:16

> x[7] vyṕı̌se 7. složku vektoru x

[1] 8

> x[4:12] vyṕı̌se 4.–12. složku vektoru x

[1] 5 6 7 8 9 10 11 12 13

Hodnota NA je vrácena v př́ıpadě, že vektor index obsahuje přirozené č́ıslo větš́ı
než je délka vektoru. Podobně R vraćı prázdný vektor numeric(0) v př́ıpadě, že
vektor index obsahuje nulu:

> x[13:18] vyṕı̌se 13.–18. složku vektoru x

[1] 14 15 16 NA NA NA

> x[c(7, 0, 5, 12)] index 0 se ignoruje
[1] 8 6 13

> x[0]

[1] integer(0)

Vektor index můžeme definovat rovněž použit́ım funkćı ke konstrukci nume-
rických vektor̊u, např. c(), :, rep(), sample(), seq()

> x[c(3, 8, 10, 4, 7)]

[1] 4 9 11 5 8

> x[c(rep(4, 2), rep(7, 3))]

[1] 5 5 8 8 8
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> x[sample(x, 5, replace=TRUE)]

[1] 6 10 11 4 6

> x[seq(from=4, to=20, by=3)]

[1] 5 8 11 14 NA NA

Můžeme rovněž použ́ıt funkćı head() a tail(), které vraćı prvńıch/posledńıch
n prvk̊u vektoru (implicitńı nastaveńı n=6):

> head(x)

[1] 2 3 4 5 6 7

> tail(x, n=3)

[1] 14 15 16

2. Vektor záporných celých č́ısel. Vektorem záporných celých č́ısel index vyme-
zujeme ty indexy vektoru x, jejichž odpov́ıdaj́ıćı hodnoty nemaj́ı být vytǐstěny.
Všechny prvky vektoru x, kromě těch specifikovaných vektorem index, jsou do
výsledné podoby vypsány v jejich p̊uvodńım pořad́ı. Délka výsledného vektoru je
length(x) - length(index).

> x[-c(1:10)] vynechá prvńıch deset prvk̊u vektoru
[1] 12 13 14 15 16

> x[-tail(x, 10)]

[1] 2 3 4 5 6 7

3. Logický vektor. Prvky odpov́ıdaj́ıćı hodnotám TRUE vektoru index jsou vypi-
sovány, zat́ımco prvky odpov́ıdaj́ıćı hodnotám FALSE jsou vynechány. Výsledný
vektor je stejné délky jako počet hodnot TRUE vektoru index.

> x[c(TRUE, FALSE, TRUE, TRUE, FALSE, rep(c(TRUE, FALSE), 5))]

vektor index může být zadán vektorem hodnot TRUE a FALSE

[1] 2 4 5 7 9 11 13 15

Poznámka. V př́ıpadě, že je logický vektor kratš́ı než je počet prvk̊u vektoru, ze
kterého prvky vyb́ıráme (vektoru x), je uplatněno pravidlo recycling rule. Pravi-
dlo spoč́ıvá v opakováńı složek logického vektoru tak dlouho, dokud jeho délka
nedosáhne délky vektoru:

> x[c(TRUE, FALSE, TRUE, FALSE)]

[1] 2 4 6 8 10 12 14 16

> x[x>7 & x<=12] vektor index může být dán omezuj́ıćımi podmı́nkami –
použit́ım porovnávaćıch a logických operátor̊u (porovnávaćı a logické operátory
viz odstavec 5.2)
[1] 8 9 10 11 12

V př́ıpadě, že vektor x obsahuje hodnoty NA, potřebujeme pomoćı funkce is.na()
zajistit, aby byly správně vynechány:
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> (y <- c(7, 3, NA, 5, NA, NA, 9))

[1] 7 3 NA 5 NA NA 9

> y[y<6]

[1] 3 NA 5 NA NA

> y[y<6 & !is.na(y)] vyṕı̌se ty hodnoty vektoru y, které jsou menš́ı než 6

a jsou r̊uzné od hodnoty NA

[1] 3 5

Alternativou v této situaci může být funkce subset(). Jej́ım prvńım argumen-
tem je vektor, ze kterého chceme źıskat jeho podmnožinu, druhým argumentem
je vektor omezuj́ıćıch podmı́nek. Výhodou této funkce je, že hodnoty NA jsou au-
tomaticky považovány za FALSE, takže nemuśı být odstraňovány pomoćı funkce
is.na().

> subset(y, y<6)

[1] 3 5

> subset(y, c(TRUE, TRUE, FALSE, FALSE, FALSE, TRUE, TRUE))

[1] 7 3 NA 9

> subset(y, c(TRUE, FALSE, FALSE)) použit́ı pravidla recycling rule
[1] 7 5 9

4. Vektor znakových řetězc̊u. Tento zp̊usob může být použit pouze v př́ıpadě,
kdy prvky vektoru maj́ı názvy. V tom př́ıpadě může být vektor index použit
stejným zp̊usobem jako v př́ıpadě přirozených č́ısel v odrážce 1, řetězce ve vek-
toru index odpov́ıdaj́ı názv̊um prvk̊u vektoru x.

> (ovoce <- c(banan=3, broskev=8, jablko=7, pomeranc=5)) přǐrazeńı
názvu jednotlivým prvk̊um vektoru
banan broskev jablko pomeranc

3 8 7 5
> names(ovoce) každý prvek vektoru má opravdu sv̊uj název
[1] "banan" "broskev" "jablko" "pomeranc"

Jiný zp̊usob definice přǐrazeńı názvu jednotlivým prvk̊um vektoru:
> ovoce <- c(3, 8, 7, 5)

> names(ovoce) <- c("banan", "broskev", "jablko", "pomeranc")

> ovoce[c("broskev", "jablko")]
broskev jablko

8 7

MATLAB použ́ıvá pro výpis subvektor̊u kulatých závorek, pro nekladné argu-
menty vraćı chybové hlášeńı.
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2.3 Délka a změna délky vektoru

Každý vektor má svou délku, což je počet jeho prvk̊u. Ke zjǐstěńı délky definovaného
vektoru slouž́ı funkce length().

Každý prázdný objekt je nějakého datového typu. Např. př́ıkazem

> numeric()

[1] numeric(0)

vytvoř́ıme prázdný numerický vektor, analogicky př́ıkazem character() vytvoř́ıme
prázdný textový vektor, atd. K již existuj́ıćımu objektu libovolné délky můžeme přidávat
nové složky, a to jednoduše umı́stěńım indexu hodnoty do hranaté závorky. Tak př́ıkazem
u[2] <- 5 vytvoř́ıme nový vektor u délky 2 (1. složka neńı známa, má tedy hodnotu
NA, 2. složka má hodnotu 5). Tento př́ıkaz můžeme použ́ıt pro jakoukoliv strukturu za
předpokladu, že datový typ přidávaných prvk̊u je shodný s datovým typem objektu.

Naopak, ke zkráceńı délky objektu je třeba jen operátor přǐrazeńı <-, kde za název
proměnné umı́st́ıme do hranatých závorek ty indexy prvk̊u, které nás zaj́ımaj́ı. Symbol
záporného znaménka před vektorem index̊u v hranatých závorkách určuje ty hodnoty,
které nemaj́ı být vypsány na výstupu.

> u <- 5:12

[1] 5 6 7 8 9 10 11 12

> length(u)

[1] 8

> u[c(1, 3, 5)] vyṕı̌se 1., 3. a 5. prvek vektoru u.
[1] 5 7 9

> u[-c(1, 3, 5)] vynechá 1., 3. a 5. prvek vektoru u.
[1] 6 8 10 11 12

V př́ıpadě, že chceme źıskat prvńıch n složek vektoru, použijeme př́ıkaz length(v)

<- n. Stejným zp̊usobem můžeme i prodlužovat vektory, přidané pozice budou mı́t
hodnotu NA.

> length(u) <- 3 analogické př́ıkazy: u[c(1,2,3)], u[1:3], head(u,3)

> u přesvědč́ıme se, že vektor u opravdu obsahuje jen p̊uvodńı 3 složky
[1] 5 6 7

> length(u) <- 5

> u

[1] 5 6 7 NA NA
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2.4 Faktory

Faktory jsou speciálńım př́ıpadem vektor̊u s nominálńımi nebo ordinálńımi daty. Jedná
se o datovou strukturu, která umožňuje přǐradit smysluplné názvy jednotlivým ka-
tegoríım. Na prvńı pohled vypadaj́ı faktory podobně jako numerické a textové vek-
tory, ale neńı tomu tak. Faktory v sobě nav́ıc obsahuj́ı informaci Levels – jedná se
o konečnou množinu hodnot, kterých kategorická proměnná může nabývat. Jednotlivé
prvky Levels jsou uspořádány podle jejich typu (numericky nebo abecedně), hodnoty
NA zde ovšem nejsou zahrnuty.

> factor(c("kocka", "kun", NA, "pes", "kocka", "pes", "pes"))

[1] kocka kun <NA> pes kocka pes pes

Levels: kocka kun pes

Poznámka. Je d̊uležité si uvědomit, že prvky numerického faktoru nejsou interpre-
továny jako numerické hodnoty:

> mean(factor(1:5)) funkce mean slouž́ı k výpočtu pr̊uměru
[1] NA

Warning message:

In mean.default(factor(1:5)) :

argument is not numeric or logical: returning NA

Funkce factor() má několik volitelných argument̊u (levels, exclude, ordered).
Argument levels může být použit k definováńı úrovńı (Levels) faktoru. Např. můžeme
vytvořit faktor i s úrovńı, která se mezi daty nevyskytuje:

> factor(c(2, 3, 1, NA, 3, 2), levels=1:4) hodnoty NA nejsou do Levels vy-
pisovány
[1] 2 3 1 <NA> 3 2

Levels: 1 2 3 4

Argument levels rovněž může sloužit ke změně pořad́ı prvk̊u úrovńı:

> factor(c(2, 3, 1, NA, 3, 2), levels=c(1, 3, 2, 4))

[1] 2 3 1 NA 3 2

Levels: 1 3 2 4

Argument labels se použ́ıvá k definici popisk̊u:

> factor(c(0, 1, 1, 0, 1), labels=c("nepritomen", "pritomen"))

[1] nepritomen pritomen pritomen nepritomen pritomen

Levels: nepritomen pritomen

> factor(c(0, 1, 1, 0, 1), labels=c("nepritomen", "pritomen"),

+ levels=c(1,0))

[1] pritomen nepritomen nepritomen pritomen nepritomen

Levels: nepritomen pritomen
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Argument exclude ignoruje vybrané prvky, tyto prvky jsou nahrazeny hodnotami NA
> factor(c(2, 3, 1, NA, 3, 2), exclude=3)

[1] 2 <NA> 1 <NA> <NA> 2

Levels: 1 2 <NA>

> factor(c(2, 3, 1, NA, 3, 2), exclude=NULL) argument exclude=NULL

slouž́ı pro zobrazeńı hodnoty NA v Levels

[1] 2 3 1 <NA> 3 2

Levels: 1 2 3 <NA>

Argument ordered=TRUE slouž́ı k seřazeńı úrovńı faktoru. Jediným rozd́ılem na výstupu
je zobrazeńı porovnávaćıho operátoru < mezi jednotlivými úrovněmi faktoru. Tuto
vlastnost můžeme použ́ıt např. při porovnáváńı jednotlivých prvk̊u.

> (velikost <- factor(c(3, 1, 5, 4, 3, 2, 4), labels=c("mravenec",

+ "hlemyzd", "koza", "slon", "zirafa")))

[1] koza mravenec zirafa slon koza hlemyzd slon

Levels: mravenec hlemyzd koza slon zirafa

> (velikost <- factor(c(3, 1, 5, 4, 3, 2, 4), labels=c("mravenec",

+ "hlemyzd", "koza", "slon", "zirafa"), ordered=TRUE))

[1] koza mravenec zirafa slon koza hlemyzd slon

Levels: mravenec < hlemyzd < koza < slon < zirafa

> velikost >= "koza" vraćı vektor logických hodnot, na pozićıch splňuj́ıćıch pod-
mı́nku jsou hodnoty TRUE, na ostatńıch pozićıch FALSE

[1] TRUE FALSE TRUE TRUE TRUE FALSE TRUE

Př́ıklady k procvičeńı

1. V cementárně byla měřena hmotnost pytl̊u cementu, k dispozici jsou naměřené
hodnoty:
50.3, 50.7, 49.2, 50.1, 49.9, 51.1, 49.8, 48.9 a 50.3.
Poskládejte tyto hodnoty do vektoru cement a vyřešte následuj́ıćı úkoly:
a) Pomoćı vhodné funkce zjistěte délku vektoru cement.
b) Vytvořte vektor cement1, který bude obsahovat hodnoty na sudých pozićıch
vektoru cement a dále pak jeho posledńı tři hodnoty.
c) Vytvořte vektor cement2, který bude náhodnou kombinaćı pěti hodnot vek-
toru cement s pravděpodobnost́ı 0.4 pro prvńı čtyři hodnoty vektoru cement a
s pravděpodobnost́ı 0.2 pro ostatńı hodnoty, hodnoty se mohou opakovat.
d) Vypǐste ty složky vektoru cement, které jsou větš́ı než 50.

2. Náhodně vygenerujte vektor v délky 15 s hodnotami 0 a 1. Dále z něj vytvořte
faktor pohlavi, ve kterém se hodnota 0 bude vypisovat jako ”muž”a hodnota 1
jako ”žena”.
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3. Změňte minulé zadáńı tak, aby se hodnota 0 vypisovala jako ”žena”a hodnota 1
jako ”muž”.

4. Vytvořte vektor hodnot v1 od -10 do 0 s krokem 0.5.

5. Vytvořte vektor hodnot v2 obsahuj́ıćı sudé hodnoty posloupnosti -12, -11, . . . ,
11, 12.
a) Hodnoty vektoru v2 zdvojte tak, aby nově vzniklý vektor obsahoval hodnoty
-12, . . . , 12, -12, . . . , 12.
b) Hodnoty vektoru v2 zdvojte tak, aby nově vzniklý vektor obsahoval hodnoty
-12, -12, . . . , 12, 12.

6. Proved’te losováńı tahu sportky, tzn. vyberte 7 č́ısel od 1 do 49 tak, aby se
neopakovala.

7. Náhodně vygenerujte 10 hodnot z normálńıho rozložeńı se středńı hodnotou 5 a
rozptylem 2.

Řešeńı.

1. cement <- c(50.3, 50.7, 49.2, 50.1, 49.9, 51.1, 49.8, 48.9, 50.3)

a) length(cement)
b) cement1 <- c(cement[seq(from=2, to=length(cement), by=2)],

tail(cement, 3))

c) cement2 <- sample(cement, size=5, prob=c(rep(0.4, times=4),

rep(0.2, times=length(cement)-4)), replace=TRUE)

d) cement[cement > 50]

2. v <- sample(c(0, 1), size=15, replace=TRUE) nebo v <- round(runif(

min=0, max=1, n=15))

pohlavi <- factor(v, levels=c(0, 1), labels=c("muz", "zena"))

3. pohlavi <- factor(v, levels=c(1, 0), labels=c("muz", "zena"))

4. v1 <- seq(from=-10, to=0, by=0.5)

5. v2 <- seq(from=-12, to=12, by=2)

a) rep(v2, times=2)

b) rep(v2, each=2)

6. sample(1:49, size=7)

7. rnorm(n=10, mean=5, sd=sqrt(2))
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Kapitola 3

Matice a pole

Základńı informace

Matice maj́ı širokou škálu využit́ı nejen v matematice, ale i v technických a ekono-
mických vědách a statistice. Jejich uplatněńı můžeme hledat např. v řešeńı systémů
lineárńıch rovnic či v aplikaci maticových operaćı. Tato kapitola seznamuje s možnostmi,
jak definovat matice či pole, uvád́ı množstv́ı postup̊u a funkćı, jak s nimi jednoduše
pracovat, v neposledńı řadě uvád́ı př́ıkazy pro řešeńı systémů lineárńıch rovnic.

Výstupy z výuky

Studenti

• ovládaj́ı př́ıkazy pro vytvářeńı matic a poĺı,

• umı́ pracovat se submaticemi,

• dokáž́ı použ́ıt funkce pro manipulaci s maticemi,

• rozlǐsuj́ı maticové násobeńı a násobeńı po složkách, umı́ řešit systémy lineárńıch
rovnic.

3.1 Základńı př́ıkazy, tvorba matic a poĺı

Matice je 2-dimenzionálńı datová struktura, která se skládá z řádk̊u a sloupc̊u. Stejně
jako vektory, všechny prvky matice muśı být stejného datového typu (numerický, kom-
plexńı, logický nebo textový), mohou rovněž obsahovat prvky s hodnotami NA, NaN,
NULL nebo Inf. Pole je k-dimenzionálńı struktura, matice je jej́ım speciálńım typem
pro k = 2.



KAPITOLA 3. MATICE A POLE

Základńım zp̊usobem k vytvořeńı matice je použit́ı př́ıkazu matrix():
matrix(data, nrow, ncol, byrow, dimnames) funkce pro tvorbu matice
data vektor hodnot, které maj́ı být uspořádány do matice
nrow počet řádk̊u matice, implicitńı nastaveńı nrow=1
ncol počet sloupc̊u matice, implicitńı nastaveńı ncol=1
byrow implicitńı nastaveńı byrow=FALSE znač́ı plněńı matice po sloupćıch, na-

staveńı byrow=TRUE plńı matici po řádćıch
dimnames argument typu ”seznam”(viz Kapitola 4) pro pojmenováńı řádk̊u a

sloupc̊u matice

> matrix(data=u, nrow=4, ncol=5) vytvoř́ı matici o 4 řádćıch a 5 sloupćıch,
prvky jsou skládány po sloupćıch

[,1] [,2] [,3] [,4] [,5]

[1,] 1 5 9 13 17

[2,] 2 6 10 14 18

[3,] 3 7 11 15 19

[4,] 4 8 12 16 20
> matrix(data=u, nrow=4, ncol=5, byrow=TRUE) vytvoř́ı matici 4 x 5, argument
byrow=TRUE zajist́ı, aby prvky byly do matice seskládány po řádćıch

[,1] [,2] [,3] [,4] [,5]

[1,] 1 2 3 4 5

[2,] 6 7 8 9 10

[3,] 11 12 13 14 15

[4,] 16 17 18 19 20

Názvy řádk̊u a sloupc̊u mohou být specifikovány argumentem dimnames. Jedná se
o argument typu seznam (pro v́ıce podrobnost́ı viz Kapitola 4) o dvou složkách – tex-
tových vektorech obsahuj́ıćıch názvy jednotlivých řádk̊u a sloupc̊u.

> matrix(u, ncol=5, dimnames=list(c("r1", "r2", "r3", "r4"), c("sl1",

+ "sl2", "sl3", "sl4", "sl5")))
sl1 sl2 sl3 sl4 sl5

r1 1 4 9 13 17

r2 2 5 10 14 18

r3 3 6 11 15 19

r4 4 8 12 16 20

Při definováńı matice je možné jeden z argument̊u jej́ıch rozměr̊u vynechat - jazyk
R si chyběj́ıćı rozměry sám dopoč́ıtá. Rovněž neńı potřeba uvádět názvy argument̊u,
pokud zachováme přesné pořad́ı, které je uvedeno v nápovědńım systému. Př́ıkazy

matrix(u, ncol=5)

matrix(u, nrow=4)

matrix(u, 4)

matrix(u, c(4, 5))
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vraćı stejné výstupy jako výše uvedený př́ıkaz matrix(data=u, nrow=4, ncol=5),
všechny př́ıkazy seskládaj́ı vektor u po sloupćıch do pěti sloupc̊u a čtyř řádk̊u.

Poznámka. V př́ıpadě, že je vektor u kratš́ı než je počet prvk̊u matice, při vytvářeńı
matice je uplatněno pravidlo recycling rule. Pravidlo spoč́ıvá v opakováńı složek vektoru
u tak dlouho, dokud jeho délka nedosáhne počtu prvk̊u matice.

Pro definováńı poĺı slouž́ı př́ıkaz array(), s ńımž je práce analogická:
array(data, dim, dimnames) funkce pro tvorbu pole
data vektor hodnot, které maj́ı být uspořádány do pole
dim numerický vektor rozměr̊u pole, implicitńı nastaveńı dim=length(data)
dimnames argument typu ”seznam”pro pojmenováńı jednotlivých dimenźı pole

> (ar <- array(u, c(2, 5, 2))) vytvoř́ı pole o rozměrech 2 x 5 x 2
, , 1

[,1] [,2] [,3] [,4] [,5]

[1,] 1 3 5 7 9

[2,] 2 4 6 8 10

, , 2

[,1] [,2] [,3] [,4] [,5]

[1,] 11 13 15 17 19

[2,] 12 14 16 18 20

Daľśım zp̊usobem, jak vytvořit matice, popř. pole je př́ıkaz dim(), který vektor
ve svém argumentu uspořádá po sloupćıch do pole požadované dimenze.

> u <- 1:20

> dim(u) <- c(4, 5) vektoru u stanov́ı dimenzi – 4 řádky, 5 sloupc̊u
> u

[,1] [,2] [,3] [,4] [,5]

[1,] 1 5 9 13 17

[2,] 2 6 10 14 18

[3,] 3 7 11 15 19

[4,] 4 8 12 16 20

Pro zjǐstěńı velikosti matice či pole slouž́ı funkce dim(). Výstupem je vektor, jehož
prvńı složka udává počet řádk̊u, druhá udává počet sloupc̊u a v př́ıpadě poĺı odkazuj́ı
daľśı složky na př́ıslušné dimenze. Pro zjǐstěńı počtu řádk̊u či sloupc̊u matic i poĺı slouž́ı
rovněž funkce nrow() či ncol().

> dim(u)

[1] 4 5
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> dim(ar)

[1] 2 5 2

> nrow(ar)

[1] 2

> ncol(ar)

[1] 5

V systému MATLAB lze funkćı size() źıskat rozměry matice, pole i vektoru.
Analogickou funkćı pro size() je v jazyce R funkce dim(), tu ovšem nemůžeme
použ́ıt pro zjǐstěńı délky vektoru. Funkćım nrow(x) a ncol(x) odpov́ıdaj́ı
v MATLABu funkce size(x,1) a size(x,2).

Daľśımi př́ıkazy pro tvorbu matic mohou být cbind() nebo rbind(), které své
argumenty skládaj́ı vertikálně (po sloupćıch) nebo horizontálně (po řádćıch). Argu-
menty mohou být vektory libovolných délek a/nebo matice s odpov́ıdaj́ıćım počtem
řádk̊u nebo sloupc̊u.

> cbind(1:3, 4:6)
[,1] [,2]

[1,] 1 4

[2,] 2 5

[3,] 3 6
> cbind(matrix(1:4, c(2, 2)), matrix(c(8, 11), c(2, 1)))

[,1] [,2] [,3]

[1,] 1 3 8

[2,] 2 4 11
> rbind(1:8, 1:5) v př́ıpadě, že vektory nejsou stejné délky, složky kratš́ıho vek-
toru se opakuj́ı tak dlouho, dokud nedosáhne rozměru deľśıho vektoru

[,1] [,2] [,3] [,4] [,5] [,6] [,7] [,8]

[1,] 1 2 3 4 5 6 7 8

[2,] 1 2 3 4 5 1 2 3
Warning message:

In rbind(1:8 1:5) :

number of columns of result is not a multiple of vector length

(arg 2)

Funkce rbind() a cbind() mohou obsahovat volitelný argument tvaru

nazev.vektoru=vektor,

který slouž́ı k pojmenováńı jednotlivých řádk̊u (v př́ıpadě funkce rbind) a sloupc̊u
(v př́ıpadě cbind). Tento zp̊usob pojmenováńı dimenźı funguje pouze pro vstupńı vek-
tory, v př́ıpadě vstupńıch matic se název ignoruje.
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> cbind(sl1=1:3, sl2=4:6)
sl1 sl2

[1,] 1 4

[2,] 2 5

[3,] 3 6
> rbind(u=1:3, A=matrix(1:6, nrow=2))

[,1] [,2] [,3]

u 1 2 3

1 3 5

2 4 6

Na rozd́ıl od MATLABu nelze v jazyce R matici o jednom sloupci źıskat trans-
pozićı vektoru (funkce t()), je třeba použ́ıt jeden z př́ıkaz̊u matrix(), dim()
nebo rbind().

3.2 Submatice

K výpisu určité podmnožiny prvk̊u matice či pole můžeme použ́ıt hranatých závorek
[ ]. Obecně má pro n-rozměrné pole A tento př́ıkaz tvar A[index 1, index 2, ...,

index n], kde index 1, odkazuje na řádky, index 2 na sloupce a na ostatńı dimenze
odkazuj́ı index 3, ..., index n. Odkaz na každou dimenzi může být jedńım ze čtyř
tvar̊u uvedených v podkapitole 2.2. V př́ıpadě, že některý z index̊u neńı specifikován,
v úvahu je brána celá délka př́ıslušné dimenze.

> (A <- matrix(1:20, 4))
[,1] [,2] [,3] [,4] [,5]

[1,] 1 5 9 13 17

[2,] 2 6 10 14 18

[3,] 3 7 11 15 19

[4,] 4 8 12 16 20
> A[-c(1, 2), c(3, 4, 5)]

[,1] [,2] [,3]

[1,] 11 15 19

[2,] 12 16 20

Jazyk R se vždy snaž́ı vracet objekty s nejnižš́ı možnou dimenźı. Např. chceme-
li vypsat jediný sloupec matice, R jej zobraźı jako řádkový vektor. To ovšem může
být v některých př́ıpadech nežádoućı – toto chováńı můžeme vypnout argumentem
drop=FALSE:
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> A[, 2]

[1] 5 6 7 8

> A[, 2, drop=FALSE]
[,1]

[1,] 5

[2,] 6

[3,] 7

[4,] 8

3.3 Funkce pro manipulaci s maticemi

nrow(), ncol() počet řádk̊u a sloupc̊u pole
dim() dimenze pole
t() transpozice matice
diag(A) vyṕı̌se diagonálu matice A

diag(v) vytvoř́ı diagonálńı matici se složkami vektoru v na diagonále
diag(k) pro každé přirozené č́ıslo k vygeneruje jednotkovou matici

rozměr̊u k × k
lower.tri(), výstupem je matice logických hodnot stejných rozměr̊u jako ma-
upper.tri() tice v argumentu. Hodnoty TRUE odpov́ıdaj́ı prvk̊um

v dolńı/horńı trojúhelńıkové matici. Implicitńı nastaveńı
diag=FALSE nezahrnuje diagonálu.

det() determinant matice
eigen() výstupem je seznam o dvou položkách - values (vlastńı č́ısla)

a vectors (vlastńı vektory). V př́ıpadě, že nás zaj́ımaj́ı pouze
vlastńı č́ısla, popř. pouze vlastńı vektory matice, použijeme
operátoru $: eigen()$values, popř. eigen()$vectors.

qr() QR rozklad. Jedńım z výstup̊u je i hodnost matice, chceme-li
zjistit pouze hodnost matice, můžeme použ́ıt př́ıkaz qr()$rank

svd() singulárńı rozklad trojúhelńıkové matice
norm() norma matice. Je potřeba nainstalovat a nač́ıst podp̊urný

baĺıček Matrix pomoćı př́ıkaz̊u install.packages("Matrix")

a library(Matrix). Volitelnými argumenty můžeme zvolit typ
normy:
"O", "o" nebo "1" pro maximálńı součty ve sloupćıch, implicitńı
nastaveńı,
"I" nebo "i" pro maximálńı součty v řádćıch,
"F" nebo "f" pro Frobeniovu normu (euklidovská norma vektor,
když je na vstupńı matici nahĺıženo jako na vektor)

sum(diag()) stopa matice
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> (A <- matrix(c(3, 2, -1, 0), 2))
[,1] [,2]

[1,] 3 -1

[2,] 2 0
> (v <- diag(A))

[1] 3 0

> diag(v)
[,1] [,2]

[1,] 3 0

[2,] 0 0
> diag(2)

[,1] [,2]

[1,] 1 0

[2,] 0 1
> lower.tri(A)

[,1] [,2]

[1,] FALSE FALSE

[2,] TRUE FALSE
> A[lower.tri(A)] <- 0 horńı trojúhelńıková matice

[,1] [,2]

[1,] 3 -1

[2,] 0 0
> eigen(A)

$values

[1] 2 1

$vectors
[,1] [,2]

[1,] 0.7071068 0.4472136

[2,] 0.7071068 0.8944272
> eigen(A)$values

[1] 2 1

> qr(A)$rank

[1] 2

> norm(A, "1"); norm(A, "i"); norm(A, "f")

[1] 5

[1] 4

[1] 3.741657

> sum(diag(A))

[1] 3
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Násobeńı matic
Pro násobeńı matic po složkách se použ́ıvá operátor *, nav́ıc muśı mı́t násobené matice
souhlasné rozměry. Pro součin matice a vektoru (v libovolném pořad́ı) se uplatňuje pra-
vidlo recycling rule, tzn. jednotlivé složky matice jsou po sloupćıch postupně násobeny
složkami vektoru.

> u <- c(1, 0, 0)

> v <- c(1, 0, 0, 0, 1)

> A <- matrix(c(1, 0, 0, 1, 0, 1, 1, 1, 0, 0, 1, 1), ncol=3)

> A
[,1] [,2] [,3]

[1,] 1 0 0

[2,] 0 1 0

[3,] 0 1 1

[4,] 1 1 1
> u * A použit́ı pravidla recycling rule

[,1] [,2] [,3]

[1,] 1 0 0

[2,] 0 0 0

[3,] 0 1 0

[4,] 1 0 0
> v * A použit́ı pravidla recycling rule. Výstup nav́ıc obsahuje varovné hlášeńı, ne-
bot’ počet prvk̊u matice A neńı dělitelný délkou vektoru v

[,1] [,2] [,3]

[1,] 1 0 0

[2,] 0 1 0

[3,] 0 0 1

[4,] 0 0 0
Warning message:

In v * A : longer object length is not a multiple of shorter object

length

Poznámka. Jazyk R nerozlǐsuje při násobeńı pomoćı operátoru * pořad́ı matice a vek-
toru. Na následuj́ıćıch př́ıkladech se můžeme přesvědčit, že operace A * u dává stejný
výstup jako u * A a operace A * v dává stejný výstup jako v * A.

> A * u použit́ı pravidla recycling rule
[,1] [,2] [,3]

[1,] 1 0 0

[2,] 0 0 0

[3,] 0 1 0

[4,] 1 0 0
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> A * v použit́ı pravidla recycling rule. Výstup nav́ıc obsahuje varovné hlášeńı, ne-
bot’ počet prvk̊u matice A neńı dělitelný délkou vektoru v

[,1] [,2] [,3]

[1,] 1 0 0

[2,] 0 1 0

[3,] 0 0 1

[4,] 0 0 0
Warning message:

In A * v : longer object length is not a multiple of shorter object

length

Pro maticové násobeńı se použ́ıvá operátor %*%, oba činitelé muśı být odpov́ıdaj́ıćıch
rozměr̊u (vnitřńı rozměry obou činitel̊u muśı být shodné).

> A %*% u
[,1]

[1,] 1

[2,] 0

[3,] 0

[4,] 1
> B <- matrix(c(0, 1, 1, 1, 0, 1, 0, 1), ncol=4)

[,1] [,2] [,3] [,4]

[1,] 0 1 0 0

[2,] 1 1 1 1
> A %*% B nesouhlasné rozměry matic
Error in A %*% B : non-conformable arguments

> B %*% A
[,1] [,2] [,3]

[1,] 0 1 0

[2,] 2 3 2

Zat́ımco v systému MATLAB operaci násobeńı po složkách zajǐst’uje operátor
.*, v jazyce R je to *. Operátor * v systému MATLAB označuje maticové
násobeńı, v jazyce R je to operátor %*%.

Řešeńı lineárńıch rovnic a inverze
Řešeńı lineárńıch rovnic je inverzńı operaćı k maticovému násobeńı

> b <- A %*% x
A znač́ı čtvercovou matici koeficient̊u pro lineárńı systém, b je vektor nebo matice pravé
strany. Vektor/matice x je řešeńım systému lineárńıch rovnic Ax = b, které źıskáme
př́ıkazem solve(A, b). V lineárńı algebře řešeńı formálně dostaneme x = A−1b, kde
A−1 znač́ı matici inverzńı k matici A. Matici inverzńı můžeme v R spoč́ıtat pomoćı
solve(A).
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> (A <- matrix(c(1, 3, 1, -1), 2))
[,1] [,2]

[1,] 1 1

[2,] 3 -1
> (b <- matrix(c(3, 1), 2))

[,1]

[1,] 3

[2,] 1
> solve(A, b)

[,1]

[1,] 1

[2,] 2
> solve(A) %*% b

[,1]

[1,] 1

[2,] 2

K řešeńı systémů lineárńıch rovnic slouž́ı i funkce backsolve():
backsolve(A, b, k, upper.tri, transpose) funkce pro řešeńı systémů lineárńıch
rovnic s trojúhelńıkovou matićı soustavy
A matice soustavy
b vektor/matice pravé strany
k počet sloupc̊u matice A a řádk̊u b, který má být při výpočtu použit
upper.tri systém s horńı trojúhelńıkovou matićı soustavy odpov́ıdá impli-

citńımu nastaveńı upper.tri=TRUE, nastaveńı upper.tri=FALSE

odpov́ıdá systému s dolńı trojúhelńıkovou matićı
transpose nastaveńım transpose=TRUE řeš́ıme systém A′x = b, implicitńı na-

staveńı transpose=FALSE

> backsolve(A, b, upper.tri=TRUE) řeš́ı systém lineárńıch rovnic

(
1 1 3
0 −1 1

)
[,1]

[1,] 4

[2,] -1

Poznámka. Stejně jako u maticového násobeńı, ani u funkćı solve a backsolve neńı ne-
zbytně nutné zadávat vektory pravé strany jako sloupcové vektory. Pro vstupńı řádkový
vektor bude výstupem řádkový vektor.
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Př́ıklady k procvičeńı

1. Vytvořte matici A1 s rozměry 3 x 5, jej́ıž prvńı řádek bude tvořen posloupnost́ı
-1, 1, 3, . . . , druhý řádek budou tvořit hodnoty 3 a posledńı řádek ekvidistantńı
posloupnost s minimálńı hodnotou -2 a maximálńı hodnotou 2.

2. Vytvořte matici A2 s rozměry 3 x 5, jej́ıž prvńı sloupec bude tvořen náhodnými
č́ısly z rovnoměrného rozložeńı na intervalu [0, 5], druhý a třet́ı sloupec bude tvořit
posloupnost s maximálńı hodnotou 3.5 a krokem 0.2 a posledńı dva sloupce budou
obsahovat hodnotu NA.

3. Vypǐste čtvrtý sloupec matice A1 jako řádkový i sloupcový vektor.

4. Vypǐste prvky prvńıho a druhého řádku a všech lichých sloupc̊u matice A1. Uložte
je do matice A3 a vhodným př́ıkazem zjistěte jej́ı rozměry, použijte i funkci pro
zjǐstěńı počtu řádk̊u a sloupc̊u zvlášt’.

5. Pomoćı funkćı rbind nebo cbind vhodně doplňte hodnotami 1 matici A3 na
čtvercovou matici a spoč́ıtejte jej́ı determinant, stopu a hodnost.

6. Byla pozorována kvalita ř́ıčńı vody. Z údaj̊u v následuj́ıćı tabulce

tvrdost vodivost koncentrace drasĺıku

lokalita 1
měřeńı 1 19.4 0.832 1.9
měřeńı 2 18.9 0.84 2.4

lokalita 2
měřeńı 1 21.2 0.826 2.1
měřeńı 2 17 0.479 1.6

vytvořte pole kvalita s rozměry 2 x 3 x 2, dimenze, řádky i sloupce pojmenujte.

7. Vytvořte matici A, vektory c a d:

A =

 1 0 1
−1 1 1

0 −1 1

, c =

 1
2
3

, d =

(
1
2

)
a matici B o rozměrech 3 x 6 s hodnotami rovnými 1.
a) Řešte systém lineárńıch rovnic Ax = c.
b) Vysvětlete výstupy př́ıkaz̊u A * B, A %*% B, A * c, A * d, c * A, d * A A

%*% c and A %*% d

c) Vhodnými př́ıkazy vytvořte k matici A dolńı trojúhelńıkovou matici C a pro

vektor pravé strany e =

 3
0
1

 řešte soustavu lineárńıch rovnic Cx = e s dolńı

trojúhelńıkovou matićı C.
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Řešeńı.

1. A1 <- matrix(c(seq(from=-1, by=2, length=5), rep(3,5), seq(from=-2,

to=2, length=5)), nrow=3, byrow=T)

2. A2 <- matrix(c(runif(n=3, min=0, max=5), seq(to=3.5, by=0.2,

length=6), rep(NA, 6)), nrow=3)

3. A1[,4]

A1[,4, drop=FALSE]

4. A3 <- A1[c(1,2), seq(from=1, by=2, to=ncol(A1))]

dim(A3), nrow(A3), ncol(A3)

5. A3 <- rbind(A3, rep(1, ncol(A3)))

det(A3), sum(diag(A3)), qr(A3)$rank

6. kvalita <- array(c(19.4, 18.9, 0.832, 0.84, 1.9, 2.4, 21.2, 17,

0.826, 0.479, 2.1, 1.6), dim=c(2, 3, 2), dimnames=list(c("mereni1",

"mereni2"), c("tvrdost", "vodivost", "koncentraceK"),

c("lokalita1", "lokalita2")))

7. A <- matrix(c(1, -1, 0, 0, 1, -1, 1, 1, 1), 3), B <- matrix(1,

nrow=3, ncol=6), c <- matrix(1:3, ncol=1), d <- matrix(1:2, ncol=1)

a) x <- solve(A, c)

b) A * B, A * c, A * d . . . násobeńı po složkách (neodpov́ıdaj́ıćı rozměry),
c * A, d * A . . . násobeńı po složkách, uplatněno pravidlo recycling rule
A %*% B, A %*% c, A %*% d . . . maticové násobeńı,
c) e <- matrix(c(3, 0, 1), nrow=3), backsolve(A, e, upper.tri=FALSE)

nebo pomoćı konstrukce dolńı trojúhelńıkové matice C:
C <- A, C[!lower.tri(A,1)] <- 0, solve(C, e)
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Kapitola 4

Datové tabulky a seznamy

Základńı informace

Datové tabulky jsou datové struktury slouž́ıćı k uchováńı souboru dat, které nacháźı
své uplatněńı předevš́ım při statistickém zpracováńı dat. Jedná se tabulku dat, jej́ıž
sloupce představuj́ı proměnné (pozorované znaky) často r̊uzných datových typ̊u a řádky
představuj́ı jednotlivá pozorováńı.
Daľśımi využ́ıvanými datovými strukturami jsou seznamy. Jedná se o objekty, které
dokáž́ı uchovávat množstv́ı informaćı r̊uzných datových struktur. Jejich využit́ı spoč́ıvá
ve smysluplném uspořádáńı např. vstupńıch a výstupńıch informaćı provedené statis-
tické analýzy do jediného objektu.
V této kapitole se nauč́ıme vytvářet datové tabulky a seznamy a pracovat s nimi.

Výstupy z výuky

Studenti

• se seznámı́ s datovými tabulkami a seznamy, znaj́ı rozd́ıly mezi nimi a umı́ je
vytvářet,

• umı́ několika zp̊usoby vytvářet podmnožiny datových tabulek a seznamů,

• dokáž́ı použ́ıvat funkce pro manipulaci s datovými tabulkami a seznamy.

4.1 Základńı př́ıkazy, tvorba datových tabulek a se-

znamů

Datová tabulka je 2-dimenzionálńı struktura, která slouž́ı k uchováńı souboru dat. Sou-
bor dat se skládá z množiny proměnných (sloupce), které jsou pozorovány na množstv́ı
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př́ıpad̊u (řádky). Jednotlivé sloupce mohou být r̊uzných datových typ̊u, ale prvky
každého sloupce muśı být stejného datového typu. Počet př́ıpad̊u muśı být pro každou
proměnnou stejný.

Seznam je nejobecněǰśı datová struktura v R, která seskupuje několik (r̊uzných) ob-
jekt̊u do objektu větš́ıho rozsahu. Jedná se o datovou strukturu skládaj́ıćı se z posloup-
nosti objekt̊u, kterým se ř́ıká složky. Každá složka může obsahovat objekt jakéhokoliv
datového typu. Seznam tedy může obsahovat vektory r̊uzných datových typ̊u a délek,
matice, pole, datové tabulky, funkce a/nebo jiné seznamy. Proto jsou seznamy vhodnými
výstupy nejr̊uzněǰśıch výpočt̊u.

Rovněž je d̊uležité si uvědomit, že datová tabulka je speciálńım př́ıpadem seznamu.
Nejedná se o nic jiného, než seznam, jehož složky jsou vektory stejné délky a od-
pov́ıdaj́ıćı pozice vyjadřuj́ı stejné př́ıpady (např. výskyt aut červené a modré barvy
během středy).

Datovou tabulku vytvoř́ıme př́ıkazem data.frame(). Pomoćı přǐrazeńı názv̊u vek-
tor̊um v seznamu argument̊u nazev 1=vektor 1, nazev 2=vektor 2, ... můžeme spe-
cifikovat názvy sloupc̊u (proměnných) a jejich hodnoty. Názvy sloupc̊u jsou nepovinné,
stač́ı zadat pouze hodnoty - v tomto př́ıpadě jsou názvy proměnných zvoleny implicitně
na základě pravidel stanovených jazykem R. Argument row.names (implicitńı nastaveńı
NULL př́ıpady č́ısluje) specifikuje názvy př́ıpad̊u. Argument check.names s implicitńım
nastaveńım TRUE kontroluje, zda jsou názvy proměnných syntakticky správné a zda se
neopakuj́ı, v př́ıpadě duplikaćı se stará o jejich přejmenováńı.

> data.frame(obor=factor(c(1, 0, 0, 1, 1), labels=c("OM", "MAEK")),

+ body=c(18, 13, 15, 20, 15))
obor body

1 MAEK 18

2 OM 13

3 OM 15

4 MAEK 20

5 MAEK 15
> data.frame(obor=factor(c(1, 0, 0, 1, 1), labels=c("OM", "MAEK")),

+ body=c(18, 13, 15, 20, 15), row.names=c("Petr", "Pavel", "Jirina",

+ "Adela", "Matej"))
obor body

Petr MAEK 18

Pavel OM 13

Jirina OM 15

Adela MAEK 20

Matej MAEK 15
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> data.frame(a=c(1,2), a=c(T,F), check.names=T)
a a.1

1 1 TRUE

2 2 FALSE
> data.frame(a=c(1,2), a=c(T,F), check.names=F)

a a

1 1 TRUE

2 2 FALSE

Funkce list() slouž́ı k vytvořeńı seznamu. Stejně jako u funkce data.frame()

mohou být i složky seznamu pojmenovány pomoćı argument̊u nazev 1=slozka 1,

nazev 2=slozka 2, ....

> (l <- list(barva=c("cervena", "modra", "bila"), data.frame(Petr=

+ sample(5, replace=T), Pavel=1:5, row.names=c("po","ut", "st", "ct",

+ "pa"))))

$barva

[1] "cervena" "modra" "bila"

[[3]]
Petr Pavel

po 1 1

ut 3 2

st 3 3

ct 5 4

pa 3 5

Funkce dim(), names() a contents() slouž́ı k výpisu vlastnost́ı datové tabulky.
Funkce dim() vypisuje rozměry datové tabulky, funkce names() zobrazuje názvy pro-
měnných. Funkce contents() vraćı vnitřńı strukturu datové tabulky. Funkce je obsa-
žena v baĺıčku Hmisc, který neńı ve standardńı distribuci, je třeba jej proto doinstalovat
př́ıkazem install.packages("Hmisc") a nač́ıst př́ıkazem library(Hmisc).

K výpisu vlastnost́ı seznamu můžeme použ́ıt funkci names(), která vraćı názvy
složek seznamu. Funkce dim() a contents() u seznamu použ́ıt nemůžeme, můžeme je
ovšem nahradit funkcemi length(), která vraćı počet složek seznamu, a str(), která
vypisuje vnitřńı strukturu seznamu.

4.2 Podmnožiny datových tabulek a seznamů

K vypsáńı podmnožiny seznamu můžeme použ́ıt jednoduchých [ ] nebo dvojitých [[ ]]

hranatých závorek. Jednoduchými závorkami uvád́ıme, které složky seznamu chceme
źıskat. Jestliže jednotlivé složky seznamu nejsou pojmenovány, požadovanou složku spe-
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cifikujeme jej́ım č́ıslem. K výpisu v́ıce složek můžeme použ́ıt operátoru : nebo funkce
c(). Jestliže jsou složky seznamu pojmenovány, požadované prvky specifikujeme jejich
názvy v uvozovkách. Podmnožina seznamu vytvořená pomoćı jednoduchých hranatých
závorek je opět typu seznam.

Naopak, př́ıkaz pro vytvářeńı podmnožiny pomoćı dvojitých hranatých závorek
vraćı objekt takového typu, jakým byl při definováńı seznamu. V tomto př́ıpadě je na
každou složku odkazováno jednotlivě, nepouž́ıvá se proto operátor : ani funkce c().
Stejně jako u jednoduchých hranatých závorek, na každou složku je odkazováno jej́ım
č́ıslem, má-li požadovaná složka název, můžeme na ni odkazovat jej́ım názvem v uvo-
zovkách nebo můžeme použ́ıt operátoru $.

> l <- list(barva=c("cervena", "modra", "bila"), matrix(1:4, 2),

+ data.frame(Petr=sample(5, replace=T), Pavel=1:5, row.names=c("po",

+ "ut", "st", "ct", "pa")))

> l["barva"]

$barva

[1] "cervena" "modra" "bila"

> typeof(l["barva"]) př́ıkaz typeof() urč́ı typ svého argumentu
[1] "list"

> l[[2]]
[,1] [,2]

[1,] 1 3

[2,] 2 4
> typeof(l[[2]])

[1] "integer"

> typeof(l$barva)

[1] "character"

Protože datové tabulky jsou speciálńım př́ıpadem seznamů, řádky a/nebo sloupce
tabulky dat mohou být źıskány pomoćı [ ], [[ ]] a/nebo operátoru $. Datové tabulky
mohou být považovány i za zobecněné matice, k vytvořeńı podmnožiny můžeme proto
použ́ıt [,].

> tab <- data.frame(cervena=c(1,2,3), modra=c(3,6,0), bila=c(2,5,1),

+ row.names=c("pondeli", "utery", "streda"))

> tab[1]
cervena

pondeli 1

utery 2

streda 3
> typeof(tab[1])

[1] "list"
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> tab[[1]] ekvivalentńı př́ıkaz př́ıkaz̊um tab[["cervena"]] a tab$cervena

[1] 1 2 3

> typeof(tab[[1]]); typeof(tab[["cervena"]]; typeof(tab$cervena))

[1] "double"

[1] "double"

[1] "double"

> tab["utery", "bila"]

[1] 5

K výběru podmnožiny datové tabulky slouž́ı i př́ıkaz subset(x, ). Argument x

specifikuje název datové tabulky, z ńıž podmnožinu vyb́ıráme. Argument subset spe-
cifikuje řádky vyhovuj́ıćı dané podmı́nce, přičemž hodnoty NA jsou brány jako FALSE.
Argument select specifikuje sloupce, které chceme vypsat, můžeme použ́ıt funkce c(),
operátoru : i operátoru - pro vynecháńı složek.

> subset(tab, subset=cervena==3, select=c(modra, bila))
modra bila

streda 0 1

Funkce subset() vždy vraćı tabulku dat, i když má jen jeden řádek nebo sloupec.
K tomu, aby vrátila jen jednoduchý vektor, muśıme za vlastńı definici podmnožiny
datové tabulky použ́ıt operátor $, za ńımž následuje název sloupce:

> tab["pondeli", "cervena"]

[1] 1

> subset(tab, subset=cervena==1, select=cervena)
cervena

pondeli 1
> subset(tab, subset=cervena==1, select=cervena)$cervena

[1] 1

4.3 Funkce pro manipulaci s datovými tabulkami a

seznamy

Přidáńı daľśıch sloupc̊u
Prvńım zp̊usobem, jak do datové tabulky přidat nový sloupec s hodnotami, je př́ıkaz

tvaru

datová tabulka$nazev noveho sloupce <- hodnoty.

Druhým zp̊usobem je provést přǐrazeńı pomoćı funkce data.frame() (bez přǐrazeńı
zobrazuje nové hodnoty pouze dočasně).
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> (knihy <- data.frame(nazev=c("Dekameron", "Maj", "Temno", "Bidnici",

+ "Babicka"), autor=c("Boccaccio", "Macha", "Jirasek", "Hugo",

+ "Nemcova")))
nazev autor

1 Dekameron Boccaccio

2 Maj Macha

3 Temno Jirasek

4 Bidnici Hugo

5 Babicka Nemcova
> knihy$pocet <- c(3, 6, 4, 3, 5)

> knihy
nazev autor pocet

1 Dekameron Boccaccio 3

2 Maj Macha 6

3 Temno Jirasek 4

4 Bidnici Hugo 3

5 Babicka Nemcova 5
> (knihy <- data.frame(knihy, k dispozici=c(F, F, T, F, T)))

nazev autor pocet k dispozici

1 Dekameron Boccaccio 3 FALSE

2 Maj Macha 6 FALSE

3 Temno Jirasek 4 TRUE

4 Bidnici Hugo 3 FALSE

5 Babicka Nemcova 5 TRUE

Funkce transform() pouze tiskne aktuálńı datovou tabulku, nepřidává nastálo no-
vou proměnnou (v opačném př́ıpadě muśıme provést přǐrazeńı).

> transform(knihy, rok=c(1971, 1997, 1983, 2003, 1992)) přidá sloupec
rok s danými hodnotami, proměnná knihy ovšem z̊ustane nezměněna

nazev autor pocet k dispozici rok

1 Dekameron Boccaccio 3 FALSE 1971

2 Maj Macha 6 FALSE 1997

3 Temno Jirasek 4 TRUE 1983

4 Bidnici Hugo 3 FALSE 2003

5 Babicka Nemcova 5 TRUE 1992

Pro přidáńı daľśıch složek do seznamu lze pomoćı operátoru přǐrazeńı, a to jednou
z možnost́ı

seznam$nova slozka <- objekt

seznam[["nova slozka"]] <- objekt

seznam["nova slozka"] <- objekt.
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> (vyzkum <- list(n=28, lokalita="Brno"))

$n

[1] 28

$lokalita

[1] "Brno"

> vyzkum$obdobi <- 2004:2012

> vyzkum[["jakost"]] <- factor(c(0, 1, 1, 1, 0, 0, 1, 0, 1, 1), labels=

+ c("1", "2"))

> vyzkum

$n

[1] 28

$lokalita

[1] "Brno"

$obdobi

[1] 2004 2005 2006 2007 2008 2009 2010 2011 2012

$jakost

[1] 1 2 2 2 1 1 2 1 2 2

Levels: 1 2

Odstraňováńı řádk̊u a sloupc̊u
Každý sloupec můžeme z datové tabulky odstranit použit́ım operátoru $ nebo [ ]

nastaveńım na hodnotu NULL. Daľśım zp̊usobem je použit́ı operátoru [ , ] k výběru
podmnožiny datové tabulky a přepsáńı p̊uvodńı proměnné.

> knihy
nazev autor pocet k dispozici

1 Dekameron Boccaccio 3 FALSE

2 Maj Macha 6 FALSE

3 Temno Jirasek 4 TRUE

4 Bidnici Hugo 3 FALSE

5 Babicka Nemcova 5 TRUE
> knihy$pocet <- NULL analogický př́ıkaz: knihy["pocet"] <- NULL. O tom, že
sloupce byly opravdu odstraněny, se můžeme přesvědčit výpisem názv̊u sloupc̊u (funkce
names())
> names(knihy)

[1] "nazev" "autor" "k dispozici"
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> (knihy <- knihy[1:3, c("nazev", "k dispozici")])

nazev k dispozici

1 Dekameron FALSE

2 Maj FALSE

3 Temno TRUE

Slučováńı
Ke sloučeńı datových tabulek můžeme použ́ıt funkce cbind() nebo rbind(), které

je slouč́ı po sloupćıch nebo řádćıch. Při použit́ı funkce cbind() muśı mı́t přidávané
sloupce stejný počet řádk̊u jako v již existuj́ıćı datové tabulce. Rovněž je vhodné se
přesvědčit, že přidávané sloupce maj́ı stejné pořad́ı řádk̊u. Při použit́ı funkce rbind()

je třeba dodržovat stejný počet sloupc̊u a jejich shodné názvy.

Poznámka. Při spojováńı datové tabulky a vektoru s r̊uznými rozměry docháźı k chy-
bovému hlášeńı, ovšem při spojováńı matice a vektoru o r̊uzných rozměrech je operace
provedena použit́ım pravidla recycling rule a doplněna o varovné hlášeńı.

> zbozi1 <- data.frame(ID=c("X1", "X2", "X3"), cena=c(99, 109, 99),

+ sklad=c(T, T, F))
ID cena sklad

1 X1 99 TRUE

2 X2 109 TRUE

3 X3 99 FALSE
> zbozi2 <- data.frame(ID=c("X4", "X5"), cena=c(99, 89), sklad=c(F, T))

ID cena sklad

1 X4 99 FALSE

2 X5 89 TRUE
> rbind(zbozi1, zbozi2)

ID cena sklad

1 X1 99 TRUE

2 X2 109 TRUE

3 X3 99 FALSE

4 X4 99 FALSE

5 X5 89 TRUE
> zbozi3 <- data.frame(ID=c("X4", "X5"), sklad=c(F, T), cena=c(99, 89))

ID sklad cena

1 X4 FALSE 99

2 X5 TRUE 89
> rbind(zbozi1, zbozi3) tabulky maj́ı odlǐsné názvy sloupc̊u, nelze je spojit
Error in match.names(clabs, names(xi)) :

names do not match previous names
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> zbozi4 <- data.frame(ID=c("X1", "X2", "X4"), barva=c("cerna", "bila",

+ "bila"))
ID barva

1 X1 cerna

2 X2 bila

3 X4 bila
> cbind(zbozi1, zbozi4) tabulky maj́ı stejný počet řádk̊u, dojde proto k jejich
spojeńı (ovšem bez ohledu na to, že je v každé z nich uveden sloupec ID s r̊uznými
hodnotami. Pokud bychom chtěli tomu chováńı předej́ıt, muśıme použ́ıt funkci
merge().)

ID cena sklad ID barva

1 X1 99 TRUE X1 cerna

2 X2 109 TRUE X2 bila

3 X3 99 FALSE X4 bila

Alternativou k funkćım cbind() a rbind() může být již zmı́něná funkce merge().
merge(x, y, by, by.x, by.y, all, all.x, all.y) slouč́ı datové tabulky x a y

by, by.x, by.y specifikuj́ı ty názvy sloupc̊u, podle kterých maj́ı být tabulky
sloučeny. V př́ıpadě stejného názvu sloupc̊u použijeme argument by. Jsou-li názvy
sloupc̊u ke sloučeńı r̊uzné, specifikujeme je pomoćı argument̊u by.x a by.y. V př́ıpadě
v́ıce podmı́nek na spojeńı podmı́nky uvád́ıme ve formě vektoru typu řetězec.

all, all.x a all.y specifikace těch řádk̊u, které se maj́ı objevit na výstupu.
Implicitńı nastaveńı all=FALSE vraćı pouze řádky z pr̊uniku obou tabulek, all=TRUE
vraćı řádky ze sjednoceńı obou tabulek. all.x=TRUE vraćı všechny řádky tabulky x,
analogicky je tomu u all.y=TRUE

Poznámka. Při použit́ı některého z argument̊u all=TRUE, all.x=TRUE nebo all.y=TRUE
maj́ı

”
volná“ mı́sta, která vznikla spojeńım, hodnotu NA.

> (tab1 <- data.frame(auto=c("fiat", "opel", "skoda", "bmw"), barva=

+ c("seda", "cervena", "cerna", "modra"), rok=c(2003, 1999, 2008,

+ 2004)))
auto barva rok

1 fiat seda 2003

2 opel cervena 1999

3 skoda cerna 2008

4 bmw modra 2004
> (tab2 <- data.frame(znacka=c("saab", "bmw", "audi"), majitel=c("muz",

+ "zena", "zena")))
znacka majitel

1 saab muz

2 bmw zena

3 audi zena
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KAPITOLA 4. DATOVÉ TABULKY A SEZNAMY

> merge(tab1, tab2) protože tabulky neobsahuj́ı stejný název sloupce, podle
kterého by se sloučeńı mělo ř́ıdit, R vytvoř́ı kartézský součin obou tabulek (tzn. ke
každému řádku tab1 se připoj́ı každý řádek tab2)

auto barva rok znacka majitel

1 fiat seda 2003 saab muz

2 opel cervena 1999 saab muz

3 skoda cerna 2008 saab muz

4 bmw modra 2004 saab muz

5 fiat seda 2003 bmw zena

6 opel cervena 1999 bmw zena

7 skoda cerna 2008 bmw zena

8 bmw modra 2004 bmw zena

9 fiat seda 2003 audi zena

10 opel cervena 1999 audi zena

11 skoda cerna 2008 audi zena

12 bmw modra 2004 audi zena
> merge(tab1, tab2, by.x="auto", by.y="znacka") spojeńı na základě výskytu
bmw v obou sloupćıch auto i znacka

auto barva rok majitel

1 bmw modra 2004 zena
> merge(tab1, tab2, by.x="auto", by.y="znacka", all.x=T) argument
all.x=T zajistil, aby výstup obsahoval všechny hodnoty z tab1

auto barva rok majitel

1 bmw modra 2004 zena

2 fiat seda 2003 <NA>

3 opel cervena 1999 <NA>

4 skoda cerna 2008 <NA>

Řazeńı
K seřazeńı dat v datové tabulce se použ́ıvá funkce order(), která vraćı vektor in-

dex̊u vzestupně (implicitńı nastaveńı decrerasing=FALSE) nebo sestupně (nastaveńı
decreasing=TRUE) uspořádaných prvk̊u. Vı́ce informaćı o funkci order je uvedeno
v odstavci 5.4.

> knihy
nazev autor pocet k dispozici

1 Dekameron Boccaccio 3 FALSE

2 Maj Macha 6 FALSE

3 Temno Jirasek 4 TRUE

4 Bidnici Hugo 3 FALSE

5 Babicka Nemcova 5 TRUE

137



KAPITOLA 4. DATOVÉ TABULKY A SEZNAMY

> knihy[order(knihy$k dispozici, knihy$nazev),] seřazeńı podle sloupce
k dispozici, v př́ıpadě v́ıce stejných hodnot řazeńı podle sloupce nazev

nazev autor pocet k dispozici

4 Bidnici Hugo 3 FALSE

1 Dekameron Boccaccio 3 FALSE

2 Maj Macha 6 FALSE

5 Babicka Nemcova 5 TRUE

3 Temno Jirasek 4 TRUE

Pokud některý ze sloupc̊u tabulky tvoř́ı numerický vektor, pro sestupné uspořádáńı
této proměnné můžeme na mı́sto argumentu decreasing=TRUE použ́ıt operátoru -.
V př́ıpadě nejednoznačných podmı́nek na seřazeńı (řádky se stejnými hodnotami pro
seřazeńı) dostává na výpisu přednost řádek s nižš́ım pořadovým č́ıslem, u názv̊u řádk̊u
se postupuje podle abecedńıho uspořádáńı.

> knihy[order(knihy$k dispozici, -knihy$pocet),] vzestupné seřazeńı pro-
měnné k dispozici a sestupné seřazeńı proměnné knihy

nazev autor pocet k dispozici

2 Maj Macha 6 FALSE

1 Dekameron Boccaccio 3 FALSE

4 Bidnici Hugo 3 FALSE

5 Babicka Nemcova 5 TRUE

3 Temno Jirasek 4 TRUE

Př́ıklady k procvičeńı

1. Následuj́ıćı tabulka popisuje 10 pacient̊u s podezřeńım na krátkozrakost (myo-
pii). Tabulku přepǐste do systému R jako datovou tabulku myopie1, hodnoty pro
pohlav́ı a myopii rodič̊u zadávejte jako faktor.

ID pohlav́ı délka studie myopie rodič̊u
101 muž 3 ano
102 žena 5 ne
103 žena 2 ne
104 muž 4 ano
105 žena 4 ano
106 muž 3 ano
107 muž 2 ne
108 muž 1 ano
109 žena 7 ano
110 muž 5 ano
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2. Přidáńım nového sloupce pro délku očńı bulvy delka s hodnotami 20.4, 22.7,
21.3, 24.56, 20.9, 21.8, 23.5, 23.9, 19.9, 22.6 vytvořte z tabulky myopie1 tabulku
myopie.
a) Z tabulky myopie odstraňte všechny sudé řádky.
b) Z tabulky myopie odstraňte sloupec ”myopie rodič̊u”. Zjistěte rozměry nově
vzniklé tabulky.
c) Vypǐste ”ID”a ”pohlav́ı”pacient̊u z tabulky myopie1 s délkou studie větš́ı než
čtyři roky.
d) Vypǐste tabulku myopie seřazenou podle délky studie pacient̊u, popř. dle délky
očńı bulvy.

3. Následuj́ıćı tabulku definujte jako datovou tabulku myopie2:

ID barva oč́ı věk
101 modrá 8
102 zelená 11
103 hnědá 9
104 hnědá 14
105 modrá 9
106 šedá 13
107 zelená 9
108 modrá 8
109 modrá 12
110 hnědá 13

Poté slučte tabulky myopie1 a myopie2 na základě ”ID”. Vyzkoušejte sloučeńı
i pomoćı funkce cbind.

4. Vytvořte seznam CR se složkami
”země”: Čechy, Morava, Slezsko,
”města”: Praha, Brno, Ostrava, Plzeň, Olomouc,
”pohoř́ı”:

pohoř́ı vrchol nadmořská výška
Krkonoše Sněžka 1602
Jeseńıky Praděd 1492
Šumava Plechý 1378
Beskydy Lysá hora 1323

Krušné hory Kĺınovec 1244

a) Vypǐste druhou složku seznamu CR ve formě seznamu. Rovněž zjistěte, jakého
je tato složka datového typu.
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b) Přidejte novou složku ”sousedé”: Německo, Rakousko, Slovensko, Polsko.
c) Smažte složku ”země”a pomoćı vhodné funkce zjistěte počet složek seznamu
CR.
d) Spoč́ıtejte pr̊uměrnou nadmořskou výšku pro uvedené vrcholy. (Pro výpočet
pr̊uměru použijte funkci mean()).

Řešeńı.

1. myopie1 <- data.frame(ID=101:110, pohlavi=factor(c(0, 1, 1, 0, 1,

0, 0, 0, 1, 0), labels=c("muz", "zena"), levels=c(0, 1)),

delka.studie=c(3, 5, 2, 4, 4, 3, 2, 1, 7, 5),

myopie.rodic=factor(c(1, 0, 0, 1, 1, 1, 0, 1, 1, 1),

labels=c("ne", "ano"), levels=c(0, 1)))

2. myopie <- data.frame(myopie1, delka=c(20.4, 22.7, 21.3, 24.56,

20.9, 21.8, 23.5, 23.9, 19.9, 22.6))

a) myopie <- myopie[-seq(from=2, by=2, to=nrow(myopie)),]

b) myopie[,"myopie.rodic"] <- NULL, dim(myopie)
c) subset(myopie1, select=c(ID, pohlavi), subset=delka.studie>4)

d) myopie[order(myopie$delka.studie, myopie$delka),]

3. myopie2 <- data.frame(ID=101:110, barva.oci=c("modra", "zelena",

"hneda", "hneda", "modra", "seda", "zelena", "modra", "modra",

"hneda"), vek=c(8, 11, 9, 14, 9, 13, 9, 8, 12, 13))

merge(myopie1, myopie2, by="ID")

cbind(myopie1, myopie2)

4. CR <- list(zeme=c("Cechy", "Morava", "Slezsko"), mesta=c("Praha",

"Brno", "Ostrava", "Plzen", "Olomouc"), pohori=data.frame(pohori=

c("Krkonose", "Jeseniky", "Sumava", "Beskydy", "Krusne hory"),

vrchol=c("Snezka", "Praded", "Plechy", "Lysa hora", "Klinovec"),

nadm.vyska=c(1602, 1492, 1378, 1323, 1244)))

a) CR[2] nebo CR["mesta"], typeof(CR[2])
CR[[2]] nebo CR[["mesta"]] nebo CR$mesta, typeof(CR[[2]])
b) CR$sousede <- c("Nemecko", "Rakousko", "Slovensko", "Polsko") nebo
CR[["sousede"]] <- c("Nemecko", "Rakousko", "Slovensko", "Polsko")

c) CR$zeme <- NULL nebo CR["zeme"] <- NULL

length(CR)

d) mean((CR$pohori))[,3]
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Kapitola 5

Konstanty, operátory a
matematické výpočty

Základńı informace

Kapitola je věnována aritmetickým, porovnávaćım, logickým a množinovým operátor̊um,
jejichž znalost je základńım předpokladem programovaćıch schopnost́ı. Dále jsou uve-
deny matematické funkce, základńı statistické funkce a funkce pro zaokrouhlováńı.
Někdy je pro zjednodušeńı práce velmi výhodné pracovat s vestavěnými konstantami,
které jsou uvedeny na konci kapitoly.

Výstupy z výuky

Studenti

• ovládaj́ı aritmetické operátory, zopakuj́ı si rozd́ıly mezi maticovým násobeńım a
násobeńım po složkách,

• použ́ıvaj́ı porovnávaćı a logické operátory,

• se seznámı́ s množinovými operátory,

• znaj́ı a umı́ vhodně použ́ıt matematické funkce,

• ovládaj́ı funkce pro zaokrouhlováńı a dokáž́ı využ́ıvat zabudovaných konstant.
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5.1 Aritmetické operátory

+ sč́ıtáńı
- odč́ıtáńı
* násobeńı
/ děleńı
^ umocňováńı
%*% maticové násobeńı
%% zbytek po celoč́ıselném děleńı (modulo)
%/% celá část z celoč́ıselného děleńı
t() transpozice matice nebo datové tabulky

Transpozićı (řádkového) vektoru je v jazyce R stále (řádkový) vektor. Trans-
pozićı řádkového vektoru je v systému MATLAB sloupcový vektor.

> a <- c(3, 5, 7, 8); b <- c(1, 2, 3); c <- c(4, 1, 8)

> a + b

[1] 4 7 10 9

Warning message:

In a + b : longer object length is not a multiple of shorter object

length

Protože vektor b je menš́ı délky než vektor a, je potřeba jeho délku zvětšit o jednu po-
zici. (Pravidlo pro postupné opakováńı složek do požadované délky se nazývá recycling
rule.) Posledńı složka výstupńıho vektoru je tedy součtem 4. složky vektoru a a 1.
složky vektoru b. Na stejném principu funguj́ı i všechny ostatńı aritmetické operátory.

MATLAB by v tomto př́ıpadě hlásil chybu a výpočet by neprovedl, protože
sč́ıtance nejsou stejné dimenze.

> "a"+ "b"

Error in "a"+ "b": non-numeric argument to binary operator

Binárńı operátory můžeme použ́ıt pouze na numerické argumenty. Na rozd́ıl od
R, v MATLABu je můžeme použ́ıt i na textové řetězce, které jsou převedeny
na odpov́ıdaj́ıćı kód v ASCII tabulce a následně provedena př́ıslušná operace.

142



KAPITOLA 5. KONSTANTY, OPERÁTORY A MATEMATICKÉ VÝPOČTY

> b <- 1:3

> c <- c(4, 1, 8)

> b / c

[1] 0.250 2.000 0.375

> b %/% c

[1] 0 2 0

> b %% c

[1] 1 0 3

5.2 Porovnávaćı a logické operátory

Porovnávaćı operátory slouž́ı k porovnáváńı odpov́ıdaj́ıćıch si složek vektor̊u. Na výstupu
dostáváme vektor logických hodnot TRUE a FALSE délky nejdeľśıho vektoru na vstupu.
Hodnoty TRUE obsazuj́ı ty pozice, které splňuj́ı danou podmı́nku, ostatńı pozice jsou
vyplněny hodnotami FALSE.

== rovno
!= neńı rovno

<, <= menš́ı, menš́ı nebo rovno
>, >= větš́ı, větš́ı nebo rovno

& logické a
| logické nebo
! negace

> a <- c(3, 5, 7)

> b <- c(1, 2, 3)

> c <- 1:4

> a <= b

[1] FALSE FALSE FALSE

> a >= 3 & b <= 2

[1] TRUE TRUE FALSE

> !(a == 5 | a == b)

[1] TRUE FALSE TRUE

Při porovnáńı vektor̊u o r̊uzných délkách je uplatněno pravidlo recycling rule:

> b == c

[1] TRUE TRUE TRUE FALSE

Warning message:

In b == c : longer object length is not a multiple of shorter object

length
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5.3 Množinové operátory

all(relace) testuje, zda jsou všechny složky relace pravdivé
any(relace) testuje, zda je alespoň jedna složka relace pravdivá
which(relace) vraćı pořad́ı těch složek relace, které jsou pravdivé

(popř. které splňuj́ı danou podmı́nku). V př́ıpadě
poĺı můžeme použ́ıt argument arr.ind=T pro výpis
hodnot v podobě č́ısel řádk̊u a sloupc̊u, popř.
daľśıch dimenźı

x %in% y, is.element(x, y) testuje, zda je x podmnožinou množiny y, vraćı lo-
gické hodnoty

intersect(x, y) pr̊unik množin x a y

union(x, y) sjednoceńı množin x a y

setdiff(x, y) rozd́ıl množin, vraćı ty prvky vektoru x, které
nejsou obsaženy v y

> x <- 1:10

> y <- 2:9

> z <- -5:5

> all(z) testuje, zda nabývaj́ı všechny prvky vektoru z hodnoty TRUE, v př́ıpadě
numerických vektor̊u odpov́ıdaj́ı hodnotě TRUE nenulové hodnoty
[1] FALSE

> all(z > -10) testuje, zda jsou všechny prvky vektoru z větš́ı než −10
[1] TRUE

> any(z)

[1] TRUE

> all(y) >= x[5]

[1] FALSE

> any(x) == any(y)

[1] TRUE

> m <- matrix(2:10, c(3, 3))
[,1] [,2] [,3]

[1,] 2 5 8

[2,] 3 6 9

[3,] 4 7 10
> which(m > 8 | m == 3)

[1] 2 8 9

> which(m > 8 | m == 3, arr.ind=T)
row col

[1,] 2 1

[2,] 2 3

[3,] 3 3
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> x %in% y

[1] FALSE TRUE TRUE TRUE TRUE TRUE TRUE TRUE TRUE

[10] FALSE

> is.element(y, x)

[1] TRUE TRUE TRUE TRUE TRUE TRUE TRUE TRUE

> union(x[1:5], y[c(7, 8)])

[1] 1 2 3 4 5 8 9

> intersect(x[1:5], y[c(1, 2, 3)])

[1] 2 3 4

> setdiff(x, y)

[1] 1 10

> setdiff(y, x)

integer(0)

5.4 Matematické funkce

Předpokládejme, že objekt x je numerický, komplexńı, logický vektor nebo pole, ope-
race jsou prováděny po složkách.

abs(x), sqrt(x) absolutńı hodnota a druhá odmocnina objektu x

sign(x) signum objektu x

Logaritmické a exponenciálńı funkce:
log(x), log10(x), log2(x) přirozený logaritmus, logaritmus se základem 10 a 2
log(x, base) logaritmus se základem base

exp(x) exponenciálńı funkce x

Trigonometrické a hyperbolické funkce:
cos(x), sin(x), tan(x), cosh(x), sinh(x), tanh(x)

Inverzńı trigonometrické a hyperbolické funkce:
acos(x), asin(x), atan(x), acosh(x), asinh(x), atanh(x)

gamma(x) gamma funkce pro kladná reálná č́ısla x

choose(n, k) kombinačńı č́ıslo
(
n
k

)
pro každé reálné n a přirozené č́ıslo k, n≥k

factorial(x) faktoriál x

max(x), min(x), sum(x), prod(x) vraćı maximálńı a minimálńı prvek, součet a
součin prvk̊u argumentu x. Pro objekty typu matice nebo pole uvedené funkce vraćı na
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výstup jedinou hodnotu ze všech prvk̊u. Pokud budeme požadovat provedeńı operaćı
po složkách, je potřeba použ́ıt některou z funkćı skupiny apply(), v́ıce o nich naleznete
v odstavci 8.5.

MATLAB aplikuje funkce max(), min(), sum() a prod() na matice nikoliv po
prvćıch, ale po sloupćıch.

cummax(x), cummin(x), cumsum(x), cumprod(x) vraćı vektor, jehož složkami jsou
maximum, minimum, kumulativńı součet a součin prvk̊u argumentu x

> a <- c(1, 2, 3, 5, 8, 2, 4, 1, 2, 2)

> cumsum(a)

[1] 1 3 6 11 19 21 25 26 28 30

> cummin(a) vždy nerostoućı posloupnost prvk̊u
[1] 1 1 1 1 1 1 1 1 1 1

> cummax(a) vždy neklesaj́ıćı posloupnost prvk̊u
[1] 1 2 3 5 8 8 8 8 8 8

range(x) vektor obsahuj́ıćı minimum a maximum objektu x, range(x) je ekviva-
lentńı př́ıkazu c(min(x), max(x))

mean(x), median(x) pr̊uměr a medián objektu x

sd(x) směrodatná odchylka objektu x, v př́ıpadě, že x je matice, sd(x) vraćı smě-
rodatnou odchylku jej́ıch sloupc̊u
var(x), cov(x, y), cor(x, y) rozptyl x, kovariance a korelace vektor̊u x, y, v př́ı-
padě, že x, y jsou matice, kovariance a korelace jsou poč́ıtány mezi sloupci x a y

quantile(x) generická funkce, vraćı minimum, dolńı kvartil, medián, horńı kvartil
a maximum objektu x

> c(min(a), max(a)); range(a)

[1] 1 8

[1] 1 8

> mean(a)

[1] 3

> var(a)

[1] 4.666667

> quantile(a)
0 % 25 % 50 % 75 % 100 %

1.00 2.00 2.00 3.75 8.00

pmax(x, y, z, ...), pmin(x, y, z, ...) objekt maximálńıch/minimálńıch prvk̊u
na odpov́ıdaj́ıćıch si pozićıch

> b <- 1:10

> pmin(a, b)

[1] 1 2 3 4 5 2 4 1 2 2
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Pro pole o 2 a v́ıce dimenźıch s numerickými, komplexńımi nebo logickými hodno-
tami nebo pro datové tabulky můžeme použ́ıt následuj́ıćı funkce, které vraćı pr̊uměry,
součty a rozptyly po sloupćıch či řádćıch:
colMeans(x), colSums(x), colVars(x)

rowMeans(x), rowSums(x), rowVars(x)

> (e <- matrix(a,5))
[,1] [,2]

[1,] 1 2

[2,] 2 4

[3,] 3 1

[4,] 5 2

[5,] 8 2
> rowSums(e)

[1] 3 6 4 7 10

sort(x, decreasing, na.last, index.return) seřazeńı objektu x

decreasing=F vzestupné pořad́ı (implicitńı nastaveńı), decreasing=T sestupné
pořad́ı,

na.last=NA zajǐst’uje vynecháńı hodnot NA (implicitńı nastaveńı), na.last=T za-
jǐst’uje, aby hodnoty NA byly řazeny na konec, na.last=F řad́ı hodnoty NA na začátek

index.return=T vyṕı̌se i p̊uvodńı pořad́ı hodnot

order(x, decreasing, na.last) vyṕı̌se indexy seřazených hodnot
na.last=T řad́ı hodnoty NA na konec (implicitńı nastaveńı), na.last=F řad́ı hod-

noty NA na začátek, na.last=NA hodnoty NA vynechává

rank(x, na.last, ties.method) vyṕı̌se pořad́ı jednotlivých hodnot odpov́ıdaj́ıćıch
vzestupně seřazenému vektoru x

na.last stejně jako u funkce order

ties.method nabývá jedné z hodnot c("first", "random", "average", "max",

"min") a použ́ıvá se pro specifikaci řazeńı shodných hodnot. "first" řad́ı vzestupně
podle pozice v řadě, "random" řad́ı náhodně, "average" podle pr̊uměrného pořad́ı (im-
plicitńı nastaveńı) a "min"/"max" podle hodnoty minimálńıho/maximálńıho pořad́ı

rev(x) převráceńı pořad́ı hodnot vektoru

> a <- c(1, 2, 3, 5, 8, NA, 2, 4, 1, 2, 2)

> sort(a) hodnoty NA automaticky vynechává
[1] 1 1 2 2 2 2 3 4 5 8

> sort(a, na.last=F)

[1] NA 1 1 2 2 2 2 3 4 5 8
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> order(a)

[1] 1 9 2 7 10 11 3 8 4 5 6

> rank(a, ties.method="average")

[1] 1.5 4.5 7.0 9.0 10.0 11.0 4.5 8.0 1.5 4.5 4.5

> rev(a)

[1] 2 2 1 4 2 NA 8 5 3 2 1

5.5 Zaokrouhlováńı

Pro zaokrouhlováńı se použ́ıvaj́ı následuj́ıćı funkce:
ceiling() zaokrouhleńı k nejbližš́ımu větš́ımu celému č́ıslu
floor() zaokrouhleńı k nejbližš́ımu menš́ımu celému č́ıslu
trunc() zaokrouhleńı směrem k 0, celá část daného č́ısla
round() zaokrouhleńı k nejbližš́ımu celému č́ıslu, parametrem digits=pocet

voĺıme počet desetinných mı́st, na jaký má být zaokrouhleńı provedeno
(implicitně digits=0)

signif() zaokrouhleńı na určitý počet platných cifer (parametr digits, zbytek
doplńı nulami)

> ceiling(c(3.468575, -3.468575))

[1] 4 -3

> floor(c(3.468575, -3.468575))

[1] 3 -4

> trunc(c(3.468575, -3.468575))

[1] 3 -3

> round(c(3.468575, -3.468575), digits=3)

[1] 3.469 -3.469

> signif(c(3.468575,-3.468575), digits=3)

[1] 3.47 -3.47

Poznámka. Zaokrouhlováńı č́ısla 5: pokud následuj́ı za č́ıslićı 5 jen nuly, č́ıslo je zao-
krouhleno směrem dol̊u, pokud následuje jakákoliv jiná č́ıslice, č́ıslo je zaokrouhleno
nahoru.

> round(7.125, digits=2)

[1] 7.12

> round(7.12501, digits=2)

[1] 7.13
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5.6 Konstanty

Jazyk R má zabudovány konstanty, z nichž nejpouž́ıvaněǰśı jsou:
pi . . . π, Ludolfovo č́ıslo
exp(1) . . . e, základ přirozeného logaritmu, Eulerovo č́ıslo
i . . . i, komplexńı jednotka
.Last.value . . . proměnná obsahuj́ıćı posledńı hodnotu, jež nebyla přǐrazena do žádné
proměnné explicitně
letters . . . malá ṕısmena abecedy
LETTERS . . . velká ṕısmena abecedy
month.name . . . anglické názvy měśıc̊u
month.abb . . . zkratky anglických názv̊u měśıc̊u

> 3

[1] 3

> .Last.value

[1] 3

> LETTERS[9:14]

[1] "I" "J" "K" "L" "M" "N"

> month.name[c(7, 10)]

[1] "July" "October"

Př́ıklady k procvičeńı

1. Definujte vektory v1 s hodnotami 1, 3, 4, v2 jako posloupnost délky 5 s počátečńı
hodnotou -6 a krokem 2 a v3 s prvńımi třemi složkami vektoru v2.
a) Proved’te součet, rozd́ıl, součin a pod́ıl vektor̊u v1 a v3.
b) Vysvětlete výsledky, pokud operace z předchoźıho zadáńı použijete na vektory
v1 a v2.
c) Uved’te celou část a zbytek po děleńı vektoru v1 vektorem v3.
d) Uved’te pozice vektoru v1, jejichž hodnoty jsou r̊uzné od hodnot vektoru v3

na odpov́ıdaj́ıćıch si pozićıch.
e) Uved’te počet prvk̊u vektoru v2, jehož hodnoty jsou menš́ı než -3 nebo rovny
1.
f) Spoč́ıtejte součin nenulových hodnot vektoru v2.
g) Zjistěte, zda je alespoň jeden prvek vektoru v1 nulový.

2. Ve třech laboratoř́ıch byly analyzovány r̊uzné vlastnosti kávy: obsah vody (x1),
hmotnost zrn (x2), pH (x3), tuky (x4), kofein (x5), obsah minerál̊u (x6) a extrakt
(x7). V prvńı laboratoři lab1 byly pozorovány vlastnosti x1, x2, x3, x6, ve druhé
laboratoři lab2 vlastnosti x1, x3, x4, x5 a ve třet́ı laboratoři lab3 vlastnosti x1,
x2 a x5. Zjistěte, které vlastnosti
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a) byly analyzovány ve všech třech laboratoř́ıch,
b) byly analyzovány v prvńı i druhé laboratoři, ale ne ve třet́ı,
c) nebyly analyzovány ani jednou z laboratoř́ı,
d) byly analyzovány alespoň jednou z laboratoř́ı.

3. Je dána matice A =

 2 1 3
1 −1 1
8 −27 1

. Spoč́ıtejte jej́ı spektrálńı poloměr, tj.

největš́ı vlastńı č́ıslo v absolutńı hodnotě.

4. Kolika zp̊usoby můžeme z krabičky 20 kuliček vybrat právě 5? Kolika zp̊usoby
bychom mohli vybrat 5 kuliček, záleželo by-li na jejich pořad́ı?

5. Spoč́ıtejte směrnici tečny ke grafu funkce, v́ıte-li, že daná tečna sv́ırá s kladnou
poloosou x úhel 60 ◦.

6. Náhodně vygenerujte vektor 10 celých č́ısel z intervalu [−2, 3].

7. Náhodně vygenerujte vektor v4 šesti hodnot z intervalu [1, 4] a zaokrouhlete jej
na:
a) 3 desetinná mı́sta,
b) 3 platné cifry,
c) směrem k nule.

8. Vypǐste posledńıch 5 velkých ṕısmen abecedy.

9. Vypǐste anglické názvy měśıc̊u, jejichž pořad́ı odpov́ıdá násobk̊um č́ısla 3.

Řešeńı.

1. v1 <- c(1, 3, 4), v2 <- seq(length=4, from=-2, by=2), v3 <- v2[1:3]

nebo v3 <- head(v2, 3)

a) v1 + v3, v1 - v3, v1 * v3, v1 / v3

b) v1 + v2, v1 - v2, v1 * v2, v1 / v2 . . . na kratš́ı vektor použito pravidlo
recycling rule
c) v1 %/% v3, v1 %% v3

d) which(v1 != v3)

e) sum(v2 < -3 | v2 == 1)

f) prod(v2[v2 != 0])

g) any(v1 == 0)

2. lab1 <- c("x1", "x2", "x3", "x6"),
lab2 <- c("x1", "x3", "x4", "x5"),
lab3 <- c("x1", "x2", "x5")
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a) intersect(intersect(lab1, lab2), lab3)

b) setdiff(intersect(lab1, lab2), lab3)

c) setdiff(c("x1", "x2", "x3", "x4", "x5", "x6"),
union(union(lab1, lab2), lab3))

d) union(union(lab1, lab2), lab3))

3. A <- matrix(c(2, 1, 8, 1, -1, -27, 3, 1, 1), 3)

max(abs(eigen(A)$values))

4. choose(20, 5), factorial(20)/factorial(15)

5. tan(pi/3)

6. round(runif(n=10, min=-2, max=3)) nebo
sample(x=-2:3, size=10, rep=T)

7. v4 <- runif(n=6, min=1, max=4)

a) round(v4, 3)

b) signif(v4, 3)

c) trunc(v4)

8. tail(LETTERS, 5)

9. month.name[seq(from=3, by=3, to=12)]
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Kapitola 6

Daľśı př́ıkazy v R

Základńı informace

Jazyk R obsahuje velké množstv́ı funkćı, některé z nich jsou součást́ı standardńı dis-
tribuce, mnohé jsou součást́ı podp̊urných baĺıčk̊u. Pro využit́ı i těchto funkćı je velmi
d̊uležité umět pracovat s baĺıčky – umět je nainstalovat a nač́ıst.
Pro statistickou analýzu dat je rovněž d̊uležité umět pracovat nejen s vestavěnými
datovými soubory, ale rovněž s vlastńımi (exterńımi) datovými soubory. Pro práci
s takovými soubory je potřeba je umět nač́ıst, součást́ı této kapitoly jsou funkce pro
ukládáńı dat a nač́ıtáńı exterńıch datových soubor̊u.
Posledńı část kapitoly tvoř́ı seznam funkćı, který uživatel̊um usnadňuje jednoduše a
přehledně z datových struktur čerpat základńı informace.

Výstupy z výuky

Studenti

• ovládaj́ı práci s knihovnami, umı́ je nainstalovat a nač́ıst,

• dokáž́ı použ́ıt r̊uzné funkce pro nač́ıtáńı dat,

• umı́ ukládat objekty do souboru,

• znaj́ı funkce pro výpis vlastnost́ı objekt̊u.

6.1 Práce s knihovnami

Ne všechny funkce jsou př́ıstupné ze základńıch knihoven, jsou umı́stěny v dodatečných
baĺıčćıch. Výpis aktuálně nainstalovaných knihoven můžeme źıskat př́ıkazem library().
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Př́ıkaz search() vyhledá přiinstalované knihovny.

> search()
[1] ".GlobalEnv" "package:stats" "package:graphics"

[4] "package:grDevices" "package:utils" "package:datasets"

[7] "package:methods" "Autoloads" "package:base"

Mnohdy je zapotřeb́ı přiinstalovat daľśı baĺıčky: záložka Packages → Install Pac-
kage(s) . . . nebo př́ıkazem install.packages("nazev balicku"). Před zahájeńım
práce s přiinstalovanými baĺıčky je třeba je nač́ıst př́ıkazem library(nazev balicku),
až teprve v tomto okamžiku je baĺıček připraven k použ́ıváńı. O tom se znovu můžeme
přesvědčit:

> library(Matrix)

Loading required package : lattice

> search()
[1] ".GlobalEnv" "package:Matrix" "package:lattice"

[4] "package:stats" "package:graphics" "package:grDevices"

[7] "package:utils" "package:datasets" "package:methods"

[10] "Autoloads" "package:base"

6.2 Práce s daty

Funkce pro ukládáńı dat
V prostřed́ı R existuje několik funkćı pro ukládáńı dat. Uživatel by si měl nejdř́ıve roz-
myslet, k jakému účelu bude dále data použ́ıvat - od toho se totiž bude odv́ıjet výběr
správné funkce pro uložeńı dat.

Univerzálńı funkćı pro ukládáńı dat je funkce save(). Funkce se použ́ıvá pro uložeńı
libovolného objektu (nebo v́ıce objekt̊u) do souboru nejčastěji s koncovkou .RData a
.dat (interńı formáty pro uchováńı dat v R), resp. do binárńıho souboru s př́ıponou
.txt. Takto uložené soubory mohou být následně načteny pomoćı funkce load().

save(..., file) funkce pro ukládáńı dat
... názvy ukládaných objekt̊u
file textový řetězec specifikuj́ıćı název souboru pro uložeńı dat
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> v <- 1:5

> mat <- matrix(2:7, 3)

> save(v, mat, file="seznam1.Rdata") uložeńı objekt̊u v a mat

> l <- list(v=1:5, mat=matrix(2:7, 3)) pro ukládáńı v́ıce objekt̊u současně je
mnohdy užitečné seskupit tyto objekty do seznamu a uložit je jako jeden objekt
> save(l, file="seznam2.RData")

> save(v, file="v.txt") uložeńı objektu v do binárńıho souboru v.txt

Daľśı využ́ıvanou funkćı pro ukládáńı dat je funkce write.table(), která slouž́ı
předevš́ım k ukládáńı matic a datových tabulek. Nejtypičtěǰśımi formáty pro ukládáńı
jsou .txt a .csv, soubory obou formát̊u jsou jednoduše zobrazitelné v libovolném tex-
tovém editoru. Takto uložená data mohou být v prostřed́ı R načtena pomoćı funkce
read.table().

write.table(x, file, sep, eol, dec, row.names, col.names) funkce pro ulo-
žeńı matice nebo datové tabulky
x název ukládaného objektu
file textový řetězec specifikuj́ıćı název souboru pro uložeńı dat
sep oddělovač sloupc̊u, implicitńı nastaveńı sep=""
eol znak pro zalomeńı řádk̊u, implicitńı nastaveńı eol="\n"
dec znak pro desetinnou čárku, implicitńı nastaveńı dec="."
row.names logická hodnota indikuj́ıćı, zda maj́ı být uloženy i názvy řádk̊u, resp.

vektor názv̊u př́ıpad̊u
col.names vektor názv̊u proměnných

> krajeCR <- data.frame(nazev=c("Hlavni mesto Praha", "Stredocesky",

+ "Jihocesky", "Plzensky", "Karlovarsky", "Ustecky", "Liberecky",

+ "Kralovehradecky", "Pardubicky", "Olomoucky", "Moravskoslezsky",

+ "Jihomoravsky", "Zlinsky", "Vysocina"),

+ mesto=c("Praha", "Praha", "Ceske Budejovice", "Plzen", "Karlovy "

+ "Vary", "Usti nad Labem", "Liberec", "Hradec Kralove", "Pardubice"

+ "Olomouc", "Ostrava", "Brno", "Zlin", "Jihlava"),

+ SPZ = c("A", "S", "C", "P", "K", "U", "L", "H", "E", "M", "T", "B",

+ "Z", "J"))
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> krajeCR
nazev mesto SPZ

1 Hlavni mesto Praha Praha A

2 Stredocesky Praha S

3 Jihocesky Ceske Budejovice C

4 Plzensky Plzen P

5 Karlovarsky Karlovy Vary K

6 Ustecky Usti nad Labem U

7 Liberecky Liberec L

8 Kralovehradecky Hradec Kralove H

9 Pardubicky Pardubice E

10 Olomoucky Olomouc M

11 Moravskoslezsky Ostrava T

12 Jihomoravsky Brno B

13 Zlinsky Zlin Z

14 Vysocina Jihlava J
> write.table(x=krajeCR, file="krajeCR.csv") uložeńı objektu krajeCR do
souboru krajeCR.csv

> write.table(x=krajeCR, file="krajeCR.txt") uložeńı objektu krajeCR do
souboru krajeCR.txt

Posloupnost jednotlivých př́ıkaz̊u i s jejich výstupy můžeme uložit v menu File →
Save to File. . . . Historii př́ıkaz̊u lze uložit v menu File → Save History nebo př́ıkazem
savehistory(file=".RHistory"), př́ıkazem loadhistory(file=".RHistory") ji mů-
žeme následně nač́ıst. V př́ıpadě, že otev́ıráme dř́ıve uložený soubor, historie př́ıkaz̊u
je načtena automaticky s ńım.

Funkce pro nač́ıtáńı dat
V jazyce R existuje několik funkćı pro nač́ıtáńı dat. Rozlǐsujeme funkce pro nač́ıtáńı dat
ze schránky, exterńıch datových soubor̊u či objekt̊u vytvořených (a uložených) př́ımo
v prostřed́ı R. Zaměř́ıme se na nejpouž́ıvaněǰśı funkce a uvedeme jejich použit́ı.

K nač́ıtáńı objekt̊u vytvořených v prostřed́ı R (soubory s př́ıponou .Rdata a .dat),
resp. soubor̊u s př́ıponou .txt slouž́ı funkce load().

load(file, verbose) pro nač́ıtáńı dat
file textový řetězec specifikuj́ıćı název souboru pro načteńı dat
verbose nastaveńı TRUE na obrazovku vytiskne názvy nač́ıtaných objekt̊u, impli-

citńı nastaveńı verbose=FALSE

> data1 <- load(file="v.txt", verbose=TRUE) načteńı souboru v.txt

Loading objects:

v
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> data1

[1] "v"

> v

[1] 1 2 3 4 5

> data2 <- load(file="seznam1.RData", verbose=TRUE) načteńı datového sou-
boru seznam1.RData, který obsahuje proměnné v a mat

Loading objects:

v

mat

> data2

[1] "v" "mat"

> v

[1] 1 2 3 4 5

> mat
[,1] [,2]

[1,] 2 5

[2,] 3 6

[3,] 4 7

> load(file="dunaj.dat") načteńı dat ze souboru dunaj.dat (data znázorňuj́ıćı
koĺısáńı [m3/s] Dunaje během roku, [8])
> dunaj

[1] 1987 1728 1862 2083 2143 2187 2588 2224 2001

[10] 1767 1460 1444

Pro nač́ıtáńı tabulek (předevš́ım s př́ıponou .txt) slouž́ı funkce read.table().
K nač́ıtáńı datových tabulek ze soubor̊u s př́ıponou .csv lze použ́ıt i výše zmı́něná
funkce read.table(), pro pohodlněǰśı nač́ıtáńı jsou však v prostřed́ı R implemen-
továny funkce read.csv() a read.csv2(). Obě tyto funkce se jen nepatrně lǐśı ve
svých vstupńıch argumentech, pro všechny tři funkce si ukážeme syntaxi a rozd́ıly v je-
jich použit́ı. Podstatné je rovněž zmı́nit, že data načtená těmito funkcemi jsou ukládána
jako objekty v podobě datové tabulky.
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read.table(file, header, sep, dec, row.names, col.names, nrows, skip,

check.names, ...) funkce pro nač́ıtáńı datových tabulek
file textový řetězec uváděj́ıćı cestu k souboru pro načteńı
header logická hodnota pro názvy proměnných v prvńım řádku, implicitńı

nastaveńı header=FALSE
sep oddělovač sloupc̊u
dec znak pro desetinnou čárku
row.names vektor názv̊u řádk̊u
col.names vektor názv̊u sloupc̊u
nrows maximálńı počet řádk̊u, který má být načten
skip počet řádk̊u, který má být přeskočen před samotným načteńım
check.names implicitńı nastaveńı chcek.names=TRUE zajǐst’uje syntaktickou

správnost proměnných

> tab1 <- read.table(file="krajeCR.txt", header=TRUE)

> head(tab1, n=5) pro zkráceńı výpisu zobraźıme pouze prvńıch pět řádk̊u
tabulky

nazev mesto SPZ

1 Hlavni mesto Praha Praha A

2 Stredocesky Praha S

3 Jihocesky Ceske Budejovice C

4 Plzensky Plzen P

5 Karlovarsky Karlovy Vary K

> tab2 <- read.table(file="krajeCR.csv", header=TRUE, sep="")

> head(tab2, n=5)
nazev mesto SPZ

1 Hlavni mesto Praha Praha A

2 Stredocesky Praha S

3 Jihocesky Ceske Budejovice C

4 Plzensky Plzen P

5 Karlovarsky Karlovy Vary K

read.csv(file, header, sep, dec, ...) funkce pro nač́ıtáńı datových tabulek
z .csv souboru
file textový řetězec uváděj́ıćı cestu k souboru pro načteńı
header logická hodnota pro názvy proměnných v prvńım řádku, implicitńı nasta-

veńı header=TRUE
sep oddělovač sloupc̊u, implicitńı nastaveńı sep=","
dec znak pro desetinnou čárku, implicitńı nastaveńı dec="."
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read.csv2(file, header, sep, dec, ...) funkce pro nač́ıtáńı datových tabulek
z .csv souboru
file textový řetězec uváděj́ıćı cestu k souboru pro načteńı
header logická hodnota pro názvy proměnných v prvńım řádku, implicitńı nasta-

veńı header=TRUE
sep oddělovač sloupc̊u, implicitńı nastaveńı sep=";"
dec znak pro desetinnou čárku, implicitńı nastaveńı dec=","

> tab3 <- read.csv(file="krajeCR.csv", sep="")

> head(tab3, n=5)
nazev mesto SPZ

1 Hlavni mesto Praha Praha A

2 Stredocesky Praha S

3 Jihocesky Ceske Budejovice C

4 Plzensky Plzen P

5 Karlovarsky Karlovy Vary K
> lab1 <- read.csv2(file="laborator.csv") soubor laborator.csv obsahuje
údaje o procentuálńım zastoupeńı měřené látky ve dvou odlǐsných laboratoř́ıch
> lab1

laborator obsah.latky

1 1 69.2

2 1 57.1

3 1 62.8

4 2 63.5

5 2 59.7

6 2 60.2
> lab2 <- read.csv(file="laborator.csv", sep=";", dec=",")

> lab2
laborator obsah.latky

1 1 69.2

2 1 57.1

3 1 62.8

4 2 63.5

5 2 59.7

6 2 60.2
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Pro nač́ıtáńı dat ze schránky lze použ́ıt funkce scan(), pro nač́ıtáńı datových tabulek
ze schránky funkce read.table() s argumentam file="clipboard".

scan(file, what, sep, dec, nmax) je funkce pro načteńı vektoru nebo seznamu
z konzole nebo souboru. Popis argument̊u:
file textový řetězec uváděj́ıćı cestu k souboru, při nač́ıtáńı ze schránky

file="clipboard"

what typ nač́ıtané hodnoty (numerické, komplexńı, . . . )
sep znak, kterým jsou odděleny jednotlivé nač́ıtané položky, např. sep=","
dec znak pro desetinnou čárku
nmax maximálńı počet hodnot, který má být načten

Postup pro zobrazeńı hodnot uložených ve schránce:
1. zkoṕırovat př́ıslušná data, např. 2; 4; 6; 1; 3; 5
2. zavolat funkci scan()

> x <- scan(file="clipboard", sep=";")

Po jej́ım zavoláńı se objev́ı oznámeńı:

Read 6 items

> x

[1] 2 4 6 1 3 5

> x <- scan(file="clipboard", sep=";", what=character())

Read 6 items

> x

[1] "2" "4" "6" "1" "3" "5"

1, 2, 3, 4, 5
3, 2, 1, 1, 2

> read.table(file="clipboard", sep=",")
V1 V2 V3 V4 V5

1 1 2 3 4 5

2 3 2 1 1 2

1 2 3 4 5 r1
3 2 1 1 2 r2

> read.table(file="clipboard", row.names=6, col.names=c("sl1", "sl2",

+ "sl3", "sl4", "sl5", "sl6")) přestože posledńı sloupec obsahuje názvy
řádk̊u, argument col.names muśı obsahovat jeho název i tohoto sloupce ("sl6"), i
když nebude vytǐstěn

sl1 sl2 sl3 sl4 sl5

r1 1 2 3 4 5

r2 3 2 1 1 2
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sl1 sl2 sl3 sl4 sl5 sl6
1 2 3 4 5 r1
3 2 1 1 2 r2

> read.table(file="clipboard", row.names=6, header=T)
sl1 sl2 sl3 sl4 sl5

r1 1 2 3 4 5

r2 3 2 1 1 2

V praxi se často setkáváme s datovými formáty ve formátu .xls či .xlsx, o nichž
v textu zat́ım nebyla žádná zmı́nka. Pro nač́ıtáńı dat těchto formát̊u sice existuj́ı funkce
v daľśıch baĺıčćıch, práce s nimi je ovšem natolik obt́ıžná, že je doporučováno nejprve
data převést do .csv souboru a ten poté nač́ıst.

Poznámka. Pro nač́ıtáńı .txt soubor̊u je doporučován následuj́ıćı postup:

1. zobrazeńı souboru v libovolném prohĺıžeči textových dokument̊u,

2. pokud je soubor čitelný, pro načteńı dat je vhodné použit́ı funkce scan(), př́ıp.
read.table() při nač́ıtáńı datových tabulek.

Alternativou rovněž může být zobrazeńı .txt souboru př́ımo v R pomoćı funkce
readLines(). Pokud je soubor v

”
čitelném“ formátu, výpis bude čitelný i v R a

k načteńı dat je možno použ́ıt funkci read.table(). Pokud je soubor v binárńım
formátu, výpis je nečitelný (nedává smysl) a k načteńı dat je třeba použ́ıt funkci
load().

> readLines("v.txt") v (binárńım) souboru je uložen vektor v, k uložeńı byl použit
př́ıkaz save(v, file="v.txt")

[1] "RDX2""X" "" ""

Warning messages:

1: In readLines("v.txt") : line 3 appears to contain an embedded nul

2: In readLines("v.txt") : line 4 appears to contain an embedded nul

3: In readLines("v.txt") : incomplete final line found on ’v.txt’

> load("v.txt")

> v

[1] 1 2 3 4 5
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> readLines("krajeCR.txt") v souboru je uložena datová tabulka krajeCR,
k uložeńı byl použit př́ıkaz write.table(krajeCR, file="krajeCR.txt"), výpis je
čitelný (dává smysl)
[1] "\"nazev\"\"mesto\"\"SPZ \""

[2] "\"1\"\"Hlavni mesto Praha\"\"Praha\"\"A\""

[3] "\"2\"\"Stredocesky\"\"Praha\"\"S\""

[4] "\"3\"\"Jihocesky\"\"Ceske Budejovice\"\"C\""

[5] "\"4\"\"Plzensky\"\"Plzen\"\"P\""

[6] "\"5\"\"Karlovarsky\"\"Karlovy Vary\"\"K\""

[7] "\"6\"\"Ustecky\"\"Usti nad Labem\"\"U\""

[8] "\"7\"\"Liberecky\"\"Liberec\"\"L\""

[9] "\"8\"\"Kralovehradecky\"\"Hradec Kralove\"\"H\""

[10] "\"9\"\"Pardubicky\"\"Pardubice\"\"E\""

[11] "\"10\"\"Olomoucky\"\"Olomouc\"\"M\""

[12] "\"11\"\"Moravskoslezsky\"\"Ostrava\"\"T\""

[13] "\"12\"\"Jihomoravsky\"\"Brno\"\"B\""

[14] "\"13\"\"Zlinsky\"\"Zlin\"\"Z\""

[15] "\"14\"\"Vysocina\"\"Jihlava\"\"J\""

> krajeCR <- read.table("krajeCR.txt")

> krajeCR

> head(krajeCR, n=5)
nazev mesto SPZ

1 Hlavni mesto Praha Praha A

2 Stredocesky Praha S

3 Jihocesky Ceske Budejovice C

4 Plzensky Plzen P

5 Karlovarsky Karlovy Vary K

6 Ustecky Usti nad Labem U

7 Liberecky Liberec L

8 Kralovehradecky Hradec Kralove H

9 Pardubicky Pardubice E

10 Olomoucky Olomouc M

11 Moravskoslezsky Ostrava T

12 Jihomoravsky Brno B

13 Zlinsky Zlin Z

14 Vysocina Jihlava J
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Pro usnadněńı práce s daty jazyk R obsahuje okolo sta vestavěných datových sou-
bor̊u (v baĺıčku datasets). Funkce data() zobraźı seznam dostupných datových sou-
bor̊u. K zobrazeńı vybraných soubor̊u slouž́ı př́ıkaz data(nazev, package)1, argument
package slouž́ı ke specifikaci baĺıčku, ve kterém se data nacháźı.

Daľśımi užitečnými funkcemi jsou attach() a detach().
Funkce attach() má použit́ı zejména u seznamů a datových tabulek, kde umožňuje
vypisováńı jejich složek př́ımo, tzn. bez uvedeńı názvu objektu. Argumentem funkce je
název objektu, u kterého chceme výše uvedené provést.

> tabulka <- data.frame(id=c(1:6), skupina=c(1, 2, 2, 1, 2, 1),

+ hodnota=runif(6, 2, 4))

> id

Error : object ’id’ not found

> attach(tabulka)

> id

[1] 1 2 3 4 5 6

Opakem k funkci attach je funkce detach, která naopak znemožńı, aby byly složky
volány pouze svým názvem, nikoliv uvedeńım i názvu objektu.

> detach(tabulka)

> id

Error : object ’id’ not found

> tabulka$id

[1] 1 2 3 4 5 6

6.3 Vlastnosti objekt̊u

Se základńımi vlastnostmi objekt̊u jsme se již seznámili v předešlých kapitolách. Zde si
uvedeme některé daľśı funkce, které nám o vnitřńı struktuře objekt̊u vypov́ı mnohem
v́ıce.

summary(object) jedná se o tzv. generickou funkci (funkce, která si nejprve zjist́ı,
jakého typu je jej́ı parametr, podle něj pak vypisuje celkový přehled: pro vektory vraćı
základńı charakteristiky polohy, pro faktory vraćı četnosti jednotlivých složek)

1Od verze 2.0.0 jsou všechny datové soubory př́ıstupné př́ımo zavoláńım jejich názvu. Mnohé baĺıčky
ovšem stále použ́ıvaj́ı dř́ıvěǰśı zp̊usob voláńı pomoćı data(nazev), jenž může být stále využ́ıván i dnes.
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> (a <- c(1, 2, 3, 5, 8, 2, 4, 1, 2, 2))

[1] 1 2 3 5 8 2 4 1 2 2

> summary(a) v př́ıpadě č́ıselných vektor̊u funkce summary() vraćı minimum, 1.
kvartil, medián, pr̊uměr, 3. kvartil a maximum
Min. 1st Qu. Median Mean 3rd Qu. Max.

1.00 2.00 2.00 3.00 3.75 8.00
> (b <- c(1+3i, 7-1i, NA))

[1] 1+3i 7-1i NA

> summary(b)
Length Class Mode

3 complex complex
> (c <- c(T, T, F, T, F))

[1] TRUE TRUE FALSE TRUE FALSE

> summary(c)
Mode FALSE TRUE NA’s

logical 2 3 0
> (d <- c("k", "l", "l", "m"))

[1] "k" "l" "l" "m"

> summary(d)
Length Class Mode

4 character character
> (e <- matrix(a, c(5, 2)))

[,1] [,2]

[1,] 1 2

[2,] 2 4

[3,] 3 1

[4,] 5 2

[5,] 8 2
> summary(e) vyṕı̌se přehled pro každý sloupec

V1 V2

Min. :1.0 Min. :1.0

1st Qu.:2.0 1st Qu.:2.0

Median :3.0 Median :2.0

Mean :3.8 Mean :2.2

3rd Qu.:5.0 3rd Qu.:2.0

Max. :8.0 Max. :4.0
> (f <- factor(a))

[1] 1 2 3 5 8 2 4 1 2 2

Levels: 1 2 3 4 5 8

> summary(f) vypisuje četnosti jednotlivých úrovńı faktoru (Levels)
1 2 3 4 5 8

2 4 1 1 1 1
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> (tab <- data.frame(cervena=c(15, 14, 12, 12), seda=c(13, 17, 10, 9),

+ zelena=c(7, 9, 8, 6)))
cervena seda zelena

1 15 13 7

2 14 17 9

3 12 10 8

4 12 9 6

> summary(tab) opět vypisuje přehled pro každý sloupec zvlášt’

cervena seda zelena

Min. :12.00 Min. : 9.00 Min. :6.00

1st Qu.:12.00 1st Qu.: 9.75 1st Qu.:6.75

Median :13.00 Median :11.50 Median :7.50

Mean :13.25 Mean :12.25 Mean :7.50

3rd Qu.:14.25 3rd Qu.:14.00 3rd Qu.:8.25

Max. :15.00 Max. :17.77 Max. :9.00

str(object) přehledně vyṕı̌se podrobnou vnitřńı strukturu objektu, je alternati-
vou k funkci summary() s t́ım rozd́ılem, že výpis provád́ı do řádku

> str(a)

num [1:10] 1 2 3 5 8 2 4 1 2 2

> str(b)

cplx [1:3] 1+3i 7-1i NA

> str(c)

logi [1:5] TRUE TRUE FALSE TRUE FALSE

> str(d)

chr [1:4] "k" "l" "l" "m"

> str(e)

num [1:5, 1:2] 1 2 3 5 8 2 4 1 2 2

> str(f)

Factor w/ 6 levels "1" "2" "3" "4",..: 1 2 3 5 8 2

4 1 2 2

> str(tab)

’data.frame’: 4 obs. of 3 variables
$ cervena: num 15 14 12 12

$ seda : num 13 17 10 9

$ zelena : num 7 9 8 6

comment(object) nastav́ı nebo vyṕı̌se komentář k danému objektu

> comment(tab) <- "Pocty aut jednotlivych barev behem 4 casovych

+ obdobi." nastaveńı komentáře k objektu tab
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> comment(tab) zobrazeńı komentáře
[1] "Pocty aut jednotlivych barev behem 4 casovych obdobi."

attributes(object) vypisuje všechny atributy objektu. K výpisu nebo nastaveńı
konkrétńı vlastnosti objektu slouž́ı př́ıkaz attr(object, name), kde parametr name

udává název zjǐst’ované vlastnosti.

> (ar <- array(1:8, c(2, 2, 2)))

, , 1
[,1] [,2]

[1,] 1 2

[2,] 2 4
, , 2

[,1] [,2]

[1,] 5 7

[2,] 6 8
> attributes(ar)

$dim

[1] 2 2 2

> attributes(f)

$levels

[1] "1" "2" "3" "4" "5" "8"

$class

[1] "factor"

> attributes(tab)

$names

[1] "cervena" "seda" "zelena"

$row.names

[1] 1 2 3 4

$class

[1] "data.frame"

$comment

[1] "Pocty aut jednotlivych barev behem 4 casovych obdobi."

> attr(tab, "names")

[1] "cervena" "seda" "zelena"
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Funkce as.something() umožňuje změny datových typ̊u všude, kde je to smyslu-
plné.

> u <- 1:10

[1] 1 2 3 4 5 6 7 8 9 10

> v <- as.character(u) převede numerický vektor na vektor textových hodnot
[1] "1" "2" "3" "4" "5" "6" "7" "8" "9" "10"

> w <- as.integer(v) převede vektor textových hodnot na numerický vektor, vek-
tory u a w jsou stejného typu
[1] 1 2 3 4 5 6 7 8 9 10

K převodu objekt̊u z jednoho datového typu na druhý je k dispozici velké množstv́ı
funkćı typu as.something(). Jejich seznam můžeme naj́ıt př́ıkazem methods(as).

Př́ıklady k procvičeńı

1. Do pracovńıho adresáře načtěte soubor strom.dat. Součást́ı tohoto souboru je
objekt strom.
a) Vhodným př́ıkazem zjistěte informace o vnitřńı struktuře tohoto objektu.
b) Zjistěte, zda je pro tento objekt vytvořen komentář. V př́ıpadě že neńı, stručný
komentář pro něj vytvořte.
c) Převed’te tento objekt na textovou matici strom1.

2. Nainstalujte a načtěte knihovnu Hmisc. Na objektu strom porovnejte výstup
funkce describe() z této knihovny s funkcemi str() a attributes(). Výstup
funkce describe() uložte do proměnné descr.

3. Do proměnné mereni1 načtěte soubor mereni.txt i s názvy řádk̊u a sloupc̊u.

4. Umožněte, aby na jednotlivé sloupce proměnné mereni1 mohlo být odkazováno
př́ımo.

5. Spojte proměnné strom, strom1, descr a metoda2 do seznamu seznam, ten uložte
do souboru seznam.dat. Výpisem soubor̊u pracovńıho adresáře se přesvědčte, že
jste tak opravdu učinili.

Řešeńı.

1. load("strom.dat")

a) summary(strom)
b) comment(strom) <- "Metody mereni vysky stromu"

c) strom1 <- as.matrix(strom)

2. install.packages("Hmisc"), library(Hmisc)
descr <- describe(strom), str(strom), attributes(strom)
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3. mereni1 <- read.table(file="mereni.txt")

4. attach(mereni1)

5. seznam <- list(strom=strom, strom1=strom1, descr=descr,

metoda2=metoda2)

save(seznam, file="seznam.dat"), dir()
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Kapitola 7

Grafika v R

Základńı informace

Grafika jazyka R patř́ı k jedné z nejv́ıce propracovaných část́ı, nab́ıźı nepřeberné
množstv́ı funkćı pro tvorbu kompletńıch graf̊u včetně popisk̊u (high-level grafika) stejně
jako funkćı k přidáváńı nových část́ı či změně již existuj́ıćıho vzhledu grafu (low-level
grafika).
Ćılem kapitoly je uvést nejv́ıce použ́ıvané argumenty grafických funkćı, seznámit se
s funkćı par, jej́ıž argumenty dokáž́ı zastoupit mnohé low-level funkce, a daľśımi funk-
cemi k tvorbě grafických výstup̊u.

Výstupy z výuky

Studenti

• znaj́ı rozd́ıly mezi high-level a low-level grafikou,

• se seznámı́ s několika př́ıkazy pro tvorbu high-level grafiky a umı́ použ́ıvat jejich
argumenty,

• ovládaj́ı funkce pro vykresleńı základńıch typ̊u graf̊u,

• dokáž́ı vytvářet 3D grafy,

• umı́ použ́ıt funkce pro tvorbu low-level grafiky,

• umı́ využ́ıvat vlastnost́ı funkce par,

• znaj́ı př́ıkazy pro ukládáńı grafu do souboru, umı́ pracovat s podgrafy.

Systém R umožňuje zobrazovat širokou škálu graf̊u. Př́ıkazy k vykreslováńı graf̊u
jsou rozděleny do tř́ı základńıch skupin:
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• High-level funkce vytvář́ı kompletńı nový graf s osami, popisky, názvem atd.

• Low-level funkce přidávaj́ı do již existuj́ıćıho grafu daľśı informace, např. daľśı
body, čáry, popisky.

• Interaktivńı grafika umožňuje interaktivně pomoćı myši přidávat data do již
existuj́ıćıho grafu.

V př́ıpadě, že jsou tyto grafy nedostačuj́ıćı, můžeme použ́ıt daľśıch baĺıčk̊u - např. grid,
lattice, iplots, misc3D, rgl, scatterplot nebo baĺıček maps obsahuj́ıćı nejr̊uzněǰśı
mapy.

7.1 High-level funkce

Všechny grafy jsou nejprve vytvořeny pomoćı high-level funkćı, které vytvář́ı ”kom-
pletńı”graf. Kompletńı v tom smyslu, že jsou automaticky vygenerovány osy, popisky
a nadpis (pokud sami nenastav́ıme jinak). High-level funkce vždy vykresluj́ı nový graf,
v př́ıpadě, že již nějaký graf existuje, přeṕı̌śı jej. Je d̊uležité si uvědomit, že data
k vykresleńı mohou být r̊uzné objekty - podle druhu objektu grafické funkce následně
vykresluj́ı graf.

Argumenty k high-level funkćım:
axes implicitńı hodnota TRUE, nastaveńı na hodnotu FALSE potlačuje vy-

kreslováńı os
log nastaveńım na hodnoty log="x", log="y", log="xy" budou mı́t vy-

brané osy logaritmické měř́ıtko
main textový řetězec pro název grafu, je umı́stěn nad grafem
sub textový řetězec, je umı́stěn pod grafem a psán menš́ım fontem
type typ výstupńıho grafu

type="p" vykresluje samostatné body (implicitńı nastaveńı)
type="l" linie
type="b" přerušované linie s body
type="c" přerušované linie bez bod̊u
type="o" body navzájem spojené liniemi
type="h" vertikálńı linie
type="s" schodovitý graf s prvńı liníı horizontálńı
type="S" schodovitý graf s prvńı liníı vertikálńı
type="n" žádné vykreslováńı dat, vykresleny jsou pouze osy, rozsah
souřadného systému záviśı na datech
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xlab, ylab textové řetězce pro názvy os x a y, tyto argumenty měńı implicitně
zadané názvy os při voláńı high-level funkćı

xlim, ylim 2-prvkový vektor specifikuj́ıćı minimálńı a maximálńı hodnotu k vy-
kresleńı dané osy

Dále jsou uvedeny nejpouž́ıvaněǰśı typy graf̊u se svými argumenty. Nejedná se
o kompletńı výčet argument̊u, uvedeny jsou pouze ty nejd̊uležitěǰśı. Použitá data jsou
uvedena na přiloženém CD.

• plot(x) vzhled grafu záviśı na povaze vstupńıch dat. Pro numerický vektor vraćı
jednoduchý graf s indexy na ose x a hodnotami na ose y, pro matice vraćı graf
s hodnotami prvńıho sloupce na ose x a odpov́ıdaj́ıćımi hodnotami druhého sloupce
na ose y (ostatńı sloupce jsou ignorovány), pro faktory vykresluje sloupcový graf
četnost́ı jednotlivých kategoríı, pro datové tabulky vykresluje bodový graf závislosti
všech proměnných, pro funkce vykresluje hladkou čáru
• plot(x, y) jestliže x a y jsou vektory téže délky, funkce vykresĺı bodový graf
hodnot y na pozićıch x. Stejného výsledku můžeme doćılit nahrazeńım argument̊u x

a y bud’ seznamem, obsahuj́ıćım dvě složky x a y, nebo matićı o dvou sloupćıch (viz
př́ıkaz plot(x)).
Implicitńı vzhled grafu plot(x) a plot(x, y) můžeme upravit pomoćı široké škály
volitelných argument̊u:

main, sub, type

axes, xlim, ylim, xlab, ylab

ann, col, bg, pch, cex, lty, lwd parametry zadávaj́ıćı výpis názvu a po-
pisk̊u os, barvu, barvu pozad́ı grafu, znaky pro vykresleńı bod̊u a jejich velikost, typ a
tloušt’ku čar. Vı́ce informaćı v odstavci 7.3.

frame.plot logická hodnota implicitně nastavená na TRUE graf orámuje
asp poměr osy y/x

> plot(function(x) 2*x^3, xlim=c(-3, 3), ylab="f(x)", main="Graf funkce

+ f(x)=2*x^3")

> benzen <- c(3.34, 4.76, 4.87, 5.11, 3.89, 4.83, 5.02) sedm měřeńı pro
kontrolu obsahu benzenu v ovzduš́ı [mg/mˆ3], [8]
> plot(benzen, pch=8, xlab="cislo pozorovani", ylab="obsah benzenu

+ [mg/m^3]", main="Obsah benzenu v ovzdusi")
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Obr. 7.1. Funkce plot()

> plot(benzen, type="p", main="type=’p’", ylab="benzen [mg/m^3]")

> plot(benzen, type="l", main="type=’l’", ylab="benzen [mg/m^3]")

> plot(benzen, type="b", main="type=’b’", ylab="benzen [mg/m^3]")

> plot(benzen, type="c", main="type=’c’", ylab="benzen [mg/m^3]")

> plot(benzen, type="o", main="type=’o’", ylab="benzen [mg/m^3]")

> plot(benzen, type="h", main="type=’h’", ylab="benzen [mg/m^3]")

> plot(benzen, type="s", main="type=’s’", ylab="benzen [mg/m^3]")

> plot(benzen, type="S", main="type=’S’", ylab="benzen [mg/m^3]")
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Obr. 7.2. Možné varianty argumentu type

• barplot() sloupcový graf
axes, main, sub, xlab, ylab, xlim, ylim

beside lze použ́ıt pouze v př́ıpadě vstupńıho argumentu typu matice. Implicitńı
hodnota beside=FALSE vykresĺı v́ıce obdélńık̊u nad sebou, nastaveńı na hodnotu TRUE

vedle sebe.
width vektor hodnot udávaj́ıćıch š́ı̌rku vykreslovaných obdélńık̊u na ose x. Jestliže

vektor wide nedosahuje délky rovné počtu složek argumentu, je použito pravidlo recyc-
ling rule.

space velikost mı́sta pro vynecháńı mezi jednotlivými sloupci (pod́ıl pr̊uměrné
š́ı̌rky sloupce), může se jednat o numerickou hodnotu nebo vektor hodnot. Pro vstupńı
matici a argument beside=TRUE může být argument space specifikován vektorem dvou
hodnot, prvńı vyjadřuje odestup sloupc̊u ve stejné skupině (ve stejném sloupci), druhý
vyjadřuje odestup mezi skupinami. Implicitńı nastaveńı je space=c(0,1) pro vstupńı
matici a argument beside=TRUE, pro ostatńı možnosti space=0.2.

names.arg vektor názv̊u ke každému sloupci nebo skupině sloupc̊u
legend.text vektor textových řetězc̊u uváděj́ıćı názvy v legendě, má smysl jen

pro vstupńı matice
horiz implicitńı hodnota horiz=FALSE vykresluje obdélńıky vertikálně, argu-

ment horiz=TRUE horizonatálně
density hodnota nebo numerický vektor nastavuj́ıćı hustotu šrafováńı sloupc̊u
angle úhel pro sklon šrafováńı
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> load(file="penicilin.dat") načteńı potřebného souboru dat, který muśı být
uložen v aktuálńım pracovńım adresáři. Data pro porovnáńı obsahu penicilinu [mg/l]
v krvi dvou pacient̊u, [8]
> barplot(penicilin, ylab="obsah penicilinu [mg/l]")

> barplot(penicilin, beside=T, ylab="obsah penicilinu [mg/l]")

> barplot(penicilin, beside=T, ylab="obsah penicilinu [mg/l]",

+ space=c(0.5,1.5), density=c(7,18), angle=c(60,105), col=gray(c(0,

+ 0.6))) funkce gray slouž́ı k vykresleńı r̊uzného stupně šedi (v́ıce v odstavci 7.3)
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Obr. 7.3. Porovnáńı obsahu penicilinu v krvi dvou pacient̊u [mg/l]

> load(file="dunaj.dat") načteńı datového souboru dunaj.dat (koĺısáńı pr̊utoku
Dunaje [m3/s] během roku, [8])
> barplot(dunaj, names.arg=c("I", "II", "III", "IV", "V", "VI", "VII",

+ "VIII", "IX", "X", "XI", "XII"), ylab="prutok [m^3/s]",

+ xlab="mesic")

> barplot(dunaj, horiz=T, names.arg=c("I", "II", "III", "IV", "V",

+ "VI", "VII", "VIII", "IX", "X", "XI", "XII"), ylab="prutok

+ [m^3/s]", xlab="mesic")

> barplot(dunaj, width=c(1, 2, 3), density=rep(c(5, 8, 13), times=4),

+ angle=seq(from=30, by=10, length=12), names.arg=c("I", "II", "III",

+ "IV", "V", "VI", "VII", "VIII", "IX", "X", "XI", "XII"), ylab="prutok

+ [m^3/s]", xlab="mesic")

> barplot(dunaj, col=gray(seq(from=0, to=1, length=12)), names.arg=

+ c("I", "II", "III", "IV", "V", "VI", "VII", "VIII", "IX", "X", "XI",

+ "XII"), ylab="prutok [m^3/s]", xlab="mesic")
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Obr. 7.4. Koĺısáńı pr̊utoku Dunaje během roku [mˆ3/s]

• hist() histogram pro numerický vektor
breaks argument š́ı̌rky interval̊u, implicitńı nastaveńı je breaks="Sturges", která

š́ı̌rku interval̊u poč́ıtá Sturgesovým pravidlem: log2 n+ 1, [18], daľśımi možnostmi jsou
breaks="Scott" (Scottovo pravidlo: 3.5·σ̂ ·n−1/3, [18]) nebo breaks="FD" (Freedman a
Diaconis: 2·IQR·n−1/3, [18]), n udává počet hodnot vektoru, σ̂ je odhadem směrodatné
odchylky a IQR znač́ı interkvantilové rozpět́ı

freq implicitńı nastaveńı freq=TRUE vykresluje absolutńı četnosti, nastaveńı na
hodnotu freq=FALSE vykresluje relativńı četnosti

right pro implicitńı hodnotu right=TRUE jsou intervaly zprava uzavřené, zleva
otevřené, pro hodnotu right=FALSE je tomu naopak

labels pro hodnotu labels=TRUE vypisuje nad sloupce absolutńı/relativńı četnosti
density, angle stejně jako u barplot()

axes, main, sub, xlim, ylim, xlab, ylab

Funkce hist() má k dispozici i výstupńı hodnoty:
breaks hodnoty hranic interval̊u
counts absolutńı četnosti pro každý interval
density hustota pravděpodobnosti pro jednotlivé intervaly
intensities shodné s density

mids středy interval̊u
xname název objektu v argumentu
equidist logická hodnota stejné délky všech interval̊u

> load(file="obili.dat") načteńı souboru dat (sklizňová ztráta obiĺı [g/m3], [8])
> hist(obili, breaks="Sturges", main="breaks=’Sturges’")

> hist(obili, breaks="Scott", main="breaks=’Scott’")

> hist(obili, breaks="FD", main="breaks=’FD’")

174



KAPITOLA 7. GRAFIKA V R

breaks='Sturges'

obili

F
re

qu
en

cy

3 4 5 6 7 8 9 10

0
2

4
6

8

breaks='Scott'

obili

F
re

qu
en

cy
2 4 6 8 10

0
2

4
6

8
10

breaks='FD'

obili

F
re

qu
en

cy

3 4 5 6 7 8 9 10

0
2

4
6

8

Obr. 7.5. Sklizňová ztráta obiĺı [g/mˆ3], argumenty š́ı̌rky interval̊u

> hist(obili, main="")

> hist(obili, freq=F, main="")

> hist(obili, labels=T, main="")
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Obr. 7.6. Sklizňová ztráta obiĺı [g/mˆ3], zobrazeńı absolutńıch a relativńıch četnost́ı
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> (hist(obili)) výstupńı hodnoty
$breaks

[1] 3 4 5 6 7 8 9 10

$counts

[1] 2 0 5 8 2 2 1

$intensities

[1] 0.09999998 0.00000000 0.25000000 0.40000000 0.10000000

+ 0.10000000 0.05000000

$density

[1] 0.09999998 0.00000000 0.25000000 0.40000000 0.10000000

+ 0.10000000 0.05000000

$mids

[1] 3.5 4.5 5.5 6.5 7.5 8.5 9.5

$xname

[1] "obili"

$equidist

[1] TRUE

$attr(,"class")

[1] "histogram"

• pie() koláčový graf pro vektor nezáporných celých č́ısel
labels vektor textových hodnot vyjadřuj́ıćı názvy jednotlivých d́ıl̊u grafu
edges numerická hodnota udávaj́ıćı počet vrchol̊u polygonu
clockwise logická hodnota vykresleńı po (TRUE) nebo proti (FALSE, implicitńı

nastaveńı) směru hodinových ručiček
init.angle počátečńı úhel pro natočeńı grafu
density, angle
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> kralici <- c(3, 4, 2, 5, 3)

> pie(kralici, angle=30, labels=c("lokalita

+ 1", "lokalita 2", "lokalita 3", "lokalita 4", "lokalita 5"),

+ col=gray(seq(from=0, to=1, length=5)))

> pie(kralici, edges=5, col=gray(seq(from=0, to=1, length=5)))

> pie(kralici, clockwise=F, init.angle=90, col=gray(seq(from=0, to=1,

+ length=5)))
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Obr. 7.7. Počet chycených kráĺık̊u v jednotlivých lokalitách lesa, [8]

• boxplot() krabicový graf
range vymezuje rozpět́ı ”fousk̊u”grafu, pro kladné range se ”fousky”rozṕınaj́ı

do vzdálenosti range ·IQR (interkvartilová odchylka), pro range=0 se rozṕınaj́ı od
minimálńı po maximálńı hodnotu, implicitńı nastaveńı range=1.5

notch implicitńı nastaveńı notch=FALSE, pro notch=TRUE zobrazuje výřezy po
stranách ”krabice”(výřezy odpov́ıdaj́ı hodnotám ±1.58·IQR√

n
)

outline implicitńı nastaveńı outline=TRUE zobrazuje odlehlé hodnoty, hodnota
FALSE odlehlé hodnoty nezobrazuje

names vektor textových řetězc̊u pro názvy jednotlivých krabicových graf̊u
horizontal pro hodnotu horizontal=TRUE vykresluje grafy horizontálně
pars seznam parametr̊u k volbě vzhledu krabicového grafu (velikosti ”krabic”,

hodnoty ”fousk̊u”a extrémů, typy, š́ı̌rky a barvy čar, velikosti bod̊u atd.), v́ıce pomoćı
př́ıkazu help(bxp)
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Př́ıkazem (boxplot()) źıskáme výstupńı hodnoty:
stats matice, jej́ıž sloupce obsahuj́ı informaci o hodnotách dolńıho ”fousu”, dolńı

části krabice, mediánu, horńı části krabice a horńım ”fousu”.1

n vektor počtu pozorováńı každé skupiny
conf matice, jej́ıž sloupce obsahuj́ı horńı a dolńı extrémy výřez̊u (notch)
out odlehlé hodnoty
group vektor stejné délky jako out, jehož prvky uváděj́ı, do které skupiny patř́ı

odlehlé hodnoty
names vektor názv̊u skupin

> load(file="dusicnany.dat") načteńı datového souboru (obsah dusičnan̊u ve
studničńı vodě, [8])
> boxplot(dusicnany)

> boxplot(dusicnany, range=0)

> boxplot(dusicnany, notch=TRUE, outline=FALSE)

> load(file="kyslik.dat") načteńı datového souboru (porovnáńı dvou me-
tod stanoveńı obsahu kysĺıku ve vodě [mg/l], [8])
> boxplot(kyslik, names=c("metoda A", "metoda B"), horizontal=TRUE,

+ las=1, xlab="obsah kysliku [mg/l]")
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Obr. 7.8. Obsah dusičnan̊u ve
studničńı vodě [mg/l]

Obr. 7.9. Porovnáńı dvou metod
stanoveńı obsahu kysĺıku ve vodě
[mg/l]

1Záměrně jsou uvedeny pojmy jako dolńı ”fous”, dolńı část krabice, horńı část krabice, horńı
”fous”, protože implicitńı nastaveńı (dolńı hradba, dolńı kvartil, horńı kvartil, horńı hradba) může
být uživatelem změněno pomoćı argument̊u range a pars na jiné hodnoty.

178



KAPITOLA 7. GRAFIKA V R

> (boxplot(kyslik)) výstupńı hodnoty
$stats

[,1] [,2]

[1,] 6.4 6.5

[2,] 6.7 6.6

[3,] 6.9 6.9

[4,] 7.0 7.1

[5,] 7.3 7.4

$n

[1] 30 30

$conf
[,1] [,2]

[1,] 6.81346 6.755766

[2,] 6.98654 7.044234

$out

numeric(0)

$group

numeric(0)

$names

[1] "metodaA" "metodaB"

• stripchart() pro numerické vektory, seznamy a tabulky dat vykresluje diagram
rozptýleńı, použ́ıvá se pro jednoduché zobrazeńı dat

method zp̊usob zobrazeńı shodných dat, implicitńı nastaveńı method="overplot"
zp̊usobuje překrýváńı shodných dat, method="jitter" zobrazuje náhodně kolem osy
y a method="stack" skládá nad sebe

jitter v př́ıpadě volby method="jitter" můžeme argumentem jitter nastavit
š́ı̌rku vykreslováńı kolem osy y

offset v př́ıpadě volby method="stack" argument udává rozestup mezi jednot-
livými vykreslenými body

vertical pro hodnotu vertical=TRUE vykresluje vertikálně
group.names textový řetězec názv̊u skupin zobrazovaný po boćıch grafu (při vy-

kresleńı v́ıce graf̊u)
at numerický vektor udávaj́ıćı pozici pro vykresleńı bod̊u
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> load(file="cekani.dat") načteńı datového souboru (doba čekáńı na zákazńıka
[min], [8])
> stripchart(cekani, method="overplot", main="method = ’overplot’",

+ cex=1)

> stripchart(cekani, method="jitter", main="method = ’jitter’", cex=1,

+ pch=1)

> stripchart(cekani, method="stack", main="method = ’stack’", cex=1.5,

+ pch=20, offset=0.4, at=0) argument cex udává velikost znak̊u, pch typ
znázorňovaných bod̊u, v́ıce viz odstavec 7.3
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Obr. 7.10. Doba čekáńı na zákazńıka [min]

• matplot() vykresleńı v́ıce datových řad do jednoho grafu. Vzhled grafu lze měnit
ńıže uvedenými argumenty, implicitńı vykresleńı je pomoćı č́ıslic
matplot(x) pro vstupńı matici x tvoř́ı každou datovou řadu jeden sloupec matice
matplot(x, y) pro dvě vstupńı matice stejných rozměr̊u udávaj́ı shodné pozice souřadnice
bod̊u, datové řady opět tvoř́ı sloupce matic. Lze vykreslit i pro vstupńı vektor x stejné
délky jako počet řádk̊u matice y

type, main, xlab, ylab, xlim, ylim

lty, lwd, pch, col, cex viz odstavec 7.3

> load(file="smes.dat") načteńı datového souboru (vliv krmné směsi na př́ır̊ustek
zv́ı̌rat, [8])
> matplot(smes, main="matplot(x)", ylab="prirustek [kg]", type=c("b",

+ "b"), lty=c(2,3), pch=c(15, 16), col=c(2,4))

> legend(7, 29, c("smes 1", "smes 2"), lty=c(2,3), pch=c(15, 16),

+ col=c(2,4)) funkce pro zobrazeńı legendy, v́ıce viz odstavec 7.2
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> time <- seq(from=1962, to=1978, length=17)

> load(file="chmel.dat") načteńı datového souboru (vývoz a sklizeň chmele
v ČSSR v letech 1962 až 1978, [8])
> matplot(time, chmel, main="matplot(x,y)", ylab="chmel [tis. tun]")

> legend(time[1], 12, c("vyvoz", "sklizen"), pch=c("1","2"), col=1:2)
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Obr. 7.11. Vliv krmné směsi na
př́ır̊ustek zv́ı̌rat [kg], [8]

Obr. 7.12. Vývoz a sklizeň chmele

v ČSSR v letech 1962 až 1978

• qqnorm(), qqline() grafy pro ověřováńı normality dat. qqnorm() vykresluje
normálńı kvantil-kvantilový graf (Q-Q plot), qqline() nav́ıc přidá do již existuj́ıćıho
grafu př́ımku odpov́ıdaj́ıćı normálńımu rozložeńı, jedná se o low-lewel funkci

> qqnorm(rnorm(70))

> qqnorm(rnorm(70))

> qqline(rnorm(70), col=gray(0.5)) funkce gray slouž́ı k vykresleńı r̊uzné
stupně šedi (v́ıce v odstavci 7.3)
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Obr. 7.13. Q-Q plot pro výběr z normálńıho rozložeńı

• curve() vykresĺı křivku
from, to interval pro vykresleńı funkce

> curve(sin(5*x), from=-30, to=30, main="curve()")
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Obr. 7.14. Funkce curve()
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• persp(x, y, z) slouž́ı k vykresleńı 3D grafu
xlim, ylim, zlim intervaly pro vykreslováńı hodnot na osách x, y a z
main, sub, col

theta úhel pro otočeńı grafu v horizontálńım smyslu
phi úhel pro otočeńı grafu ve vertikálńım smyslu
shade st́ınováńı
ticktype typ os, ticktype="simple" (implicitńı nastaveńı) vykresĺı pouze šipky

souběžné s osami grafu, šipky indikuj́ı směr nár̊ustu hodnot, ticktype="detailed"
zobrazuje i měř́ıtko os (počet značek na ose udává argument nticks)

border implicitńı nastaveńı NULL vykresluje křivky, barvu vykreslovaných křivek
můžeme měnit pomoćı argumentu col nebo funkce gray(), nastaveńı border=NA vy-
kresleńı křivek zabraňuje

> persp(x, y, z)

> persp(x, y, z, ticktype="detailed", nticks=5, phi=270, xlab="osa x",

+ ylab="osa y", zlab="osa z")

> persp(x, y, z, ticktype="detailed", nticks=5, phi=30, theta=55,

+ shade=0.5, xlab="osa x", ylab="osa y", zlab="osa z")

> persp(x, y, z, shade=0.5, phi=30, theta=55, border=NA, axes=F)
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Obr. 7.15. Funkce persp()
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• image() vytvoř́ı mř́ıžku s obdélńıky r̊uzného stupně šedi, slouž́ı k zobrazeńı 3-
dimenzionálńıch nebo prostorových dat

> x <- seq(-1.5*pi, 1.5*pi, length=50)

> y <- seq(-1.5*pi, 1.5*pi, length=50)

> z <- sin(x) %*% t(sin(y))

> image(x, y, z, col=gray(seq(from=0,to=1,length=80)), main="image()")
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Obr. 7.16. Funkce image()

Funkce contour() a filled.contour() slouž́ı k podobnému zobrazeńı jako funkce
image().

> contour(x, y, z, main="contour()")

> filled.contour(x, y, z, main="filled.contour()")
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Obr. 7.17. Funkce contour() Obr. 7.18. Funkce filled.contour()
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Velký výběr daľśıch 3D graf̊u nab́ıźı baĺıčky misc3d, scatterplot3d a lattice.

• symbols() na dané souřadnice vykresĺı symboly - kružnice, čtverce, trojúhelńıky,
hvězdičky, v́ıce informaćı v nápovědě: help(symbols)

7.2 Low-level funkce

Někdy se stává, že grafické funkce nevykresluj́ı přesný typ grafu, jaký bychom si přáli.
V těchto př́ıpadech je dobré použ́ıt tzv. low-level funkce. Pomoćı nich vytvář́ıme celý
graf po samostatných částech přidáńım daľśıch informaćı (body, čáry, text, . . . ) do již
existuj́ıćıho grafu.

Nejpouž́ıvaněǰśı funkce pro tvorbu low-level grafiky (pro význam argument̊u bg,
cex, col, lty, lwd a pch viz odstavec 7.3):
• points(x, y, type, pch, col, bg, cex, lwd, ...) dle nastaveńı argument̊u
vykresĺı body daných tvar̊u a barev na souřadnice x, y
• lines(x, y, type, lty, lwd, ...) vykresĺı lomenou čáru mezi body danými
souřadnicemi x a y

• segments(x0, y0, x1, y1, col, lty, lwd, ...) vykresĺı úsečky mezi dvěma
body o souřadnićıch [x0, y0], [x1, y1]
• abline(a, b, ...) vykresĺı př́ımku se směrnićı b a pr̊useč́ıkem s osou y a

• abline(h, ...) vykresĺı vodorovné úsečky přes celou š́ı̌rku grafu, h udává hodnoty
na ose y
• abline(v, ...) vykresĺı svislé úsečky, v udává hodnoty na ose x
• rect(xleft, ybottom, xright, ytop, col, ...) vykresĺı obdélńık, jehož vr-
choly jsou dány souřadnicemi xleft, ybottom, xright a ytop

• polygon(x, y, col, ...) vykresĺı mnohoúhelńık(y) s vrcholy danými body o sou-
řadnićıch x a y,
• arrows(x0, y0, x1, y1, length, angle, code, col, ...) vykresĺı šipky smě-
řuj́ıćı z bodu o souřadnićıch [x0, y0] do bodu o souřadnićıch [x1, y1], délku a úhel hlavy
šipky uvád́ı argumenty length a angle, styl vykresleńı šipky udává code (0 - bez šipky,
1 - šipka na začátku, 2 - šipka na konci, 3 - šipka na obou stranách)
• rug(x, ...) ”rohož”s rozestupem, slouž́ı k vykresleńı hustoty bod̊u
• legend(x, y, legend, ...) na souřadnice x a y vytiskne legendu (vektor tex-
tových řetězc̊u). Funkce má velké množstv́ı volitelných argument̊u (viz help(legend))
• title(main, sub, xlab, ylab, ...) vyṕı̌se název, podtitulek, popisky os
• grid(nx, ny) vykresĺı mř́ıžku, nx a ny udávaj́ı počet vertikálńıch a horizontálńıch
čar, implicitńı nastaveńı k vykreslováńı mř́ıžky (col="lightgray", lty="dotted",

lwd=par("lwd")) lze samozřejmě libovolně měnit
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• axis(side, at, labels, tick, lty, lwd, col, ...) vykresĺı osu, umožňuje
nastavit značky a popisky libovolně pro jednotlivé osy

side přirozené č́ıslo specifikuj́ıćı stranu grafu, na které má být osa vykres-
lena (1 - dole, 2 - vlevo, 3 - nahoře, 4 - vpravo)

at body, ve kterých maj́ı být vykreslovány značky pro měř́ıtko
labels názvy pro jednotlivé značky
tick logická hodnota pro vykreslováńı značek

• text(x, y, labels, ...) vyṕı̌se textový řetězec labels do grafu na pozici [x, y]
• mtext(text, side, ...) vyṕı̌se textový řetězec text na okraj grafu (side)

7.3 Funkce par()

Funkce par() slouž́ı k nastaveńı a změnám parametr̊u aktuálńıho grafu. Nastaveńı
parametr̊u pomoćı funkce par() měńı hodnoty parametr̊u nastálo – ve všech daľśıch
voláńıch libovolné grafické funkce až do doby zavřeńı grafického okna nebo nastaveńı pa-
rametr̊u na nové hodnoty. S otevřeńım nového grafického okna jsou všechna předchoźı
nastaveńı ignorována.

Text
adj zarovnáńı textu pro název grafu a popisky os, 0 - zarovnat vlevo, 1 - zarovnat

vpravo, 0.5 - zarovnat horizontálně na střed
ann implicitńı hodnota ann=TRUE vypisuje anotace (název a popisky os), hodnota

FALSE je potlačuje

cex relativńı velikost znak̊u (1 - normálńı velikost, 2 - dvojnásobná), cex.main

nastav́ı velikost znak̊u pro název grafu, cex.sub pro podtitulek, cex.axis,
cex.lab pro velikost ṕısma popisk̊u a názv̊u os

Barva
bg barva pozad́ı grafu
col barva bod̊u, obrys̊u bod̊u nebo spojnice. Barva může být vyjádřena přirozeným

č́ıslem nebo textovým řetězcem. Pro barvu os použijeme př́ıkaz col.axis,
pro popisky os col.lab, pro titulek a podtitulek grafu col.main a col.sub.
Základńı barvy jsou uvedeny v Tab. 7.1, podrobněǰśı seznam barev o 657
položkách dostaneme př́ıkazem colors(), funkćı gray() s argumenty od 0
do 1 źıskáme r̊uzné stupně šedi
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barva numerická hodnota textový řetězec

b́ılá 0 "white"

černá 1 "black"

červená 2 "red"

zelená 3 "green"

modrá 4 "blue"

modrozelená 5 "cyan"

fialová 6 "magenta"

žlutá 7 "yellow"

šedá 8 "gray"

Tab. 7.1. Barvy bod̊u

Graf
pty textový řetězec specifikuj́ıćı tvar grafické oblasti, "s" čtvercová, "m" ma-

ximálńı
mfcol 2-prvkový vektor tvaru c(pocet radku, pocet sloupcu) rozděluj́ıćı graf

na odpov́ıdaj́ıćı počet podgraf̊u, jednotlivé grafy jsou řazeny po sloupćıch
mfrow stejně jako mfcol, grafy jsou řazeny po řádćıch
new implicitńı nastaveńı FALSE, nastaveńı na hodnotu TRUE umožňuje přikresleńı

daľśıho grafu pomoćı high-level funkce do již existuj́ıćıho grafu

Osy
las numerická hodnota pro otočeńı popisk̊u os:

0 - x vodorovně, y svisle
1 - x i y vodorovně
2 - x svisle, y vodorovně
3 - x i y svisle

Body, čáry
lty numerická hodnota udávaj́ıćı typ čáry, jednotlivé typy s odpov́ıdaj́ıćı hodnotou

jsou uvedeny na Obr. 7.19
lwd numerická hodnota pro š́ı̌rku čáry, standardńı lwd=1
pch numerická hodnota pro znak vykreslovaných bod̊u, jednotlivé znaky s hodno-

tami 1 – 20 jsou uvedeny na Obr. 7.26. Pro hodnoty 21 – 25 jsou vykresleny
znaky s hodnotou 1, 0, 5, 2, 6 (v tomto pořad́ı) s volitelnou barvou výplně bg

a barvou hranice col. Hodnoty 26 – 31 nejsou definovány, hodnotám 32 – 255

odpov́ıdaj́ı znaky ASCII tabulky. Je možno použ́ıt i jakékoliv textové řetězce,
vypisuje se však vždy jen prvńı znak.
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Obr. 7.19. Typy čar (argument lty)
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Obr. 7.20. Typy bod̊u (argument pch)

7.4 Daľśı užitečné funkce

K otevřeńı daľśıho grafického okna slouž́ı př́ıkaz dev.new() nebo windows() (pouze
v systému Windows). Př́ıkaz dev.new() můžeme použ́ıt i s numerickým argumentem
which, prostřednictv́ım něhož lze př́ıkazy dev.set(which) a dev.off(which) dané
okno aktivovat, popř. zavř́ıt. Př́ıkaz graphics.off() zavře všechna grafická okna.
Ukládat grafy lze v menu File → Save as výběrem požadovaného formátu. Alternati-
vou je použ́ıt některého z př́ıkaz̊u:
pdf(file, width, height)

postscript(file, width, height)

png(file, width, height)

jpeg(file, width, height)

file textový řetězec pro název souboru
width š́ı̌rka grafu v palćıch
height výška grafu v palćıch
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> pdf(file="Nil.pdf")

> plot(Nile, main="Rocni prutoky reky Nil") vykresleńı objektu Nile (ve-
stavěná proměnná)
> dev.off()

null device

1

Př́ıkazem recordPlot() lze grafy ukládat i jako objekty. Zpětně lze takto uložený graf
zobrazit (a upravovat) př́ıkazem replayPlot() nebo zavoláńım názvu objektu.

> plot(Nile, main="Rocni prutoky reky Nil")

> Nil <- recordPlot() uložeńı grafu do proměnné Nil

> replayPlot(Nil) zobrazeńı grafu

Rocni prutoky reky Nil

Time

N
ile

1880 1900 1920 1940 1960

60
0

80
0
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00
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00

14
00

Obr. 7.21. Ročńı pr̊utoky řeky Nil

Funkce layout() umožňuje vytvářet složený graf obsahuj́ıćı několik graf̊u r̊uzných
rozměr̊u, přičemž mohou zab́ırat i v́ıce řádk̊u či sloupc̊u.

Jediným povinným argumentem funkce je matice, jej́ıž počet řádk̊u a sloupc̊u
a jejich č́ıselné hodnoty určuj́ı pořad́ı zaplňováńı jednotlivých ”box̊u”grafy. Př́ıkaz
layout(matrix(c(1, 0, 3, 2), 2, 2, byrow=TRUE)) vytvoř́ı graf se čtyřmi boxy,
přičemž pozice [1, 1] bude obsazena jako prvńı, dále budou obsazovány pozice [2, 2] a
[2, 1], pro nulovou hodnotu z̊ustává pozice prázdná (pozice [1, 2]).

Argumenty heights a widths jsou použ́ıvány ke specifikaci výšek a š́ı̌rek box̊u.
Šablonu s jednotlivými boxy si můžeme prohlédnout př́ıkazem layout.show(n) (Obr. 7.22),
kde n udává počet vykreslovaných graf̊u.
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> layout(matrix(c(1, 0, 3, 2), 2, byrow=T), widths=c(3, 1),

+ heights=c(1, 3))

> layout.show(3) (Obr. 7.22)
> load(file="pary.dat") načteńı datového souboru (závislost výšky 169
manželských pár̊u, [8]). Soubor obsahuje proměnnou pary typu seznam se složkami
muz, zena, muzhist a zenahist

> attach(pary)

> layout(matrix(c(1, 0, 3, 2), 2, byrow=T), widths=c(3, 1),

+ heights=c(1, 3))

> par(mar=c(0, 3.5, 1, 1)) funkce mar slouž́ı pro nastaveńı okraj̊u grafu
> barplot(muzhist, axes=F, space=0)

> par(mar=c(3.5, 0, 1, 1))

> barplot(zenahist, axes=F, space=0, horiz=T)

> par(mar=c(4.3, 4, 1, 1))

> plot(muz, zena, xlab="muz [mm]", ylab="zena [mm]")
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Obr. 7.22. Šablona s boxy Obr. 7.23. Závislost výšky 169 manželských
pár̊u
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Funkce split.screen() slouž́ı k děleńı grafického prostřed́ı na libovolný počet
část́ı. Např. př́ıkazem split.screen(c(2,2)) rozděĺıme prostřed́ı na čtyři části, na
něž můžeme odkazovat př́ıkazy screen(1), . . . , screen(4) a pomoćı těchto př́ıkaz̊u
dané podgrafy vytvářet nebo měnit. Každá část přitom může být znovu rozdělena po-
moćı funkce split.screen(c(,), screen).

Poznámka. Rozděleńı grafu na jednotlivé podgrafy můžeme dosáhnout i pomoćı argu-
ment̊u mfcol a mfrow funkce par() (viz odstavec 7.3).

MATLAB použ́ıvá k rozděleńı grafu na v́ıce část́ı funkci subplot.

> load(file="etnika.dat") načteńı datového souboru (počet souhlasných reakćı
na deset otázek zástupc̊um čtyř etnik, [8])
> popisx <- rownames(etnika)

> split.screen(c(1,3)) vytvoř́ı prázdné grafické okno, nav́ıc je výstupem i vektor
hodnot odkazuj́ıćı na jednotlivé podgrafy, šablona okna s boxy viz Obr. 7.24
[1] 1 2 3

screen 1 screen 2 screen 3

Obr. 7.24. Šablona okna s boxy pro př́ıkaz split.screen(c(1,3))

> screen(1) aktivace levého boxu pro vykresleńı podgrafu
> barplot(etnika[,1], main="etnikum 1", names.arg=popisx, las=3)

> screen(2)

> barplot(etnika[,2], main="etnikum 2", names.arg=popisx, las=3)

> split.screen(c(2,1), screen=3) rozděleńı pravého boxu na 2 daľśı boxy,
aktuálńı šablona s boxy viz Obr. 7.25
[1] 4 5
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screen 1 screen 2

screen 4

screen 5

Obr. 7.25. Šablona okna s boxy pro př́ıkaz split.screen(c(2,1), screen=3)

> screen(4)

> barplot(etnika[,3], main="etnikum 3", names.arg=popisx, las=3)

> screen(5)

> barplot(etnika[,4], main="etnikum 4", names.arg=popisx, las=3)
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Obr. 7.26. Počet souhlasných reakćı na deset otázek zástupc̊um čtyř etnik.

Interaktivńı funkce locator() umožňuje vybrat pozici pro umı́stěńı grafických
prvk̊u (např. legendy, popisk̊u os, . . . ). Funkce locator() čeká, než uživatel zvoĺı levým
tlač́ıtkem myši mı́sto, následně vyṕı̌se jeho souřadnice. Argument n udává počet bod̊u,
u kterých chceme t́ımto zp̊usobem zjistit souřadnice.
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Př́ıklady k procvičeńı

1. Do jednoho grafu zakreslete na intervalu [0, 3π] graf funkćı sinx (červeně) a cos x
(modře). Graf vhodně otitulkujte a pomoćı funkce locator() obě funkce popǐste.

2. Vestavěná proměnná InsectSprays popisuje účinnost sprej̊u proti hmyzu a za-
hrnuje dvě složky – count a spray. Vykreslete histogram absolutńıch četnost́ı
pro počet jedinc̊u hmyzu daného pozorováńı (složka count).

3. Pro stejnou proměnnou jako v úkolu 2 vykreslete boxplot. Dále zjistěte, zda se
data ř́ıd́ı normálńım rozložeńım. Svou odpověd’ podložte vhodným grafem.

4. Do dvou graf̊u vedle sebe zobrazte graf funkce sin(x) cos(x+y) pro x, y z intervalu
[0, 5]. Do levého grafu zobrazte prostorový graf, do pravého pouze jeho vrstevnice.
Grafy popǐste.

5. Načtěte soubor vyskomer.dat, ve kterém je uloženo 15 kontrolńıch měřeńı dvěma
r̊uznými výškoměry. Do jednoho grafu zakreslete pr̊uběh měřeńı pro oba výškoměry
následovně:

• pr̊uběh pro vyskomer1 modrými čtverečky,

• pr̊uběh pro vyskomer2 zelenými hvězdičkami,

• graf opatřete názvem, popisky os a legendou.

Graf uložte do souboru ”vyskomer.pdf”.

Řešeńı.

1. x <- seq(from=0, to=3*pi, length=100), y <- matrix(c(sin(x),cos(x)),

ncol=2)

matplot(x, y, col=c(2,4), type="l", main="Grafy funkci sin(x) a

cos(x)", xlab="osa x", ylab="osa y") nebo
plot(x, sin(x), col=2, type="l", main="Grafy funkci sin(x) a

cos(x)", xlab="osa x", ylab="osa y"), points(x, cos(x), col=4,

type="l") nebo
plot(x, sin(x), col=2, type="l", main="Grafy funkci sin(x) a

cos(x)", xlab="osa x", ylab="osa y"), lines(x, cos(x), col=4,

type="l")

souradnice <- locator(2)

text(souradnice, labels=c("sin(x)", "cos(x)"))

2. hist(InsectSprays$count)
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3. boxplot(InsectSprays$count)

qqnorm(InsectSprays$count), qqline(InsectSprays$count)

4. x <- seq(from=0, to=5, length=100), y <- x,
z <- sin(x) %*% t(cos(x+y))

layout(matrix(1:2, nrow=1))

persp(x, y, z, main="Funkce ’persp’")

contour(x, y, z, main="Graf ’countour’") nebo
split.screen(c(1,2))

screen(1), persp(x, y, z, main="Funkce ’persp’")

screen(2), contour(x, y, z, main="Graf ’countour’")

5. load(file="vyskomer.dat")

pdf(file="vyskomer.pdf")

matplot(1:15, vyskomer, col=c("blue", "green"), lty=c(1,2),

pch=c(15, 8))

legend(11, 34, c("vyskomer1", "vyskomer2"), col=c("blue","green"),

pch=c(15, 8))

dev.off()
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Kapitola 8

Programováńı v R

Základńı informace

Jazyk R je snadno rozšǐritelný o vlastńı funkce či dávkové soubory. Pro zvládnut́ı tvorby
vlastńıch funkćı je třeba porozumět rozd́ıl̊um mezi lokálńımi a globálńımi proměnnými
a ovládat podmı́něné př́ıkazy a př́ıkazy cykl̊u. Použit́ı těchto př́ıkaz̊u může ovšem být
u některých datových struktur zdlouhavé či výpočetně neefektivńı, těmo situaćım je
věnována posledńı část kapitoly popisuj́ıćı skupiny funkćı apply.

Výstupy z výuky

Studenti

• dokáž́ı vysvětlit rozd́ıl mezi funkcemi a dávkovými soubory,

• rozlǐsuj́ı lokálńı a globálńı proměnné,

• ovládaj́ı r̊uzné podmı́něné př́ıkazy,

• umı́ použ́ıt př́ıkazy cykl̊u,

• jsou schopni vhodně aplikovat funkci apply.

8.1 Funkce a dávkové soubory

Programy v jazyce R, které si uživatel může sám vytvořit, lze rozdělit do dvou skupin
- dávkové soubory a funkce. V následuj́ıćıch odstavćıch si uvedeme hlavńı rozd́ıly mezi
nimi a zp̊usoby, jak lze tyto programy vytvořit.
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Hlavńım rozd́ılem funkćı a dávkových soubor̊u je ten, že objekty definované uv-
nitř funkce nejsou k dispozici v pracovńım prostoru. U dávkových soubor̊u nezálež́ı
na tom, z jakého adresáře jsou volány, objekty definované uvnitř dávky jsou v pra-
covńım prostoru stále k dispozici. Daľśım rozd́ılem je ten, že funkce pracuj́ı se vstupńımi
proměnnými, dávkové soubory nikoliv.

Funkce
Každá funkce v R, at’ vestavěná nebo definovaná uživatelem, je tvaru

nazev <- function(argumenty){telo},

kde nazev udává název funkce, argumenty je čárkami oddělená posloupnost vstupńıch
argument̊u a telo obsahuje posloupnost př́ıkaz̊u, které muśı být uzavřeny ve složených
závorkách { } (pouze v př́ıpadě jediného př́ıkazu mohou být složené závorky vy-
nechány).

Funkce lze vytvářet př́ımo v př́ıkazové řádce, při tvorbě složitěǰśıch zdrojových kód̊u
je vhodněǰśı mı́sto př́ıkazové řádky použ́ıvat editory. Jazyk R má k dispozici zabudo-
vaný vlastńı editor, který najdeme v menu File→ New script. Možné je rovněž použ́ıvat
editory jako PSPad nebo WinEdt s č́ıslovanými řádky, kontrolou syntaxe apod. Takto
vytvořené funkce ukládáme do souboru s koncovkou .R.

V př́ıpadě, že je funkce vytvořena př́ımo v př́ıkazové řádce, spoušt́ı se zavoláńım
svého názvu nazev s argumenty uvedenými v kulatých závorkách. V př́ıpadě, že je
vytvořena v textovém editoru, je třeba nejdř́ıve funkćı source() nač́ıst soubor, ve
kterém je uložena. Argumentem funkce source() je textový řetězec obsahuj́ıćı celý
název souboru (i s koncovkou .R) nebo cestu k němu. Následně se spoušt́ı zavoláńım
názvu funkce nazev s argumenty uvedenými v kulatých závorkách.

Při voláńı funkce bez názv̊u argument̊u muśı být jednotlivé argumenty uvedeny
přesně v tom pořad́ı, v jakém byly definovány. V opačném př́ıpadě můžeme použ́ıt
přǐrazeńı nazev argumentu=hodnota, popř. názvy argument̊u můžeme zkracovat, jestliže
zkratka nemůže znamenat žádný jiný argument. Hodnoty argument̊u mohou mı́t defi-
novány své implicitńı hodnoty – ty lze př́ıkazem nazev argumentu=implicitni hodnota

nastavit v seznamu argument̊u při definováńı funkce. Při voláńı funkce pak tyto argu-
menty mohou být vynechány a bude jim přidělena hodnota implicitni hodnota.

Výstupńı hodnoty źıskáme pomoćı funkce return(), pouze k výpisu hodnot se
použ́ıvá funkce print(). V př́ıpadě jediného výstupńıho objektu je tento objekt uváděn
do argumentu funkce return(), v př́ıpadě v́ıce výstupńıch objekt̊u muśı být seskupeny
do seznamu.

Jazyk R rovněž umožňuje definováńı nových binárńıch operátor̊u (např. %in%).
K odlǐseńı od funkćı muśı být jejich název ve tvaru "%nazev%".
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> kvadr <- function(a, b, c){
+ obsah <- 2*(a*b + b*c + c*a)

+ objem <- a*b*c

+ return(list(obsah=obsah, objem=objem))}
> vystup <- kvadr(1, 2, 3)

> vystup

$obsah

[1] 22

$objem

[1] 6

Dávkové soubory
Jedná se o posloupnost př́ıkaz̊u, která může využ́ıvat již definovaných objekt̊u z pra-
covńıho prostoru. Zpravidla se vytvář́ı v libovolném textovém editoru, název souboru
muśı mı́t př́ıponu .R (např. davka.R). Dávkové soubory se spoušt́ı funkćı source

s názvem dávkového souboru (nebo cestou k němu) uvedeným jako textový řetězec
(např. source("davka.R")).

> a <- 1; b <- 2; c <- 3

> source("kvadr.R") spuštěńı dávky kvadr.R

> obsah

[1] 2

> objem

[1] 6

Násilné ukončeńı běž́ıćı dávky nebo funkce se provád́ı př́ıkazem Q.
V pr̊uběhu funkce nebo dávky se občas může stát, že se potřebujeme dostat zpět do

pracovńıho prostoru, např. vypracováńı zadaných úkol̊u (viz cvičeńı) a následně dále
pokračovat v běhu funkce či dávky. To lze př́ıkazem browser(), k odlǐseńı funkce či
dávky a prostřed́ı pracovńıho prostoru se prompt změńı na Browse[1]>. Od této chv́ıle
se nacháźıme v pracovńım prostoru, kde můžeme zadávat libovolné př́ıkazy. Zpět se do-
staneme př́ıkazem c nebo klávesou ENTER.

MATLAB mı́sto př́ıkazu browser() použ́ıvá keyboard, objevuje se prompt
K>> a k návratu zpět do dávkového souboru použ́ıvá př́ıkaz return.

8.2 Lokálńı a globálńı proměnné

V jazyce R neńı nezbytně nutné deklarovat proměnné uvnitř funkce. Při vyhodnocováńı
funkce R použ́ıvá pravidlo lexical scoping, které rozhodne, zda je objekt lokálńı nebo
globálńı proměnnou.
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> funkce1 <- function(){print(x)}
> x <- 3

> funkce1() Objekt x neńı definován uvnitř funkce funkce1(), proto R hledá
v uzavřeném1 prostřed́ı objekt s názvem x a vytiskne jeho hodnotu. V př́ıpadě, že
by objekt x nebyl nalezen ani v globálńım prostřed́ı, zobrazilo by se chybové hlášeńı
Error in print(x) : object ’x’ not found a vyhodnocováńı funkce by t́ımto bylo
u konce.
[1] 3

MATLAB by v př́ıpadě, kdy objekt x neńı definován uvnitř funkce funkce1(),
dával chybové hlášeńı, protože proměnná x je považována za lokálńı
v prostřed́ı, ve kterém byla definována (v tomto př́ıpadě ve workspace).

> funkce2 <- function(){x <- 1; print(x)}
> x <- 3

> funkce2()

[1] 1

> x Jestliže je x použito jako název objektu uvnitř funkce, hodnota x v globálńım
prostřed́ı nebude změněna.
[1] 3

Chceme-li mı́t k dispozici i v globálńım prostřed́ı přǐrazeńı provedená uvnitř funkce,
muśıme použ́ıt operátoru <<- nebo funkce assign s argumentem envir=.GlobalEnv.

> funkce3 <- function(){x <- 2; print(x)}
> x přesvědč́ıme se, že objekt x neńı definován
Error: object ’x’ not found

> funkce3()

[1] 2

> x objekt x opravdu neńı v globálńım prostřed́ı definován, je definován pouze
v prostřed́ı funkce funkce3

Error: object ’x’ not found

Rozd́ıl při použit́ı operátoru pro globálńı přǐrazeńı:

> funkce4 <- function(){assign("x", 2, envir=.GlobalEnv); print(x)}
> x

Error: object ’x’ not found

> funkce4()

[1] 2

> x

[1] 2
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8.3 Podmı́něné př́ıkazy

Do této chv́ıle jsme sestavovali programy, které vyhodnocovaly pouze jednoduché př́ıkazy
nebo jejich posloupnosti uzavřené ve složených závorkách. Často ovšem potřebujeme
provést sérii př́ıkaz̊u až na základě výsledku nějaké podmı́nky/nějakých podmı́nek.

if (podminka) {prikaz}
provede prikaz v př́ıpadě, že podminka je vyhodnocena jako TRUE. V př́ıpadě vyhod-
noceńı podmı́nky jako FALSE se žádné př́ıkazy neprovedou.

> x <- 5

> if (x > 3) {"Podminka splnena."}
[1] "Podminka splnena."

if (podminka) {prikaz1}
else {prikaz2}
V př́ıpadě vyhodnoceńı podmı́nky podminka jako TRUE je proveden prikaz1, v opačném
př́ıpadě je proveden prikaz2.

> if (x > 3) {"Podminka splnena."}
+ else {"Podminka nesplnena."}
[1] "Podminka splnena."

Podmı́nka vraćı bud’ hodnotu TRUE nebo FALSE. Jestliže podmı́nka vraćı logický vektor
o v́ıce než jednom prvku, jako výsledek vyhodnoceńı podmı́nky je ovšem brán pouze
jeho prvńı prvek. Součást́ı výstupu je i hlášeńı:

> x <- c(-2, 0, 3, 1)

> if (x > 0) {"vetsi nez 0"}
+ else {"mensi nebo rovno 0"}
[1] "mensi nebo rovno 0"

Warning message:

In if (x > 0) { :

the condition has length > 1 and only the first element will be used

MATLAB by v tomto př́ıpadě vyhodnotil podmı́nku vracej́ıćı vektor o hod-
notách TRUE jako TRUE, v př́ıpadě jediné hodnoty FALSE jako FALSE.

Alternativou k př́ıkazu if - else může být př́ıkaz
ifelse(podminka, prikaz1, prikaz2),
která v př́ıpadě podmı́nky vyhodnocené jako TRUE provede př́ıkaz prikaz1, v opačném
př́ıpadě provede prikaz2.
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Obr. 8.1. Diagram vysvětluj́ıćı př́ıkaz if - else if - else

> ifelse(x > 3, "Podminka splnena.", "Podminka nesplnena.")

[1] "Podminka splnena."

if (podminka1) {prikaz1}
else if (podminka2) {prikaz2}
else if (podminka3) {prikaz3}
else {prikaz4}
Vysvětleńı těchto podmı́něných př́ıkaz̊u je zachyceno na Obr. 8.1.

> x <- 3

> if (x == 1) {"cervena - stat!"}
+ else if (x == 2) {"oranzova - pripravit se"}
+ else if (x == 3) {"zelena - muzeme jet"}
+ else {"zadna jina barva na semaforu neexistuje"}
[1] "zelena - muzeme jet"

Př́ıkaz
switch(vyraz, prikazy, prikazy jine)

slouž́ı také k větveńı programu. Jestliže vyraz je celé č́ıslo, na výstupu je vrácena hod-
nota odpov́ıdaj́ıćıho prvku prikazy. Pokud nedojde ke spojeńı hodnoty vyraz s prvkem
prikazy, funkce vraćı hodnotu NULL.
Pro textový řetězec muśı být název vyraz použit ke spojeńı s př́ıslušným prvkem
posloupnosti prikazy. Pokud nedojde ke spojeńı s některým z prvk̊u posloupnosti
prikazy, můžeme definovat prikazy jine, které budou v tomto př́ıpadě provedeny.
prikazy jine můžeme definovat pouze pro vyraz typu textový řetězec.
Syntaxe př́ıkazu bude názorněǰśı z následuj́ıćıch př́ıklad̊u:

200



KAPITOLA 8. PROGRAMOVÁNÍ V R

> switch(2, "vyborne", "velmi dobre", "dobre", "uspokojive",

+ "dostatecne", "nedostatecne")

[1] "velmi dobre"

> switch(7, "vyborne", "velmi dobre", "dobre", "uspokojive",

+ "dostatecne", "nedostatecne")

[1] NULL

> switch("vyborne", vyborne="znamka A", velmi dobre="znamka

+ B", dobre="znamka C", uspokojive="znamka D", dostatecne="znamka E",

+ neuspokojive="znamka F", "znamka neexistuje")

[1] "znamka A"

> switch("chvalitebne", vyborne="znamka A",

+ velmi dobre="znamka B", dobre="znamka C", uspokojive="znamka D",

+ dostatecne="znamka E", neuspokojive="znamka F", "znamka neexistuje")

[1] "znamka neexistuje"

8.4 Př́ıkazy cykl̊u

Někdy potřebujeme opakovaně vyhodnocovat př́ıkaz nebo skupinu př́ıkaz̊u. Je třeba si
dát pozor na správnou definici konce cyklu, v opačném př́ıpadě může doj́ıt k zacykleńı.
Mezi nejznáměǰśı př́ıkazy cykl̊u patř́ı funkce for, while a repeat.

for (promenna in vyraz) {prikaz}
Provede sérii př́ıkaz̊u prikaz, promenna označuje indexačńı proměnnou, vyraz může
být vektor nebo seznam, pro jehož každou složku je prikaz vyhodnocen. Cyklus for

je vhodné použ́ıvat tehdy, když předem v́ıme, kolik opakováńı chceme provést.

> for (i in 1:5) {cat("pruchod cyklem", i, "\n")}2 funkce cat() zřetěźı a
vytiskne své argumenty
pruchod cyklem 1

pruchod cyklem 2

pruchod cyklem 3

pruchod cyklem 4

pruchod cyklem 5

Někdy ovšem předem nev́ıme, kolikrát bude třeba cyklus opakovat, a počet opakováńı
záviśı na splněńı určité podmı́nky. V těchto př́ıpadech použijeme cyklus while:
while (podminka) {prikaz}
Stejně jako u výrazu if, podminka je výraz, který po vyhodnoceńı vraćı logickou hod-
notu TRUE nebo FALSE. V př́ıpadě splněńı podmı́nky podminka cyklus provede prikaz.
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> i <- 1

> while (i %in% c(1:5)) {print(i); i <- i + 1}
[1] 1

[1] 2

[1] 3

[1] 4

[1] 5

Cyklus repeat opakuje vyhodnocováńı př́ıkaz̊u prikaz do té doby, dokud nedosáhne
konce. Pro ukončeńı se použ́ıvá př́ıkaz break, který je součást́ı posloupnosti př́ıkaz̊u
prikaz. Syntaxe vypadá následovně:
repeat {prikaz}
Poznámka. Př́ıkaz break lze použ́ıt i pro ukončeńı cykl̊u for a while.

> i <- 0

> repeat{
+ print(i)

+ i <- i + 1

+ if (i == 5) {break}}
[1] 0

[1] 1

[1] 2

[1] 3

[1] 4

8.5 Skupiny funkćı apply()

Do této skupiny patř́ı funkce apply(), lapply(), sapply() a tapply(). Společnou
vlastnost́ı všech těchto funkćı je schopnost aplikovat funkci na vybrané části struktury
bez použit́ı cyklu, což má výhody v přehlednosti i rychlosti výpočtu.

Funkce apply() se použ́ıvá pro vektory, matice a pole. Funkce požaduje tři argu-
menty: název pole a jeho dimenze, na kterých má být provedena požadovaná operace.
Jej́ı název je třet́ım argumentem funkce. Jestliže u matic druhý argument nabývá hod-
noty 1, operace se provád́ı po řádćıch, v př́ıpadě hodnoty 2 po sloupćıch, u poĺı vyšš́ı
hodnoty odkazuj́ı na daľśı dimenze.
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> ar <- array(1:8, c(2,2,2))

, , 1

[,1] [,2]

[1,] 1 3

[2,] 2 4

, , 2

[,1] [,2]

[1,] 5 7

[2,] 6 8
> apply(ar, 1, sum)

[1] 16 20

> apply(ar, 2, sum)

[1] 14 22

> apply(ar, 3, sum)

[1] 10 26

Obě funkce lapply() i sapply() provád́ı výpočet určité funkce v jednotlivých
složkách seznamu jako prvńıho argumentu. Druhým argumentem je název funkce, která
má být provedena. Tyto př́ıkazy se lǐśı pouze výstupem - zat́ımco lapply() vraćı se-
znam o stejném počtu složek jako vstupńı seznam, funkce sapply() se snaž́ı výsledek
zjednodušit do vektoru nebo matice.

> (l <- list(1:5, 5:14))

[[1]]

[1] 1 2 3 4 5

[[2]]

[1] 5 6 7 8 9 10 11 12 13 14

> lapply(l, range)

[[1]]

[1] 1 5

[[2]]

[1] 5 14

> sapply(l, range)
[,1] [,2]

[1,] 1 5

[2,] 5 14
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Funkce tapply() aplikuje požadovanou funkci na roztř́ıděná data v tabulce dat.
Argument INDEX specifikuje seznam položek pro roztř́ıděńı.

> (tabulka <- data.frame(id=c(1:6), skupina=c(1, 2, 2, 1, 2, 1),

+ hodnota=runif(6, 2, 4)))
id skupina hodnota

1 1 1 3.238305

2 2 2 2.502754

3 3 2 3.939131

4 4 1 3.524773

5 5 2 3.731300

6 6 1 3.836787
> tapply(tabulka$hodnota, INDEX=tabulka$skupina, mean)

1 2

3.533288 3.391061

Př́ıklady k procvičeńı

1. Vytvořte dávku odd.R, uvnitř ńı definujte vektor v s hodnotami 1, 3, 4, 5, 6, 7,
10 a výstupńı proměnnou pocet, která vrát́ı počet lichých č́ısel vektoru v.

2. Vytvořte funkci oddf.R, která pro libovolný vstupńı vektor či vrát́ı počet lichých
č́ısel. Zkontrolujte, zda vstupńı objekt obsahuje pouze numerické hodnoty a zda
jsou všechny tyto hodnoty celá č́ısla.

3. Vytvořte funkci mattovec.R, která pro vstupńı matici vyṕı̌se vektor jej́ıch po
sloupćıch seřazených prvk̊u. Zajistěte, aby pro diagonálńı matice byla vypisována
pouze diagonála a pro dolńı/horńı trojúhelńıkové matice pouze dolńı/horńı část.

4. Vytvořte funkci product.R, která pro dvě vstupńı celoč́ıselné hodnoty n a k vrát́ı
jejich součin, aniž by byla použita operace násobeńı. Povolena je pouze operace
sč́ıtáńı.

5. Pro usnadněńı práce rybář̊um vytvořte funkci ryby.R, která pro vstupńı vektor
představuj́ıćı hmotnosti postupně vylovených ryb rybáře upozorńı, kdy je třeba
dávat daľśı ryby do nové kádě. Nosnost každé kádě je 20 kg. Kolik kád́ı budou
rybáři pro sv̊uj úlovek potřebovat (výstupńı proměnná kad)? Ošetřete, aby váhy
vylovených ryb byla pouze kladná reálná č́ısla.
Funkci vyzkoušejte na náhodně vygenerovaném vektoru hmotnost́ı 25 ryb s hmot-
nostmi mezi 1–5 kg, hmotnosti zaokrouhlete na jedno desetinné mı́sto.

6. Soubor les.dat obsahuje informace o š́ı̌rce kmene 45 stromů ve dvou lokalitách
lesa. Použijte vhodné př́ıkazy pro zjǐstěńı pr̊uměrné, minimálńı a maximálńı š́ı̌rky
kmene pro každou z lokalit.
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Řešeńı.

1. v <- c(1, 3, 4, 5, 6, 7, 10)

sude <- v %% 2

pocet <- sum(sude)

cat(’Pocet lichych cisel: ’, pocet, ’\n’)
. . . dávku uložit s názvem odd.R, nač́ıtáńı a spouštěńı: source("odd.R")

2. oddf <- function(x){

if (is.numeric(x) & is.real(x)){
pocet <- sum(x %% 2)

}

return(pocet)

} . . . funkci uložit s názvem oddf.R,
nač́ıtáńı funkce: source("odd.R"),
spouštěńı funkce: pocet <- oddf(v)

3. mattovec <- function(A){

if (sum(A - diag(diag(A))) == 0){
vec <- diag(A)

}
else if (sum(A[!lower.tri(A, diag=T)]) == 0){
vec <- A[lower.tri(A, diag=T)]

}
else if (sum(A[!upper.tri(A, diag=T)]) == 0){
vec <- A[upper.tri(A, diag=T)]

}
else vec <- as.vector(A)

return(vec)

}
source("mattovec.R"), vec <- mattovec(matrix(1:4, 2))

4. product <- function(n, k){

if (round(n)-n != 0 | round(k)-k != 0){
stop(’Nejde o celociselne hodnoty!’)

}
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else if (n==0 | k==0){
soucin <- 0

}
else {soucin <- 0

for (i in 1:k){
soucin <- soucin + n

}}

return(soucin)

}
source("product.R"), soucin <- product(2, 3)

5. ryby <- function(x){

kad <- 0

if (all(is.real(x) & x>0)){
while (sum(x) >= 50){

index <- max(which(cumsum(x) <= 20))

x <- x[index:length(x)]

kad <- kad + 1

}
}
else stop("Nejedna se o vektor kladnych realnych cisel!")

return(kad)

}
source("ryby.R")

r <- round(runif(min=1, max=5, n=25), digits=1)

kad <- ryby(r)

6. load("les.dat")

tapply(les$sirka, INDEX=les$lokalita, mean)

tapply(les$sirka, INDEX=les$lokalita, min)

tapply(les$sirka, INDEX=les$lokalita, max)
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2010]. Dostupné z WWW: <http://biostat.mc.vanderbilt.edu/wiki/pub/

Main/TheresaScott/Scott.IntroToR.I.pdf>

[13] SCOTT, Theresa A. An Introduction To The Fundamentals & Functionality Of
The R Programming Language: Part II: The Nuts and Bolts. [online] 101 s. [cit.
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